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Sﬂjmn INTRODUCTION

1.1 Introduction

spColumn is a software program for the design and investigation of reinforced concrete sections
subject to axial and flexural loads. The section can be rectangular, round or irregular, with any
reinforcement layout or pattern. Slenderness effects can be considered.

The program offers investigation of irregularly shaped, reinforced concrete column sections that
may contain openings or boundary elements. Widely used for design of shear walls, bridge piers
as well as typical framing elements in buildings, spColumn can investigate sections that are
impossible to find on design charts or do by hand calculations. You can obtain the P-M interaction
diagrams from both uniaxial and biaxial runs, as well as the M,-M, moment contour plots from
biaxial runs for even the most irregular column and shear wall sections. Slenderness effects
producing magnified moments may be included in the investigation.

1.2 Program Features

* Code support for ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02
* Code support for CSA A23.3-14, CSA A23.3-04, and CSA A23.3-94

* English and SI units

* Design and investigation run options

+ Uniaxial or biaxial flexure combined with axial load

» Rectangular, circular, and irregular section geometry

* Non-slender and sway or nonsway slender columns

*  Complete P-M and M,-M, interaction diagrams

» Customizable view of interaction diagrams

* Superposition of interaction diagram from a different run
» Factored, unfactored, axial, and control points loading

* Binary (COL) and text (CTI) input file formats

* Graphical input for irregular sections

* Imports geometry, reinforcement, and loads from text files
» Imports section shape and reinforcement from DXF files

» Exports section shape and reinforcement to DXF files

| 8 |
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spSection module for creating and modifying irregular sections

spResults module for viewing and exporting input and output data

spReporter module for generating , viewing, exporting and printing results

Exports graphical reports (screen printouts) to EMF files

Exports P-M diagrams, M,-M, diagrams, and 3D failure surface to TXT and CSV files
GUI (Graphical User Interface) and batch mode (command prompt) runs

Reports neutral axis location and maximum steel strain corresponding to section capacity

Reports neutral axis location, net tensile steel strain, and strength reduction factors in text
output

Program Capacity

1.4

10,000 reinforcing bars within a section.

10,000 exterior points that define the geometric outline of the cross section (spSection
module).

10,000 interior points that define an opening in the cross section (spSection module).

10,000 factored load entries, each consisting of an axial load, a moment about the x-axis,
and a moment about the y-axis.

50 service load entries, each consisting of dead, live, wind, earthquake, and snow axial
loads, moments at column top about the x and y axes, and moments at column bottom
about the x and y axes.

50 load combinations.

System Requirements

Any computer running Microsoft Windows Vista SP2, Windows 7, Windows 8, or Windows 10
operating system with 32 or 64 bit processing is sufficient to run the spColumn program. For

instructions on how to troubleshoot system specific installation and licensing issues, please refer

to support pages on StructurePoint website at www.StructurePoint.org.

| 9 |
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1.5 Terms

The following terms are used throughout this manual. A brief explanation is given to help
familiarize you with them.

Windows refers to the Microsoft Windows environment as listed in System
Requirements.

1 indicates metric equivalent

Click on means to position the cursor on top of a designated item or location

and press and release the left-mouse button (unless instructed to use
the right-mouse button).

Double-click on means to position the cursor on top of a designated item or location
and press and release the left-mouse button twice in quick
succession.

1.6 Conventions

To help you locate and interpret information easily, the spColumn manual adheres to the following

text format.

Italic indicates a glossary item, or emphasizes a given word or phrase.

Bold indicates the name of a menu or a menu item command such as File
or Save.

Mono-space indicates something you should enter with the keyboard. For
example “c:\*.txt”.

KEY + KEY indicates a key combination. The plus sign indicates that you should
press and hold the first key while pressing the second key, then
release both keys. For example, “ALT + F” indicates that you should
press the “ALT” key and hold it while you press the “F” key. then
release both keys.

SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box

component. For example, the OPEN dialog box or the CANCEL or
MODIFY buttons.

| 10 |
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1.7 Installing, Purchasing and Licensing spColumn

To purchase StructurePoint software please visit StructurePoint.org/buy.asp

To download and install a trial version of StructurePoint software please visit StructurePoint.org/
download-trial.asp

For setup, installation, and licensing please use the StructurePoint Setup & Licensing Guide

| 11
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Sﬂ]mn METHOD OF SOLUTION

2.1

Definitions and Assumptions

1.

The analysis of the reinforced concrete section performed by spColumn conforms to the

provisions of the Strength Design Method! and Unified Design Provisions® and is based
on the following assumptions.

a)

b)

d)

All conditions of strength satisfy the applicable conditions of equilibrium and strain
compatibili‘[y3

Strain in the concrete and in the reinforcement is directly proportional to the distance
from the neutral axis*. In other words, plane sections normal to the axis of bending are
assumed to remain plane after bending.

The maximum usable (ultimate) strain at the extreme concrete compression fiber is

assumed equal to 0.003 for ACI codes® and 0.0035 for CSA codes® unless otherwise
specified by the user

A uniform rectangular concrete stress block is used. For ACI code’, the maximum
uniform concrete compressive stress, f., is 0.85f,." by default and the block depth is

¢, where c is the distance from the extreme compression fiber to the neutral axis and

By is described in item 4 below. For CSAS, £, is taken as:
f-=(0.85—0.0015f.")f." > 0.68f., where f,.’ is in MPa
Both f,. and #; can be modified by the user.

e) Concrete displaced by the reinforcement in compression is deducted from the

compression block’

—_—

For CSA A23.3-04 (Ref. [6]) and CSA A23.3-94 (Ref.[7])

. For ACI 318-14 (Ref. [1]), ACI 318-11 (Ref. [1]), ACI 318-08 (Ref. [2]), ACI 318-05 (Ref. [3]) and ACI

318-02 (Ref. [4]); also see notes on ACI 318-08, 8.1.2 in Ref. [9] and notes on ACI 318-11, 8.1.2 in Ref.
[13]

. ACI318-14,4.5.1,22.2.1.1, 13.2.6.2; ACI1 318-11, 10.2.1; ACI 318-08, 10.2.1; ACI 318-05, 10.2.1; ACI

318-02, 10.2.1; CSA A23.3-14, 10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1

. ACI 318-14,22.1.2,22.2.1.2; ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02,

10.2.2; CSA A23.3-14, 10.1.2; CSA A23.3-04, 10.1.2; CSA A23.3-94, 10.1.2

. ACI318-14,22.2.2.1; ACI 318-11, 10.2.3; ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3
. CSA A23.3-14,10.1.3; CSA A23.3-04, 10.1.3; CSA A23.3-94, 10.1.3
. ACI 318-14,22.2.2.3; ACI 318-11, 10.2.6; ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI

318-02, 10.2.6, 10.2.6

. CSA A23.3-14,10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1

For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [3], [4]) and with Eq. 10-10 in CSA
codes (Refs. [6], [7])
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f)

2
h)

)

For the reinforcing steel, the elastic-plastic stress-strain distribution is used!?. Stress in
the reinforcing steel below the yield strength, Sy is directly proportional to the strain.

For strains greater than that corresponding to the yield strength, the reinforcement
stress remains constant and equal to Sy Reinforcing steel yield strength must be within

customary ranges.

Tensile strength of concrete in axial and flexural calculations is neglected! .
Reinforcement bars are located within section outline.

Irregular sections must be composed of a closed polygon without any intersecting
sides.

Members with very large cross sectional area, multiple openings, and unusual
geometry must be carefully evaluated in light of above assumption for solution
stability and reliability of results.

2. The modulus of elasticity of concrete, E,. is computed as follows (unless otherwise

specified by the user):

E.=57,000 \/Zfor the ACI code!? where frc and E_. are in psi,

EC

=4,700,/f c’, for the ACI code!? where f ' . and E_ are in MPa.

!

For the CSA standard!?, E. = 3,518\/]70+7,355, where / ¢ and E_. are in MPa.

3. The modulus of elasticity of reinforcing steel, E,, is taken as 29,000 ksi (200,000 MPa)

unless otherwise specified by the user. The computed compression controlled strain limit

cannot exceed 0.005 and is reset to 0.002 for user input 5 values in excess of 145 ksi.

10. ACI 318-14, 20.2.2.1; ACIT 318-11, 10.2.4; ACI 318-08, 10.2.4; ACI 318-05, 10.2.4; ACI 318-02,
10.2.4; CSA A23.3-14, 8.5.3.2; CSA A23.3-04, 8.5.3.2; CSA A23.3-94,8.5.3.2

11.ACI 318-14,22.2.2.2; ACI 318-11, 10.2.5; ACI 318-08, 10.2.5; ACI 318-05, 10.2.5; ACI 318-02, 10.2.5;
CSA A23.3-14, 10.1.5; CSA A23.3-04, 10.1.5; CSA A23.3-94, 10.1.5

12.ACI 318-14,19.2.2.1; ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1

13. ACI 318M-14, 19.2.2.1; ACI1 318M-11, 8.5.1; ACI 318M-08, 8.5.1; ACI 318M-05, 8.5.1; ACI 318M-02,

8.5.1

14. CSA A23.3-14, 8.6.2.2, Eq. 8.1, CSA A23.3-04, 8.6.2.2, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6
(with v, = 2400 kg/m?)
15. ACI 318-14,20.2.2.2; ACI 318-11, 8.5.2; ACI 318-08, 8.5.2; ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI

318M-05, 8.5.2; ACI 318M-02, 8.5.2; CSA A23.3-14, 8.5.4.1; CSA A23.3-04, 8.5.4.1; CSA A23.3-94,
8.5.4.1
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Stress Block

Ny

Cross Section

Figure 2-1 Analysis of Reinforced Section

4. The ratio of the concrete compression block depth to the distance between the extreme
compression fiber and the neutral axis, f;, is computed as follows (unless otherwise

specified by the user):

0.65 < f; =1.05-0.05f , < 0‘85, for the ACI code'® where f'c is in ksi,

0.65 < 'BI = (149 -f c)/ 140 < 0'85, for the ACI code!” where f'c is in MPa.

=0.97 - 0.0025f , > 0.67

For the CSA standardlg, P 1 , Where f ' . 1s in MPa.

5. Stress in the reinforcement is computed based on the strain at the centroid of each
reinforcing bar.

16. ACI 318-14, 22.2.2.4.3; ACI 318-11, 10.2.7.3; ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-
02,10.2.7.3

17. ACI 318M-14, 22.2.2.4.3; ACI 318M-11, 10.2.7.3; ACI 318M-08, 10.2.7.3; ACI 318M-05, 10.2.7.3;
ACI 318M-02, 10.2.7.3

18. CSA A23.3-14, 10.1.7(c); CSA A23.3-04, 10.1.7(c); CSA A23.3-94, 10.1.7(c)
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6. All moments are referenced to the geometric centroid of the gross concrete section
(neglecting the reinforcement).

7.

For the ACI codes, the nominal (unreduced) capacity of the section is first computed.

Then, the nominal capacity is reduced to the design capacity using the strength reduction
factor, ¢, the value of which is calculated based on the net tensile steel strain, g,in the

following waylg.

e Forc

olumns with spiral reinforcement per ACI 318-14, ACI 318-11, and ACI 318-08

0.9 if ¢; 2 0.005 (tension controlled section)

015 (8’ Jy /ES) lffy / E,, < & < 0.005 (transition section)

$=190.75+ 0057 TE
' Yy df e, <f ) / E,, (compression controlled section)
0.75
* For columns with spiral reinforcement per ACI 318-05 and ACI 318-02
0.9 if ¢; 2 0.005 (tension controlled section)
$=20.70 + 020 (8’ ~/y/Es iffy / E), < & <0.005 (transition section)
' 0.005-f /E
Ty Bs if ¢ < fy / E\, (compression controlled section)
0.70
» For other columns per ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI
318-02
0.9 if €2 0.005 (tension controlled section)
$=10.65+ 0.25 (8f =/, /ES) szy / E,, < & < 0.005 (transition section)
' 0.005-f /E, . . .
0.65 Sy Es if ¢, <f ) / E,, (compression controlled section)

19.ACI 318-14, 21.2; ACIT 318-11, 9.3.2, 10.3.3, 10.3.4; ACI 318-08, 9.3.2, 10.3.3, 10.3.4; ACI 318-05,

9.3.2,10.3.3,10.3.4; ACI 318-02,9.3.2,10.3.3, 10.3.4
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Axial
Load,
P A
Pn,
~
6 oS
~ Nominal Interaction Diagram
~
4 ( Factored (Design)
Py, Compression AN actored (Design
0.90 — " <\ > Interaction Diagram
-
/// ¢Pn,max \\
Spiral* _ _— Magmum Design \ Compression
0.750r0.704————— N controlled
0.65 § Transition
Other 3 Y
I3 ensi ntrolled limit /
T 0 § ure Bendin z
| g - » Moment, M
£y 0.005 S &
Es E // Tension
c . Tension /// controlled
ompression - ot
controlled Transition Controlled Max.
Tension

*Spiral sections in compression controlled zone: ¢ = 0.75 per ACI 318-14/11/08 and ¢ = 0.70 per ACI 318-05/02

Figure 2-2 Reduction factors for Flexural and Axial Capacity per ACI Code

Figure 2-2 illustrates variation of the strength reduction factor with net tensile strain in extreme
tension steel and the impact of the strength reduction factor on the axial and flexural capacity
interaction diagram. It is worth noting that in the transition between compression controlled and
tension controlled zones, the nominal axial capacity, P,,, decreases whereas the value of net tensile

strain increases and so does the strength reduction factor, ¢. Consequently, the resulting factored
axial capacity (i.e. the product of nominal axial capacity and the strength reduction factor), ¢P,,

may either increase or decrease in the transition zone depending on the rates of axial force
decrease and strength reduction increase for the section under consideration. Typically, the rate of
axial capacity decrease dominates over the rate of strength reduction increase and thus the factored
axial load capacity decreases as well.

For certain classes of sections (e.g. sections having a narrowing in the middle such as hollow core
section, T-shaped, L-shaped, and I-shaped sections), however, the reverse may be true resulting in
the factored axial load capacity increase in the transition zone between compression controlled
and tension controlled zones. This unusual increase in axial load capacity is not illustrated by
interaction diagrams produced by the program and is not considered for design and investigation
of cross-sections. It will be flagged to inform the user, however, when the program is run using
Control Points as the load type.

Where unsymmetrical members (e.g. C-shaped or U-shaped sections) are investigated under
biaxial bending, the Mx-My contour diagram occasionally crosses the X or Y axes more than
once. This presents an unusual situation where a load point may exist outside of the Mx-My
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contour while appearing within the P-Mx or P-My contour views. It is suggested the Mx-My
contours be investigated carefully for each factored axial load level.

For the CSA standards, the program calculates the factored resistance directly using the factored

compressive concrete strengthzo, #.f ., and the factored forces in reinforcement bars?!, #.S;. The

material resistance factors are:

. = 0.60 for CSA A23.3-94

=0.65 for CSA A23.3-04/14 (cast-in-place)
=0.70 for CSA A23.3-04/14 (precast)
¢ =0.85 for CSA A23.3-94/04/14

For all ACI and CSA A23.3-94/04 standards, the design axial capacity is capped22 at 0.85 of the
maximum axial capacity for sections with spiral reinforcement or at 0.80 for sections with tie
reinforcement.

Additionally, for CSA A23.3-14 the design axial capacity is capped23 at 0.90 of the maximum
axial capacity for sections with spiral reinforcement or at (0.2+0.002%) < 0.80 for sections with tie
reinforcement where h is the wall thickness or the minimum column dimension.

20. CSA A23.3-14,8.4.2,16.1.3; CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2

21. CSA A23.3-14, 8.4.3; CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3

22. ACI 318-14, 22.4.2.1; ACI 318-11, 10.3.6; ACI 318-08, 10.3.6; ACI 318-05, 10.3.6; ACI 318-02,
10.3.6; CSA A23.3-14, 10.10.4; CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4

23. CSA A23.3-14,10.10.4
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fs=0 Balanced point
& = f,/Es
f=0.5f,

s

Moment, M Tension control
point g = 0.005

Factored (Design) Interaction Diagram per ACI 318

Axial Load, P
A
S~
~
~
fs=0 Balanced point
=f,/E
fs=0.5fy/ & = Iy/Es
4
Moment, M

Factored (Design) Interaction Diagram per CSA A23.3

Figure 2-3 Shapes of P-M interaction diagram for ACI code and CSA standard

8. In the investigation mode the program will calculate capacity for any provided area of

reinforcement. However, if the reinforcement area falls below the code-speciﬁed24
minimum of 0.01 times the gross area, Ag, then two options, Architectural or Structural,

are available.

24. ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02,
10.9.1; CSA A23.3-14, 10.9.1; CSA A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1

| 19 |



Sﬂ]mn METHOD OF SOLUTION

10.

I1.

2.2

By default Architectural option is selected for which the capacity of the section is reduced.
For the ACI codes, the reduction results from multiplying the maximum concrete stress,

f ' ¢ by the ratio of reinforcement area to 0.014,. This produces the same effect as

reducing the effective concrete area® to achieve ratio of reinforcement area to gross

concrete area equal to 0.01. For the CSA standards?®, the factored axial and flexural

resistances are multiplied by ratio 0.5(1 +p,/ 0.01) for the 04 edition and p, / 0.01 for the
94 edition.

For Structural option, the section is treated “as is” without any reductions in capacity. This
option is provided for informational purposes only, since per all codes supported by
spColumn, capacity of compression members with reinforcement area less than 0.014,

has to be reduced and areas below 0.005Ag are not allowed.

Under the Design option, the reinforcement ratio cannot be less than 1.0% if Structural
column type is selected in design criteria and 0.5% in case of Architectural column type.
For Architectural type, the capacity of the designed column is reduced as described above.
Additionally, User Defined type is provided in the design criteria, which allows designs
with reinforcement ratios not less than 0.1%. No reduction in capacity is applied for User
Defined column type.

Maximum reinforcement ratio?’ for Structural and Architectural options in both
Investigation and Design modes is 8%. For User Defined type in the Design mode the
maximum reinforcement ratio is set to 20%.

Reinforcement design strength for standard materials is limited to the value permitted for
design calculations?® by ACI to 80 ksi and CSA to 500 MPa.

Conventions

Positive axial forces are compressive and negative axial forces are tensile.

Looking in plan at the section with z-axis pointing outwards, the positive x-axis points to
the right and the positive y-axis points up. For this section, vectors of positive bending
moments have the same orientation as their corresponding axes x and y. Thus, a positive
bending moment about the x-axis, M, produces tension at the top face of the section and

25.
26.
27.

28.

ACI318-14,10.3.1.2; ACI 318-11, 10.8.4; ACI 318-08, 10.8.4; ACI 318-05, 10.8.4; ACI 318-02, 10.8.4
CSA A23.3-14,10.10.5; CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5

ACIT 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02,
10.9.1; CSA A23.3-14, 10.9.2; CSA A23.3-04, 10.9.2; CSA A23.3-94,10.9.2

ACI 318-14, Table 20.2.2.4a; CSA A23.3-14, 8.5.1

| 20 |



Sﬂ]mn METHOD OF SOLUTION

compression at the bottom face. A positive bending moment about the y-axis, My,

produces tension at the left face of the section and compression at the right face.

z z z
A A A
. N | |
op / P
A PLEAM % M, M $
//\ /; X ' » X ' >y
‘ M | |
« | |
b — | |
/ 1 ;
| |
z
A z z
—— 4 s
‘ A } \
(B~ } |
A 777? A \ |
My <+~ }/ 4 Xy X 1 > X 1 >y
Ef;/ . p% M, MX¢P
M, Section A-A Section B-B
Bottom

Figure 2-4 Positive axial force and bending moments (internal forces)

3. If service loads are input, moment loads at the upper (top) and lower (bottom) ends of the

column are needed. Top and bottom moment loads of opposite signs produce single
curvature bending. Top and bottom moment loads of the same sign produce double
curvature bending.
Positive moment loads at the upper end of the column coincide with positive bending
moments. However, at the lower end, positive moment loads produce effects opposite to
positive bending moments. Therefore, spColumn changes the sign of the service moment
at the lower end to convert it from a moment load to a bending moment.

Axial load is assumed to be constant so it is input only as for the upper end where positive
axial load coincides with positive axial force.

4. If factored loads are input, they are considered to be applied at a section pointing upwards
so that they have the same orientations as positive axial force and positive bending
moments.
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z
A y . 5
Top /x
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Figure 2-5 Positive moment loads (external forces)

5. The convention for the slenderness input of beam and column dimensions and their
orientation is presented in Figure 2-6. Beams above the columns are shown. Same
convention applies to beam below the column.

z

Column Above\ qb v
X-Beam
2 i " Above Left

Y Beam |

Above Left \ X
~._ Y-Beam
Above Right
Design
X-Beam Column
Above Right ¢
y
- X-Beam
Below Left
Lux

Y-Beam __~
Below Left

Y-Beam
Below Right

\Column Below

X-Beam 4\/*

Below Right

Figure 2-6 Slenderness Input Convention
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2.3 Section Investigation Mode

231 Loading Options

The computations performed when investigating a section depend on the selected load mode:

a) Factored loads — for each load point, the capacity ratio is computed. For a biaxial run,
the computed M, and M, moment capacities are at the same angle as that produced by
the applied M, and M, moments. The program also reports the depth of neutral axis

and maximum steel strain corresponding to the calculated capacity points. For the ACI
code, the value of strength reduction factor is also reported.

spColumn allows defining up to 50 load combinations. The user has full control over
the combinations. The program contains predefined (built into the program) default
primary load combinations for the supported codes. These default combinations are
created when starting a new project. The default load combinations of the Dead (D),
Live (L), Wind (W), Earthquake (E) and Snow (S) loads considered by the program

are shown below. For the ACI 318-14, 11, 08, 05, and 02 codes?:

Ul = 14D

U2 = 12D+ 1.6L+0.5S

U3 = 12D+I1.0L+1.6S

U4 = 12D+0.8W+1.6S

Us = 12D+1.0L+1.6W +0.5S
U6 = 09D+ 1.6W

U7 = 12D-08W+1.6S

U8 = 12D+1.0L-1.6W+0.5S

U9 = 09D-1.6W
Ul0 = 1.2D+1.0L+1.0E-0.2S
Ull = 09D +1.0E
Ul2 = 12D +1.0L-1.0E +0.2S
Ul3 = 09D-1.0E

For the CSA A23.3-94 code®”:
Ul = 125D

29. ACI 318-14, 5.3; ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W
based on service-level wind load and E based on ultimate-level forces)
30. CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies)
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U2
U3
U4
U5
U6
u7
Us
U9
ul0
Ull
Ul2
Ul3
Ul4
Ul5
ulé6
Ul17

1.25D + 1.5L

1.25D + 1.5L+ 1.5S

1.25D + 1.05L + 1.05W

1.25D + 1.05L + 1.05W + 1.05S
1.25D + 1.5W

0.85D + 1.5W

1.0D +1.0L + 1.0E

1.0D +1.0L + 1.0E + 1.0S

1.0D + 1.0E

1.25D + 1.05L — 1.05W

1.25D + 1.05L — 1.05W + 1.05S
1.25D - 1.5W

0.85D - 1.5W

1.0D+ 1.0L-1.0E

1.0D + 1.0L - 1.0E + 1.0S

1.0D - 1.0E

For the CSA A23.3-04 code’!:

Ul
U2
U3
U4
Us
U6
u7
Us
U9
ul10
Ull
Ul12
U13

1.4D

1.25D + 1.5L

1.25D + 1.5L + 0.5S
1.25D + 1.5L + 0.4W
1.25D + 1.5L - 0.4W
0.9D + 1.5L

0.9D + 1.5L +0.5S
0.9D + 1.5L +04W
0.9D + 1.5L-0.4W
1.25D + 1.5S

1.25D + 0.5L + 1.5S
1.25D + 0.4W + 1.5S
1.25D-0.4W + 1.5S

31. CSA A23.3-14, 8.3.2; CSA A23.3-14, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2.A; CSA
A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2
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Ul4
Ul15
Ulé6
ul17
Ul8
ul9
U20
U21
U22
U23
U24
U2s
U26
u27
U28
U29
U30
U31
u32
U33

0.9D + 1.5S

0.9D +0.5L + 1.5S

0.9D + 0.4W + 1.5S

0.9D - 0.4W + 1.5S

1.25D + 1.4W

1.25D + 0.5L + 1.4W
1.25D + 1.4W + 0.5S
1.25D - 1.4W

1.25D + 0.5L - 1.4W + 0.5S
1.25D - 1.4W + 0.5S

0.9D +0.5L+ 1.4W

0.9D + 0.5L + 1.4W

0.9D + 1.4W + 0.5S

0.9D - 1.4W

0.9D+ 0.5L - 1.4W

0.9D - 1.4W +0.5S

1.0D + 1.0E

1.0D + 0.5L + 1.0E + 0.25S
1.0D - 1.0E

1.0D +0.5L - 1.0E + 0.25S

For the CSA A23.3-14 code’%:

Ul
U2
U3
U4
U5
U6
u7
Us
U9

1.4D

1.25D + 1.5L

1.25D + 1.5L+ 1.0S
1.25D + 1.5L + 0.4W
1.25D + 1.5L - 0.4W
09D + 1.5L

0.9D + 1.5L + 1.0S
0.9D + 1.5L + 0.4W
09D +1.5L-0.4W

32. CSA A23.3-14 Annex C, Table C1; NBCC 2010 [8], Table 4.1.3.2A; CSA A23.3-04, Annex C, Table
C1; NBCC 2005 [8], Table 4.1.3.2
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b)

U110 = 125D+ 1.5S

Ull = 125D+ 1.0L+1.5S
Ul2 = 125D+04W +1.58S
Ul3 = 1.25D-04W +1.5S
Ul4 = 09D+ 1.5S

Ul5 = 09D+ 1.0L+ 1.5S
Ul6 = 09D +04W +1.58
Ul7 = 09D-04W +1.5S
Ul8 = 125D+ 1.4W

Ul9 = 125D+ 0.5L+1.4W
U20 = 1.25D+1.4W +0.5S
U21 = 1.25D-14W

U22 = 1.25D+0.5L-14W
U23 = 1.25D-14W +0.5S
U24 = 09D+ 1.4W

U25 = 09D +0.5L+1.4W
U26 = 09D+ 1.4W +0.5S
U27 = 09D -1.4W

U28 = 09D+ 0.5L—1.4W
U29 = 09D-14W +0.5S
U30 = 1.0D+ 1.0E

U3l = 1.0D+0.5L+ 1.0E + 0.25S
U32 = 1.0D-1.0E

U33 = 1.0D+0.5L-1.0E +0.25S

Service loads — the program calculates the factored loads using the input load
combinations. If slenderness effects are to be checked and the column is found to be
slender, the applied moments are magnified according to Procedures 2.5 and 2.6. For
each calculated factored load, the same computations described in (a) above are
performed.

Control points — for several key points on the interaction diagram, the program
calculates axial load and moment capacity together with the neutral axis depth and
maximum steel strain corresponding to the respective moment capacity. For ACI code,
strength reduction factor is also reported. The following key points are used by the
program: maximum compression, allowable compression, point where steel stress is
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zero, point where steel stress is 0.5f), balanced point, pure flexure and maximum

tension. For ACI code, an additional control point is introduced where maximum steel
strain is equal to 0.005 (tension control limit).

d) Axial loads — for each input axial load, the program calculates the positive and
negative moment capacities together with the corresponding neutral axis depths and
maximum steel strains. For ACI code, strength reduction factors are also reported.

2.3.2 Interaction Diagram Options

The program also computes the interaction diagram (uniaxial runs) or the three-dimensional
failure surface (biaxial runs) of the input section. The values of maximum compressive axial load
capacity and maximum tensile load capacity are computed. These two values set the range within
which the moment capacities are computed for a predetermined number of axial load values.

a) For uniaxial runs, positive and negative moment capacities about only the selected
axis are computed. Moment capacities about the orthogonal axis are ignored. To
compute the moment capacity at a certain level of axial load, the neutral axis angle is
held constant, parallel to the selected axis. The neutral axis depth is adjusted to arrive

at the desired axial load capacity. This is done for all the predetermined values of axial
load.

b) For biaxial runs, the same predetermined values of axial load are utilized. For each
level of axial load, the section is rotated in 10-degree increments from 0 degrees to 360
degrees and the M, and M, moment capacities are computed. Thus for each level of

axial load, an M,-M), contour is developed. Repeating this for the entire range of axial
loads, the three-dimensional failure surface is computed. A three-dimensional
visualization of the resulting entire nominal and factored failure surface is provided to
support enhanced understanding of the section capacity.

Also for each point on the interaction diagram or on the three-dimensional failure surface, the
program calculates the location of the neutral axis (expressed in terms of depth and angle of the
neutral axis), maximum steel strain, and (for ACI codes only) the strength reduction factor. These
results are reported for the maximum capacity of the section based on the ultimate limit states and
not for the given loading input. The information can however be used to draw conclusions or make
additional calculations for a given loading condition.

| 27 |



Sﬂ]mn METHOD OF SOLUTION

2.4
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(a) Moment slice at constant load P, (b) Half of P-M slice at constant angle A

Figure 2-7 Interaction Surface for Combined Axial Load and Biaxial Bending

Section Design Mode

1.

Based on the specified minimum, maximum and increment specified for the section and
the reinforcing bars, the program selects the smallest section with the least amount of
reinforcement for which the capacity exceeds the applied loads. If service loads are input,
they are factored using the input load combinations. Depending on the design criteria the
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2.5

user selects, the least amount of reinforcement the program searches for means either the
smallest number of bars or the smallest steel area.

The program starts the design by trying the smallest section (minimum dimensions) and
the least amount of reinforcing bars. The program verifies that the ratio of provided
reinforcement is always within the specified minimum and maximum ratios. Furthermore,

unless otherwise specified by the user’?, the bar spacing is always kept greater than or
equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 mm] for ACI** and 1.4 times
the bar diameter or 1.2 in [30 mm] for CSA®.

A section fails the design if, for any load point the capacity ratio exceeds 1.0 (unless
otherwise specified in the Design Criteria dialog box).

Once a section passes the design, its capacity is computed and the calculations explained
in Procedure 2.3 above are performed.

For members with large cross sectional area spColumn sometimes warns the user with the
following message “Cannot achieve desired accuracy”. This results when the program
cannot meet the predefined convergence criteria and the corresponding point on the
interaction diagram may be slightly off. The convergence criteria is more stringent than
required in engineering practice, however, the shape of the interaction diagram should be
verified to be relatively smooth and free of unexpected discontinuity.

Moment Magnification at Ends of Compression
Member

This procedure accounts for moment magnification due to second-order effects at ends of columns

36

in sway frames’".

1.

If properties of framing members are input, spColumn computes the effective length

o, . . . 37,
factor, kg, for sway condition using the following equation”:
2
(7 / ky) Y. ¥p _1 tani—(V/A_i_WBjﬂ _
36 g 6 kg

33. The user may select spacing greater than the default value to take into account tolerances for reinforce-

ment placement (see ACI 117-06, Ref [5]) and other project specific considerations.

34. ACI 318-14, 25.2.3; ACI 318-11, 7.6.3; ACI 318-08, 7.6.3; ACI 318-05, 7.6.3; ACI 318-02, 7.6.3
35. CSA A23.3-14, Annex A, 6.6.5.2; CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2
36. ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACT 318-05, 10.13; ACI 318-02,

10.13; CSA A23.3-14, 10.16; CSA A23.3-04, 10.16; CSA A23.3-94, 10.16

37. Exact formula derived in Ref. [12] pp. 851 for Jackson and Moreland alignment chart
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where y is the ratio of Y (El/f,) of columns to ) (EI/f) of beams in a plane at one end of
the column, y,4 and yp are the values of y at the upper end and the lower end of the
column. For a hinged end, y is very large. This happens in the case where ) (EI/f) of
beams is very small (or zero) relative to the ) (EI/€.) of columns at that end. In this case,
the program outputs 999.9 for the value of . The moment of inertia used in computing

is the gross moment of inertia multiplied by the cracked section coefficients>® (specified
in the Slenderness Factors dialog box).

2. For the ACI code®, slenderness effects will be considered if k {,/r>22.0. For the CSA
standards, all sway columns are designed for slenderness effects.

3. If the ratio k€, /r exceeds 100, slenderness effects cannot be accounted for using moment

magnification procedure40. A more exact method must be used. In this case, the program
issues a warning message and aborts design or investigation procedure except for
calculations per ACI 318-14, ACI 318-11, and ACI 318-08 where limit of k& £,/r <100
does not explicitly apply and the program continues calculations after showing the
warning message.

4. Factored moments, M, and M, p,p due to dead, live, and snow loads assumed to

s,top
cause no appreciable sidesway‘“, are calculated at the top and bottom ends of the column.

5. Factored moments, M, .,

to cause appreciable sidesway42, are calculated at the top and bottom ends of the column.

and M p,,, due to lateral loads (wind and earthquake) assumed

6. Flexural stiffness EI is calculated as™*:

02E I +EI
EJ = c'g s'se
1+ﬂds

where E,. is the modulus of elasticity of concrete, E is the modulus elasticity of steel, I, is

the gross moment of inertia of the concrete section, I, is the moment of inertia of

38.ACI318-14,6.6.3.1.1,6.6.4.2,6.7.1.3,6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-
05, 10.11.1, 10.13.1; ACI 318-02, 10.11.1, 10.13.1; CSA A23.3-14, 10.14.1.2, 10.16.1; CSA A23.3-04,
10.14.1.2, 10.16.1; CSA A23.3-94, 10.14.1, 10.16.1

39. ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACT 318-08, 10.10.1; ACI 318-05, 10.13.2; ACI 318-02,
10.13.2

40. ACT 318-05, 10.11.5; ACT 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA
A23.3-94,10.13.2

41. ACI 318-14,2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14,
3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

42. ACI 318-14,2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04,
2.3; CSA A23.3-94,10.0

43. ACI 318-14, 6.6.4.4.4, Eq. 6.6.4.4.4b; ACI 318-11, 10.10.6 Eq. 10-14; ACI 318-08, 10.10.6 Eq. 10-14;
ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3 Eq.
10-19; CSA A23.3-04, 10.16.3.2, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.16.3.2, 10.15.3.1 Eq. 10-18
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reinforcement. Assuming that shear due to lateral loads is not sustained in most frames**,

the By is taken as zero (with the exception of strength and stability of the structure as a

whole under factored gravity loads described in Step 11).

7. The critical buckling load, P,, is computed as®.
2
Pc _m EI2
(k1)
8. The sway moment magnification factor, o, is computed as*0:
1.0
=" >
o 3p 1.0
$ LR

where the stiffness reduction factor, ¢, is equal to 0.75.

XP, is taken as the factored axial load for the load combination under consideration times
the ratio ZP,/P,, i.e.*’ £P, = P, (ZP,/P,).

XP,. is taken as the critical buckling load for the load combination under consideration
times the ratio XP./P,, i.e. XP.=P.(XP./P,).

¢k and the ratios £P,/P, and XP/P, may be modified using the Slenderness Factors
input box.

9. The magnified moments at the top and bottom ends of the compression member are

computed as*;

Myop = My, top + 6sM, top

Mbot = Mns, bot + 5sMs, bot

10. The smaller and the larger factored end moments are then determined based on absolute
values of magnified top and bottom end moments

44.ACI 318-14, R6.6.4.6.2(b); ACI 318-11, R10.10.7.4; ACI 318-08, R10.10.7.4; ACI 318-05, R10.13.4.1,
R10.13.4.3; ACI 318-02, R10.13.4.1, R10.13.4.3; Ref. [10] pp 586 (first paragraph from the bottom)

45.ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13;
ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3.1 Eq.
10-18; CSA A23.3-04, 10.16.3.2, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.16.3.2, 10.15.3 Eq. 10-17

46. ACI 318-14, 6.6.4.6.2, Eq. 6.6.4.6.2b; ACI 318-11, 10.10.7.4 Eq. 10-21; ACI 318-08, 10.10.7.4 Eq. 10-
21; ACI 318-05, 10.13.4.3 Eq. 10-18; ACI 318-02, 10.13.4.3 Eq. 10-18; CSA A23.3-14, 10.16.3.2
Eq. 10-24; CSA A23.3-04, 10.16.3.2 Eq. 10-23; CSA A23.3-94, 10.16.3.2 Eq. 10-23

47. To minimize required input, the program uses one value of ratio P,/ P, for all load combinations.
However, the ratio can vary depending on the combination under consideration. In this case, it will be
conservative to use the highest value of the ratio.

48. ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13.3; ACI 318-02,
10.13.3; CSA A23.3-14, 10.16.2; CSA A23.3-04, 10.16.2; CSA A23.3-94, 10.16.2
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I1.

2.6

b

2 |Mb0t

My if |Mt0p

Mtop if|Mt0p < |Mb0t

b

2 |Mb0t

Mtop if|Mt0p
Mbot if|Mt0p

While design codes define moment M, as always positive and the sign of moment M;

2

H =

< |Mb0t| .

depending on single or double curvature bending49, spColumn retains actual signs of
moments M; and M,. This revision ensures proper comparison against negative and

positive moment capacities of unsymmetrical sections (see Figure 2-8).

Strength and stability of the structure as a whole under factored gravity loads’ 0 is ensured
by checking that the value of the moment magnification factor, J. is positive and does not
exceed 2.5.

The program performs this check for all load combinations that include only gravity loads
with the exception of the ACI 318-14/11/08 codes for which the check is not performed
and CSA A23.3-94 where the check is performed only for the load combination of 1.25
dead load plus 1.5 live load plus (1.5 snow or 0.0 snow), if this combination is present
(default). The g, factor for the load combination under consideration is equal to the

maximum sustained factored axial load to the maximum factored axial load.

Moment Magnification along Length of
Compression Member

This procedure accounts for moment magnification due to second-order effect along the length of

compression members that are part of either nonsway5 Uor sway frames>2. In nonsway frames,
moment magnification along length is neglected by the program if the condition in Step 3 is
satisfied.

49.

50.

51.

52.

ACI318-14,2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14,
3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

ACT 318-05, 10.13.6; ACI 318-02, 10.13.6; CSA A23.3-14, 10.16.5; CSA A23.3-04, 10.16.5; CSA
A23.3-94,10.16.5

ACI 318-14, 6.6.4.4.2, 6.6.4.5.1, 6.6.4.5.2; ACI 318-11, 10.10.6; ACI 318-08, 10.10.6; ACI 318-05,
10.12; ACI 318-02, 10.12; CSA A23.3-14, 10.15; CSA A23.3-04, 10.15; CSA A23.3-94, 10.15

ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2; ACI 318-08, 10.10.2.2; ACI 318-05, 10.13.5; ACI 318-02,
10.13.5; CSA A23.3-14, 10.16.4; CSA A23.3-04, 10.16.4; CSA A23.3-94, 10.16.4
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In sway frames designed per ACI 318-02/05 and CSA A23.3-94/04/14, the magnification along
the length is neglected if>3:

L 35
r | R
f'cAg

By rearranging and introducing k= NP/ ' -Ag) ., this condition can be succinctly expressed as

K ¢,/ r <35. For columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 codes, moment
magnification along length is to be considered for all slender compression members, i.e. columns

in either nonsway or sway frames regardless of the K ¢,/ r ratio. Since various published examples
of columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 do not combine moment

magnification at ends and along length of columns in sway frames>*, spColumn optionally allows
not considering moment magnification along the length of a column in a sway frame based on
engineering judgment of the user.

When moment magnification along the length of a compression member is considered, the
following procedure is followed:

1. The effective length factor, k, is either entered by the user or calculated by the program.

The value of k must be between 0.5 and 1.0 for moment magnification along length and

the recommended> value is 1.0. Smaller values can be used if justified by analysis. If

properties of framing members are input, spColumn computes the effective length factor,

k, for nonsway condition from the following equation’ 6.

2
YaVp| @ Yat Vs lk 2, 1
4 | 2 +( 2 j(l_tan(n/k))Jrn/ktanﬁ_l

Where y is the ratio of ) (EI/¢,) of columns to ) (EI/f) of beams in a plane at one end of

the column, wA and wB are the values of y at the upper end and the lower end of the
column, respectively. Moments of inertia used in computing y factors are gross moments

of inertia multiplied by the cracked section coefficients>’ (specified in the Slenderness
Factors dialog box).

53. ACI 318-05, Eq. 10-19; ACI 318-02, Eq. 10-19; CSA A23.3-04, Eq. 10-26; CSA A23.3-04, Eq. 10-25;
CSA A23.3-94, Eq. 10-25

54. See Example 11.2 in Ref. [9], Example 12.4 in Ref. [11], and Example 12.3 in Ref. [10]

55. ACI 318-14, 6.6.4.4.3, R6.6.4.4.3; ACI 318-11, 10.10.6.3, R10.10.6.3; ACI 318-08, 10.10.6.3,
R10.10.6.3; ACI 318-05, 10.12.1; ACI 318-02, 10.12.1; CSA A23.3-14, 10.15.1; CSA A23.3-04,
10.15.1; CSA A23.3-94, 10.15.1

56. Exact formula derived in Ref. [12] pp. 848 for Jackson and Moreland alignment chart
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2. Moments at column ends, M; and M,, are calculated, where M, is the moment with the
smaller absolute value and M, is the moment with the larger absolute value. For columns

in nonsway frames, the end moments will be equal to the factored applied first order
moment. For columns in sway frames, the end moments will be the moments M; and M,

calculated in the procedure for moment magnification at ends of compression member.
While design codes define moment M, as always positive and the sign of moment M,

depending on single or double curvature bendingsg, spColumn retains actual signs of
moments M; and M, to ensure proper comparison of resulting magnified moments against
negative and positive moment capacities of unsymmetrical sections (see Figure 2-8). This
revised interpretation does not affect results of the moment magnification along length
procedure because the procedure relies on the M;/M, ratio. spColumn follows the code

definition which assumes the ratio to be positive if the member is bent in single curvature
and negative if bent in double curvature. If both moments are equal to zero, the program
conservatively assumes the ratio of M/M,=1.0.

3. Second-order effects along length for columns in nonsway frames can be ignored if:

k¢ M,
“ <34-12—L <40 for ACI codes’°,
r M,
and

k&, _25-10(M;/ My)

a \/Pf/(f'c Ag)

where £, is the unsupported column length, r = /I, /A is the radius of gyration, and the

, for the CSA standards®?,

ratio M,/M, is always taken as greater than or equal to —0.5.

4. Iftheratio k £,/ r exceeds 100, slenderness effects cannot be accounted for using moment

magnification procedure“. A more exact method must be used. In this case, the program
issues a warning message and aborts design or investigation procedure except for

calculations per ACI 318-14, ACI 318-11, and ACI 318-08 where limit of k £,/ r <100

57.ACI318-14,6.6.3.1.1,6.6.4.2,6.7.1.3,6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-
05, 10.11.1, 10.12.1; ACI 318-02, 10.11.1, 10.12.1; CSA A23.3-14, 10.14.1.2, 10.15.1; CSA A23.3-04,
10.14.1.2, 10.15.1; CSA A23.3-94, 10.14.1, 10.15.1

58.ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14,
3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

59.ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACT 318-05, 10.12.2; ACI 318-02,
10.12.2

60.CSA A23.3-14,10.15.2; CSA A23.3-04, 10.15.2; CSA A23.3-94, 10.15.2

61.ACI 318-05, 10.11.5; ACT 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA
A23.3-94,10.13.2
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does not explicitly apply and the program continues calculations after showing the
warning message.

5. The factor C,, is computed as®?:

M,
C,=0.6+04—1
M,

and for codes other than ACI 318-14, ACI 318-11, and ACI 318-08, C,, is taken as not
less than 0.4.

.063

If M{=M,=0, the program assumes C,, to be equal to 1.0°". This is consistent with the

assumption made above (in Step 2).
6. The sustained load factor S, (B; for ACI 318-05/02 and CSA A23.3-14/04/94) is

computed as the ratio of maximum factored axial sustained load to the maximum factored
axial load for the load combination under consideration for compression members either

in nonsway64 or sway65 frames. The value of £, 1s not taken greater than 1.0.

7. Flexural stiftness EI is computed as%®;

02E.1,+E
El = clg sise
1+'Bdns

where E. is the modulus of elasticity of concrete, E is the modulus of elasticity of steel, I,
is the gross moment of inertia of the concrete section, and I, is the moment of inertia of

reinforcement.
8. The critical buckling load, P, is computed as®’:
_ 2’El
¢ 2
(k)

62. ACI 318-14, 6.6.4.5.3; ACI 318-11, 10.10.6.4; ACI 318-08, 10.10.6.4; ACI 318-05, 10.12.3.1; ACI 318-
02, 10.12.3.1; CSA A23.3-14, 10.15.3.2; CSA A23.3-04, 10.15.3.2; CSA A23.3-94, 10.15.3.1

63. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-
02,10.12.3.2

64. ACI 318-14, 6.6.4.4.4; ACI 318-11, 10.10.6.2; ACI 318-08, 10.10.6.2; ACI 318-05, 10.11.1; ACI 318-
02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

65. ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2, 10.10.6.2; ACI 318-08, 10.10.2.2, 10.10.6.2; ACI 318-05,
10.13.5; ACI 318-02, 10.13.5; CSA A23.3-14, 10.14.1.3(a), 10.16.4; CSA A23.3-04, 10.14.1.3(a),
10.16.4; CSA A23.3-94, B4 definition (a) in 10.0, 10.16.4

66.ACI 318-14, 6.6.4.4.4 Eq. 6.6.4.4.4(b); ACI 318-11, 10.10.6.1 Eq. 10-14; ACI 318-08, 10.10.6.1 Eq. 10-
14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.15.3 Eq. 10-19;
CSA A23.3-04, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.15.3.1 Eq. 10-18

67.ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13;
ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.15.3.1 Eq. 10-18;
CSA A23.3-04, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.15.3 Eq. 10-17
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9. The magnification factor for moment along length, é, is computed as®8:
C
s=—"_>10
1 _ u
St
where the stiffness reduction factor, ¢y, is equal to 0.75 (may be modified using the
Slenderness Factors input box) and P,, is the factored axial load for the load combination
under consideration.

10. The moment due to minimum eccentricity, e,,;, is computed as®:

M,,;,= P, e,in, Where

€pin=0.6 +0.03% , with h in inches,

Cpin=15 +0.034 , with h in mm,

and h is the section dimension (diameter for circular sections) in the direction being
considered.

11. The factored magnified moment along the length of a compression member, M, is the
larger’® of 6M, and 6M,,,;,,. The program also calculates moment M, based on the smaller
end moment, M, to account for scenario when M; and M, are of different sign (double
curvature bending). For an unsymmetrical section, the smaller moment, M;, may govern
the design when the moment capacity on the negative side of the interaction diagram is
smaller than the moment capacity on the positive side (see Figure 2-8).

68. ACI 318-14, 6.6.4.5.2 Eq. 6.6.4.5.2; ACI 318-11, 10.10.6 Eq. 10-12; ACI 318-08, 10.10.6 Eq. 10-12;

69.

70.

ACI 318-05, 10.12.3 Eq. 10.9; ACI 318-02, 10.12.3 Eq. 10.9; CSA A23.3-14, 10.15.3.1 Eq. 10-17; CSA
A23.3-04, 10.15.3.1 Eq. 10-16; CSA A23.3-94, 10.15.3 Eq. 10-16

ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI
318M-05, 10.12.3.2; ACI 318-02, 10.12.3.2; ACI 318M-02 10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA
A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3.

ACI318-14, 6.6.4.5.4; AC1318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-
02,10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3
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A
Axial Load,

>

M, oM,
Moment, M

Figure 2-8 Case of unsymmetrical section bent in double curvature (M4 and M, of
different sign) with the smaller end moment, M4, governing the design

2.7 Moments Magnification Ratio

For calculations in accordance with ACI 318-14/11/08, the value of total magnified moment
including second-order effects (combined magnification at ends and along length of compression

member) cannot exceed 1.4 times the corresponding moment due to first order effects’!. Columns
with second-order moment to first-order moment ratios exceeding 1.4 do not meet requirements of
ACI 318-14/11/08.

The ratio of second-order moment, M,,;, to first-order moment M, is calculated for both values

(i=1, 2) of magnified moment along length, M, ¢/ i.e. based on M; and Mj:

71. ACI 318-14, 6.2.6; ACI 318-11, 10.10.2.1; ACI 318-08, 10.10.2.1
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MCI.
i \M, | > M,
Manl ~ Mui lf‘ Uu; | mm|
My, | M., .
L, MCI lf‘Mul <|Mmin|
min

Cutoff value of M,,;,, is applied to M, in order to avoid unduly large ratios in cases where M,

moments are smaller than M,,,;,.

If only magnification at ends is considered (i.e. when user chooses to bypass provision 10.10.2.2
of ACI 318-14/11/08 and ignores second order effects along the length of a compression member
in a sway frame), the ratio of second-order moment, M5, 4, to first-order moment, My, is

calculated at both ends (i =1, 2) as:

Manl- _ M _ ]Mins +5S‘}Mis
Mlstl- M, ]Mins +A4is

U

where M; are the magnified end moments My and M,, and M, are the corresponding factored

applied moment composed of the part that causes no appreciable sidesway, M;,,, and the part that

mns>
causes appreciable sidesway, M. If both M,,,; and My, moments are equal to zero, the
l 1

program will report the ratio equal to 1.0. If only M 1st, Mmoment is equal to zero, the program will

report the ratio as a large value.

2.8 Section Capacity

The program computes capacity ratio for all load points. For a load point, capacity ratio is always
computed at the same angles as that produced by the applied My and My moments of that load

point.
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Section A-A (P-M Diagram)

v

The user can select one of the two available methods i.e. Moment-capacity or Critical-capacity, for
calculation of capacity ratio. In both methods:

Capacity ratio < 1 : internal load-point (is safe)
Capacity ratio = 1 : load point on diagram
Capacity ratio > 1 : external load point

Moment capacity

M,
] R 1 = —u
Capacity Ratio=

n

Sometimes the value of @M, cannot be obtained. In such cases the program reports a Capacity
ratio of “< 1” for load points inside the failure surface and a Capacity ratio of “> 1 for load points
outside the failure surface.

Critical capacity

Critical capacity ratio calculation is based on the closest distance (d) to a load-point from the
interaction diagram. But because the horizontal axis (M) & vertical axis (P) of P-M diagrams have
different units and scales, spColumn uses a normalized diagram for the calculation of closest
distance (d).
The normalized diagram is created by:

Dividing all “P” components of diagram-points and load-points by P

max

Dividing all “M” components of diagram-points and load-points by M.«

| 39 |



Sﬂ]mn METHOD OF SOLUTION

(P)
L0 Corresponding

Load-point - i
capacity pomnt

Closest
g distance
»(M »
/ Mmax 0D o™
P-M Diagram Normalized P-M Diagram

And the Critical capacity ratio of a load-point is:

Capacity ratio=1-d : internal load-point (is safe)
Capacity ratio = 1 : load point on diagram
Capacity ratio=1+d : external load point

The closest distance (d) can alternatively be calculated by finding the corresponding capacity

voint (OPr, DMn)

on the diagram which minimizes the following equation:
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3.1 spColumn Interface

The spColumn Interface will appear after the program is started as shown below. The
spColumn Interface consists of a Control Menu, Title Bar, Menu Bar, Toolbar,
Information Bar, Graphics Bar, and a Status Bar. The program name and current data file
name is shown in the Title Bar. All the menu commands can be accessed from the Menu Bar
and some frequently used commands also can be accessed from the buttons in the Toolbar.
The Status Bar shows the current state of the program.

Control Title Menu
Menu / Bar Bar

lel@]| = |

Column Cross Section

Toolbar

Main Window

Graphics Area

MATERIAL:

Input Data Echo

Information Bar

ﬁ Status Bar

Figure 3-1 Main Window

Control Menu

The Control menu is located in the upper-left corner of the window and includes commands
for sizing, moving, enlarging, restoring, and closing the window, as well as switching to other
applications. To access the Control menu using the mouse, click the left mouse button on the
box; using the keyboard, press ALT+ SPACEBAR.

Title Bar

The Title Bar displays the name of the application (spColumn in this case), along with the
name of the current data file in use. If the data has not been saved into a file, the word Untitled
is displayed in the Title Bar.
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Menu Bar

The Menu Bar is located directly beneath the Title Bar. It lists the available menus. There is
a total of 6 distinct drop-down menus accessible from the Menu Bar. The majority of
commands appearing in the drop-down menus are also accessible via the program’s Main
Window area.

Toolbar

The Toolbar is located directly below the Menu bar. It contains a collection of buttons (or
icons) that provide a shortcut to accessing the menu commands. The Toolbar buttons can only
be accessed using the mouse.

Information Bar

The Information bar is located on the left side of the spColumn window. The top part displays
the column cross section. The bottom part is a list of selected input data echo.

Graphics Area

The Graphics Area covers most of the window. This is where the interaction diagram is
shown.

Status Bar

The Status Bar is located directly beneath the program’s Main Window area. It displays
important information such as units, design code, cursor position, and helpful messages.

3.2 File Menu

The File menu gives access to file operations, printing

Mew Ctrl+N
operations and to exiting the spColumn program. open- e
ave trl+
Save As...
New (CTRL+N) mport ,
Export >
Clears any input data and returns the data to the default et
. Print Report >
values so that a new data file may be input. Prin Sercen.. ctnp
1 chusers\desktophtest.col
Open (CTRL+0) 2 C:\Program Files (x36)...\Exampled.col

3 c\users\sides different.col
4 C:\Users\Des,, \Example03.col

Opens an existing data file.

Exit

Save (CTRL+S)

Saves the changes you have made to the current input file under that same filename.
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Save As

Enables you to name or rename a data file.
Import

Reads geometry, reinforcement or loads data from an ASCII (TXT) file, or imports section
geometry and reinforcement from a DXF file.

Export

Exports interaction diagram and 3D failure surface to Comma-Separated Values (CSV) files
(readable by most spreadsheet programs) or Tab-Delimited Text (TXT) files. Exports a
column section to Drawing Exchange Format (DXF) file (readable by most CAD programs).
Exports graphical report (screen printout) to Enhanced Metafile Format (EMF) file (readable
by most graphics and word processing programs).

Revert

Discards any changes to the data file and returns to the most recently saved version of the data
file. This option will only be available if the data file has been previously saved and there have
been modifications done on the data file since. Do not save the data file immediately prior to
reverting otherwise this command will have no effect.

Print Report
Provides the option to print Default report or Customize the report before printing.
Print Screen (CTRL+P)

Prints the graphical image displayed in the Graphics/Input Area of the Main Window.
Displays Print dialog box and prints the results similarly as they appear on the screen.

Recent Data File List
Provides quick access to up to four recently open data files.
Exit

Ends the spColumn program. If you have made any changes to your data and have not saved
them, spColumn will prompt you whether you want to save or abandon any changes you have
made before you exit.
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3.3 Input Menu

The Input Menu includes commands used to input the data needed General Information..
to define a problem. The Input Menu contains the following
commands: General Information, Material Properties, Section,

Reinforcement, Slenderness, Loads, and Flip/Rotate Section.

Material Properties..,

Section »
Reinforcement b
Slenderness >

Loads >

General Information

The General Information command allows you to enter the Flip/Rotate Section
project, column and engineer names. It also allows the selection of

units, run options, run axis and slenderness consideration.
Material Properties

The Material Properties command enables you to input material properties for concrete and
reinforcing steel.

Section
Rectangular: Input the dimensions of a rectangular section.
Circular: Input the diameter of a circular section.

Irregular: Initiates spSection module to define an irregularly shaped section. Available under
investigation option only. See Chapter 6 for spSection module.

Reinforcement

All Sides Equal: Input a reinforcement pattern in which all the bars are of one size, and the
number of bars is the same on all four sides of a rectangular layout or are equally spaced for a
circular layout. Number of bars should be enter as multiple of four (4). Available for
rectangular and circular sections.

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and are
uniformly spaced on all four sides of a rectangular layout. Number of bars should be entered
as multiple of four (4). Available for rectangular sections only.

Sides Different: Input a reinforcement pattern in which each one of the four sides of a
rectangular section has a certain number of bars and a certain bar size. Available for
rectangular sections only.

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any size can be
placed anywhere within the column section.
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Confinement: Input confinement-related data such as the capacity reduction factors and the
size of ties associated with the longitudinal bar size.

Design Criteria: Input parameters that govern the design of the section such as column type,
minimum and maximum reinforcement ratio, bar selection criterion, minimum clear spacing,
and allowable capacity (ratio).

Slenderness
Design Column: Input data needed for slenderness related to the column being considered.

Column Above/Below: Input data needed for slenderness related to the columns above and
below the design column.

X-Beams: Input data needed for slenderness related to beams perpendicular to the x-axis
framing into the design column at top and bottom joints.

Y-Beams: Input data needed for slenderness related to beams perpendicular to the y-axis
framing into the design column at top and bottom joints.

Factors: Slenderness factors related to stiffness reduction factor and cracked-section
coefficients. Code defaults are selected by default. However, user-defined selection is also
available.

Loads

Factored: Input factored axial loads and moments. This option is available for non-slender
columns only.

Service: Input service-level (dead, live, wind, earthquake, and snow) axial loads and moments
about the active axis. Moments are input at the top and at the bottom of the column. This
option is available for both slender and non-slender columns.

Control Points: If chosen, the program will compute key points on the interaction diagram. In
addition, the splice regions are shown on the interaction diagram. This option is available for
non-slender columns under the investigation option only. Also the splice lines are only shown
for uniaxial runs.

Axial Loads: Input a group of axial loads with an initial value, a final value, and an increment.
This option is available for uniaxial non-slender columns under the investigation option only.

Load Combinations: Input the load factors and combinations used to combine the service
loads.

Flip/Rotate Section

Flip an unsymmetrical section about an axis or rotate an irregular section (created in
spSection).
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3.4 Solve Menu

The Solve Menu contains the command to execute the
design or investigation calculations along with options
that control inclusion of nominal capacity calculations,
tracing through the design process, and creating the
classic results file. The Solve Menu contains the

Execute F5

Include Nominal Diagram
Design Trace

Classic Results File

following commands: Execute, Include Nominal Diagram, Design Trace, and Results File.

Execute (F5)
Executes the Solver.
Include Nominal Diagram
Toggles INCLUDE NOMINAL DIAGRAM option on and off.
Design Trace
Toggles DESIGN TRACE option on and off.
Classic Results File

Toggles CLASSIC RESULTS FILE option on and off.
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3.5 View Menu

The View menu commands can be used to customize the —_— e
display screen to suit your viewing needs and enable you Reporter F7
to view the result diagrams. The View menu contains the Redraw

following commands: Results, Reporter, Redraw, Copy Diagram to Clipbosrd =€
Copy Diagram to Clipboard, Information Bar, Tool : :;zlr::,tm o

Bar, Status Bar, Grid, Mx-My Diagram, P-M ¥ Statusgar

Diagram - Full, P-M Diagram - M Positive, P-M :fwmagmm

Diagram - M Negative, 2D/3D Viewer, Next Load, P-M Diagram - Full

Previous Load, Next Angle, Previous Angle, Show i
P-M Diagram - M negative

Load Point Labels, Show Splice Lines, Show Normal 2D/3D Viewer
Diagram, Superimpose... Nedt Load Ctrl+Arrow Up
Previous Load Ctrl+Arrow Down
Mext Angle Ctrl+Arrow Right
Results (F6) Previous Angle Ctrl+Arrow Left
Executes the spResults module to view the input and f:”“ t“;"_d "L°_i”t ebels
ahow splice Lines
output data after a successful run has been performed. | Show Nominal Diagram
Superimpose...
Reporter (F7)
Executes the spReporter module to generate and print reports after a successful run has been
performed.
Redraw

Redraws the displayed diagrams or contours.
Copy Diagram to Clipboard (CTRL+C)

Copies the displayed diagram or contour to clipboard so that in can be pasted in other
applications.

Information Bar

Shows or hides the Information Bar.
Tool Bar

Shows or hides the Tool Bar.
Status Bar

Toggles the Status Bar at the bottom of the screen on or off.
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Grid

Shows or hides the Grid.
Mx-My Diagram

View a contour of the failure surface sliced at a constant axial load.
P-M Diagram - Full

View an interaction diagram sliced at a constant (M, My) angle drawn for both positive and

negative moments.
P-M Diagram - M positive

View an interaction diagram sliced at a constant (My, M) angle drawn for the positive

moments only.
P-M Diagram - M negative

View an interaction diagram sliced at a constant (M,, M) angle drawn for the negative

moments only.
2D/3D Viewer

View and analyze 2D interaction diagrams and contours along with 3D failure surfaces in a
multi viewport environment.

Next Load (Ctrl + Arrow Up)

View an M,-M, interaction diagram for the factored load next to the one displayed currently

on the interaction diagram.
Previous Load (Ctrl + Arrow Up)

View an M,-M; interaction diagram for the factored load previous to the one displayed

currently on the interaction diagram.
Next Angle

View a P-M interaction diagram for the (M, M,) angle next to the one currently displayed on

the interaction diagram.
Previous Angle

View a P-M interaction diagram for the (M, My) angle previous to the one currently displayed

on the interaction diagram.
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Show Load Point Labels

Show/Hide Load Point labels of loads input.
Show Splice Lines

Show the P-M splice lines corresponding to f; = 0 and f; = 0.5f,

Show Nominal Diagram

Show nominal (unfactored) capacity interaction diagram in addition to the design (factored)
capacity interaction diagram. Available only when Include Nominal Diagram option is
selected in the Solve menu.

Superimpose

Superimpose an interaction diagram from a previously saved run over the current interaction
diagram.

3.6 Options Menu

The Options menu allows you to change the startup options of the Startup Defautts..

spColumn program to suit your needs. The Options menu contains Reinforcement...
the following commands: Startup Defaults and Reinforcement. Section Capacity...
Startup Defaults

The Startup Defaults command allows you to change the default system of units, design
code, reinforcement database, and the data directory which is where the program looks for data
when it is executed.

Reinforcement
View or Edit reinforcing bar set.
Section Capacity

The Section Capacity command allows you to change the method by which the adequacy of
the system to the set of applied loads is checked.
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3.7 Help Menu

The Help menu includes commands that enable you to obtain online

spColumn Info...

help for the program and show the copyright and registration Submit a Question...
information about your software. >
anual...
Help...
spColumn Info -
P f Tutorial Videos...
Opens information page for the current version of spColumn being st e
used in the default browser. Internet connection is required. Check for Updates...

Release Motes...

Submit a Questlon About spCelumn...

Opens “Submit a Question” page where you can ask questions on
Technical, Licensing, Sales, Pricing or other topics via e-mail. Internet connection is required.

Manual
Opens spColumn Manual in the default browser. Internet connection is required.
Help

Uses the default browser to open spColumn Help. It provides access to all available help
topics. Click on any topic and a help screen will appear with information about that item.
Internet connection is required.

Tutorial Videos

Uses the default browser to open a page containing spColumn tutorial videos. Internet
connection is required.

Design Examples

Uses the default browser to open a page containing design examples for StructurePoint
software. Internet connection is required.

Check for Updates
Checks if a newer version of spColumn is available. Internet connection is required.
Release Notes

Uses default browser to open a page containing release notes for the version of spColumn
being used. Internet connection is required.
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About spColumn

Shows the version number of the program, the licensing information, and the copyright
information. In the case of a trial license, the expiration date is given as well as the locking
code which is needed to obtain a standalone license.
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4.1 Introduction

In this chapter, the sections follow the order in which commands and options appear beginning
with those found under the File menu and ending with those under the Help menu.

Many of the commands and options that appear under these menus are also accessible by other
methods. Consequently, these other methods are also explained.

4.2 Creating New File

When spColumn is loaded, the program is ready to begin receiving input for a new project. Until
you save the file, the data will not have a filename associated with it, and the title bar will display
the word Untitled as illustrated here:

5P spColumn - (Untitled)

File Input S5Sclve View Opticns Help

* From the File menu, choose New. This clears the screen in preparation for a new project
or data entry file and returns the program to its default settings.

» Ifexisting data on an open project has been changed prior to executing the New command,
the program will display the following message box inquiring whether you wish to save
the data on the open project or data file before creating a new file:

spColumn

"-I The following file has been modified.

. C\Program Files (x86)\StructurePoint\spColumn®Circular
Jacketed Steel Pile.col

Do you want to save it?

Yes Mo Cancel

4.3 Opening File

spColumn allows you to open data files that were saved at an earlier time including files from
previous versions of spColumn as well as pcaColumn. Note that the extension name of a
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pcaColumn and spColumn file is .COL. spColumn also opens files with the spColumn Text Input,

.CTI, extension.

4.4

From the File menu, choose Open and a dialog box will appear.

All files with the COL extension contained in the current drive and directory are displayed
in the FILE NAME list box. To view files with the .CTI’? extension use the file type drop-
down menu to choose the .CTI extension.

To open a file that exists in another drive or directory, select the drive or directory you
want from the LOOK IN drop-down list.

From the FILE NAME list box, select the file to be opened, or simply type its name in the
text box.

Choose the OK button.

Alternatively, an input file can be opened by spColumn if the file is drag-and-dropped
onto the program window or if the file pathname is provided as a command line parameter
when invoking spColumn from the command prompt.

5P Open
“ v « Examples » Examples-Manual v O Search Examples-Manual 2
Organize * New folder coR SN | 0
A .
@ OneDrive CTI Files
DXF Files
E This PC 4% Exampledl.col
- 3D Objects ) Exampled2.col
» A360 Drive &) Exampled3.col
I Desktop &) Bampledd.col
@ Documents P Bamplebiicol
; Downloads P Bompledticol
J‘) Music
v
File name: ‘Example{ﬂ.col v| spColumn Input Files (*.col)  +

Saving File

spColumn files are saved in a binary format with .COL or .CTI extensions.

72.For more information see "spColumn Text Input (CTI) file format" on page 182.
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441

442

Save the data with the same file name

At any time while editing a data file that has previously been saved under a file name,
choose File and Save to save the changes under the same file name, overwriting the old
file. From the File menu, select the Save command before giving the data file a name
displays the Save As dialog box.

Change format or rename the file

From the File menu, select Save As, and a dialog box will appear.

All files with .COL extensions contained in the current drive and directory are displayed
in the FILE NAME list box.

To save the file to a drive or directory other than the default, select a different drive or
directory drive from the SAVE IN drop-down list.

Use FILE TYPE list box to select either spColumn Input File, .COL, or spColumn Text
Input File, .CTIL.

In the FILE NAME text box, type a new file name. If no file extension is specified, an
extension will be appended to the specified file name based on the selected file type.

Choose the OK button.

« v P <« spColumn » Examples v D Search Examples

Organize = Mew folder = v

,® ©

~ - e
& OneDrive MName Date modified Type

[ This PC Mo iterns match your search.
) 30 Objects
a0 A360 Drive
[ Desktop
|:j Documents
‘ Downloads

J’! Music

| Pirtures

File name: -

Save as type: | spColumn Input Files (*.col) ~

~ Hide Folders Cancel

v £ >
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4.5 Most Recently Used Files (MRU)

New
Open...
Save

Save As...

Import

Export
Revert...

Print Results...

Print Screen...

1 C:\Program Files (x86)...\Example03.col

2 C:\Program Files (x86)...\ test.col } MRU

3 C:\Program Files (x86)...\Example09.col
4 C:\Program Files (x86)...\sides different.col

Exit

Ctrl+N
Ctrl+0
Ctrl+5

Ctrl+P

The Most Recently Used Files (MRU) list shows the four data files that were opened most
recently. Selecting a data file from this list makes it easier and faster to open the file. The list is

empty when the program is executed for the first time.

4.6 Importing

4.6.1 Importing Data

Geometry, reinforcement or load data may be imported from a text file.
The import file must be saved in pure ASCII (text) forma

» Select File | Import | Import Data... or press CTRL + I
keyboard shortcut to display IMPORT DATA dialog box. O Factored loads

» Select the type of data you want to import: SERVICE LOADS, ok | Cencel
FACTORED LOADS, REINFORCEMENT OR GEOMETRY.

t 73 Import Data (from text file)

™+ Geametry
" Reinfarcement

" Service loads

* Choose the OK button. The Open Import file box is displayed.

» All files with the TXT extension contained in the current drive and directory are displayed

in the FILE NAME list box.

» To open a file that exists in another drive or directory, select the drive or directory you

want from the LOOK IN drop-down list.

» From the File Name list box, select the file to be opened, or simply type its name in the

text box.

*  Choose the OPEN button.

73.For more information see "spColumn Text Input (CTI) file format" on page 182.
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4.6.2 Importing DXF Files

» Select File | Import | Import DXF.... to display Open Import file box.

» All files with the DXF extension contained in the current drive and directory are displayed
in the FILE NAME list box.

» To open a file that exists in another drive or directory, select the drive or directory you
want from the LOOK IN drop-down list.

» From the File Name list box, select the file to be opened, or simply type its name in the
text box.

*  Choose the OPEN button.

* The basic IMPORT MODEL FROM DXF FILE dialog box is displayed.

sp Import model from DXF file

CXF import DXF unit

Select layer(s) to import the section from | Use unit from DXF file
All v Unit system

+ Align section centroid to coordinate origin Length unit of model

*  Press OK button.

The advanced IMPORT MODEL FROM DXF FILE dialog box can be displayed by clicking
Advanced >> button in the basic view and is shown below.
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sp Import model from DXF file

Assign section layer(s)

Solid shape:

Opening shape:

Bars:

Layers

v Select/deselect all
v o

L4 |:| Section
L4 |:| Bars

+| Align section centroid to coordinate origin

<< Basic

DXF unit

| Use unit from DXF file
Unit system

Length unit of model

Preview

Reset camera

o | [ e ]

If the DXF file (or selected layer) contains a closed polyline entity (either LWPOLYLINE or

POLYLINE) it will be interpreted as the section outline. If multiple closed polylines are present
then the first two will be automatically recognized as the outline and the opening and the rest will

be ignored.

Reinforcing bars are derived from DXF circle entities (CIRCLE). If no closed polylines are

present then the first circle entity will be interpreted as a circular shape of the column and the rest

will be interpreted as reinforcing bars.

Dimensions of imported entities will be automatically converted to current project units based on

DXF header variable SINSUNITS if the “Use unit from DXF file” option is checked otherwise the
DXF file will be assigned the user defined length units and unit system which will then be

converted to the current project units.
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4.7

Exporting

Once a successful run has been performed you may export results

Factored Interaction Diagrar...

data Of the fOHOWing: Factored 3D Failure Surface...
Nominal Interaction Diagram...
1. Points from the interaction diagram or 3D failure surface to a Nominal 30 Failure Suﬁ:&m
Comma-Separated Values (CSV) file or to a Tab Delimited Column Section to DIF Fil...
Text file (TXT). These files can be read by most spreadsheet e

and mathematical programs where data produced by
spColumn can be further analyzed and processed as needed by the user. Coordinates of the
points (P, My, My) are saved together with corresponding location of the neutral axis

(depth and angle), maximum steel strain, and (for ACI code) strength reduction factor.

The column section can be exported to a file in Drawing Exchange Format (DXF) format
that is readable by most CAD programs.

A graphical report can be exported to a file in Enhanced Metafile Format (EMF) that is
readable by most graphics and word processing programs. The file will include column
section, column information, and the interaction diagram currently displayed on the screen
presented the same way as in the printout created by the default printer using the File |
Print Screen command. The following steps are used to export various output data:

Select File | Export | Factored Interaction Diagram to export P-M or M,-M, diagram

currently displayed on the screen.

Select File | Export | Factored 3D Failure Surface to export 3D failure surface (biaxial
runs only).

Select File | Export | Nominal Interaction Diagram to export nominal (unfactored) P-M
or M,-My diagram corresponding to the one currently displayed on the screen.

Select File | Export | Nominal 3D Failure Surface to export nominal (unfactored) 3D
failure surface (biaxial runs only).

Select File | Export | Column Section to DXF File to export column section to DXF file

Select File | Export | Graphical Report to EMF File to export graphical report to EMF
file.

For interaction diagrams and 3D failure surface, use FILE TYPE list box to select either
Comma-Separated Values (CSV) file or Tab Delimited Text file (TXT). For sections, only
DXF format is available and for graphical reports, only EMF format is available.

In the FILE NAME text box, type the file name. If no file extension is specified, an
extension will be appended to the specified file name based on the selected file type.

| 62 |



Sﬂjmn OPERATING spColumn

*  Choose the SAVE button.

5P Export Current P-M Diagram

« v <« Examples » Examples-Manual v D Search Examples-Manual »

Organize « New folder R v o

~
/@ OneDrive

[ This PC
) 3D Objects
¥ A360 Drive
[ Desktop
@ Documents
* Downloads

J’ Music

= Pirtures he

File name: | Examplel1-factored.csv “

Save as type:  Comma-Separated Values Files (*.csv) ~

» Hide Folders Cancel

4.8 Revert

Discards any changes to the data and returns to the last version of saved data. This option will only
be available if the file has been modified since the last file save.

4.9 Printing

Once a successful run has been performed you may print the diagram displayed on the screen
using File | Print Screen command. You may print the report using File | Print Report | Default
Report. If you select File | Print Report | Customized Report you will be taken to the
spReporter module.

4.9.1 Print Screen

» Select File | Print Screen. A dialog box appears.
* Select the printer to send the diagram displayed on the screen to.
» Use Print dialog controls to set up the printer options.

* Choose the OK button to start the printing or choose the CANCEL to terminate the print
job.
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= Print

General

—Select Printer

AIHP Laserlet 400 MFP M425 PCL 6

M Microsoft XPS Documen

ey HP Laser)et Professional P 1102w

M1 %end To OneMote 2013

M Microsoft Print to PDF

£

>

Status: Offline [~ Prnttofie Preferences |

Location:

GromeTe Find Printer. .. |
— Page Range

Lo Mumber of copies: |1 3:

" Selection ' Cument Page

" Pages: I

PBrint Cancel

49.2

» Select File | Print Report | Default Report. A dialog box appears.

Print Report

» Select the printer to send the report to.

» Use the PROERTIES button to access and modify the printer options if required.

» choose the OK button to start printing or CANCEL to terminate the print job.

Printer

Microsoft Print to PDF

D rdys
meaay

Settings
Paper

Crientation

Print

Properties

Letter -

Portrait r

Cancel

| 64 |



Sﬂ]mn OPERATING spColumn

410

General Information

The General Information command allows you to define or

change

4.11

General Information

options that will affect the rest of the input.

Labels
Select Input | General Information. A dialog box Project:
appears. |

Colurm: E ngineer:
Enter the PROJECT, COLUMN, and ENGINEER labels. | |
Select the units of measure, ENGLISH or METRIC. _

[ezign Code
Select the axis about which the column capacity is to (401 31814 ]
be computed: ABOUT X-AXIS, ABOUT Y-AXIS, or
BIAXIAL. [nits Fiun Option

] % Englizh (% |revestigation

Select a design code to conform to: ACI 318-14, ACI £ Metic ® Do
318-11, ACI 318-08, ACI 318-05, ACI 318-02, CSA -
A23.3-14, CSA A23.3-04 or CSA A23.3-94. & Aboutihuis O Biasial
Choose a run option: INVESTIGATION or DESIGN. ® L T
Specify whether slenderness effects are to be | “omeiderslendemess? € Yes & No
considered or not by checking either YES or NO under ok | Cancel
the CONSIDER SLENDERNESS? option.

Choose the OK button.

Material Properties

Select Input | Material Properties. A dialog box appears.

Enter the concrete compressive strength, £, under STRENGTH, f’c. The modulus of
elasticity, E., under ELASTICITY, Ec; the constant stress intensity, f, at the maximum

usable strain used to calculate the force on concrete, under MAX STRESS, fc; the factor
used to determine the depth of the stress block, under BETA(1); and the maximum usable
strain at the extreme concrete compression fiber, at the ULTIMATE STRAIN are
automatically computed and displayed. Modify any of the values if different than
computed.

For the reinforcing steel, enter the yield strength, f, under STRENGTH, fy. The modulus of

elasticity, E; under the ELASTICITY, Es, as well as Compression-controlled strain limit,

Eps_yt are automatically computed and displayed. Modify any of the values if different
than computed.
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* Choose the OK button to accept standard or modified values based on user’s judgment.

Material Properties

— Concrete — Reinforcing Steel
Strength, f'c: I bezi Strength, fy: IEEI fezi
v Standard v Standard

Elasticity, Ec: IF ksi EIasticity,Es:lW ki
Max stress, fo |34— ks
Beta(1]: IEIBE— Compreszion-controlled strain limit,
|Jltimate strain: W Eps_ut: Im

(1] I Cancel |

412 Section / Rectangular

4.12.1 Input for the Investigation Option:

Rectangular Section

» Select Input | Section | Rectangular. A dialog box appears. widh (along %E - [10° in

Depth [along *r; |2D in

* Enter the width and depth of the rectangular section using
WIDTH (ALONG X) and DEPTH (ALONG Y) respectively. Note
that width is measured along the x-axis and depth is measured ok | ceneel |
along the y-axis.

* Choose the OK button
4.12.2 Input for the Design Option:

* Select Input | Section | Rectangular. A dialog box

Rectangular Section

appears.

Start End Increment

* Enter the starting and ending values for each dimension | width(aongi; 10 10 [z in
(width and depth) along with an increment for each |Dephisongvi|z0 a0 [z i
dimension under START, END and INCREMENT columns o |
along WIDTH (ALONG X) and DEPTH (ALONG Y). Note
that the starting and ending values may be the same (in
which case the increment must be zero).

Cancel |

e Choose the OK button.
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413 Section/Circular

4131

4.13.2

Input for the Investigation Option:

Select Input | Section | Circular. A dialog box appears.

Enter the diameter of the column section.

Choose the OK button.

Input for the Design Option:

Select Input | Section | Circular. A dialog box
appears.

Enter the starting and ending values of the diameter
along with an increment. Note that the starting and
ending values may be the same (in which case the
increment must be zero).

Choose the OK button.

Circular Section

Diarmeter: I'I B in

o ]

Cancel |

Circular Section

Start End
Diameter 20 [30 |2 i

o]

|ncrement

Cancel |

414 Reinforcement/All Sides Equal

The Input | Reinforcement | All Sides Equal command allows you to enter the total number of
bars in the column section. The program attempts to place equal number of bars on each side of a

rectangular layout then equally space them on each side. For a circular layout, the program

attempts to equally space the bar.

4141

Input for the Investigation Option:

Select Input | Reinforcement | All Sides Equal. A
dialog box appears.

Enter the total number of bars in the section NO. OF
BARS (Must be at least 4 and a multiple of 4).

Select the bar size.

Mo, of bars: |4

Bar size: e -

Clear cover: I'I R in

% Transverse bars

All Sides Equal

Bar Layout

" Rectangular

™ Circular

Cover to

" Longitudinal bars

Enter the clear cover and specify whether it is to the
transverse bars (ties) or to the longitudinal bars.

T

Cancel |

Select a bar layout, CIRCULAR or RECTANGULAR.

The default is CIRCULAR for a circular section and RECTANGULAR for a rectangular

section.
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*  Choose the OK button

414.2 Input for the Design Option

All Sides Equal
* Select Input | Reinforcement | All Sides i i | S0
. @ Transverse bars
Equal. A dialog box appears. No.ofbars [T [0 | Longueiing bue

* Enter the minimum and maximum total number | Barsize:  [63 =] [#18 ~| - Bar Lapout
of bars in the section (must be at least 4 and @ | toacover [15 in ' Rectangular
multiple of 4 for a rectangular layout).

e Select the minimum and maximum bar sizes Ok, I Cancel |

along with the clear cover.

" Circular

* Enter the clear cover and specify whether it is to the transverse bars (ties) or to the
longitudinal bars.

» Select a bar layout, Circular or Rectangular. The default is CIRCULAR for a circular section
and RECTANGULAR for a rectangular section.

*  Choose the OK button.

415 Reinforcement/Equal Spacing

The Input | Reinforcement | Equal Spacing command allows you to enter the total number of
bars in the column section. The program attempts to place the bars equally spaced on all four sides
of a rectangular layout. This command is only applicable for rectangular sections.

4.15.1 Input for the Investigation Option:

* Select Input | Reinforcement | Equal Spacing. A

Equal Spacing

dialog box appears.

« Enter the total number of bars in the section NO. OF | Mo.ofbas: [+ M
BARS. (Must be at least 4 and a multiple of 4). Barsize: |88 ~] | ¢ Longhudinal bars

+ Select the bar size. Clearcover. [15in

» Enter the clear cover and specify whether it is to the o] Cancel_|

transverse bars (ties) or to the longitudinal bars.

e Choose the OK button.

4.15.2 Input for the Design Option:

* Select Input | Reinforcement | Equal Spacing. A dialog box appears.
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Equal Spacing

Minimurn M asinum — Cayver o

No. of bars: I4 |12 ¥ Transverse bars
Bar size: Iﬂg ,l Img 'I 1 Longitudinal bars
Clear cover: |1.5 it

Ok I Cancel |

* Enter the minimum and maximum total number of bars in the section under MINIMUM and
MAXIMUM corresponding to NO. OF BARS. (must be at least 4 and a multiple of 4).

* Select the minimum and maximum bar sizes.

» Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal
bars.

* Choose the OK button.

416 Reinforcement/Sides Different

4.16.1 Input for the Investigation Option:

» Select Input | Reinforcement | Sides Different. A
dialog box appears.

Sides Different

Top Bottom  Left Right

«  Enter the number of bars to be placed on each of the | Meetbas |t 8+ s
top, bottom (on the top and bottom, number of bars | ®s= |8 =llms <|fwe ~|lms -]
needs to be at least 2), left and right sides (on the lefp ~|® e e e e

Cover to

and right, the number of bars may be any number) of {(:' Transverse bars " Longitudinal bars
the rectangular section. Note that corner bars are
associated with the top and bottom sides. ] =

» Select the bar size and enter the clear cover for each
of the top, bottom, left and right sides of the section.

» Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal
bars.

e Choose the OK button.

4.16.2 Input for the Design Option:

* Select Input | Reinforcement | Sides Different. A dialog box appears.
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* In the Top and Bottom Group

Enter the minimum and maximum total number of bars to be placed on the top and
bottom sides.

The number of bars must be greater than 4 and a multiple of 2. Corner bars are associ-
ated with the top and bottom sides.

Select the minimum and maximum bar size and enter the clear cover.

* In the Left and Right Group

Enter the minimum and maximum total number of bars to be placed on the Left and
Right sides. The minimum and maximum number of bars can be set to zero (0) or must
be multiple of 2.

The minimum and maximum bar size entries are inactivated, therefore, follows the
entries for Top and Bottom Group.

Enter the clear cover.

Sides Different

Top and Battom Left and Right

Miminnurn b asimom Finirum b asimum
No. of bars: | |4 |14 o [10

Bar size: |ﬂ3 ﬂhﬂsﬂ |3¢3 J|ﬂ18J
Clear cover: | |1.5 in 1.5 it

Cowver to

¢ Transverse bars ¢ Longitudinal bars

ak. | Cancel |

» Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal

bars.

e Choose the OK button.

417

Reinforcement/Irregular Pattern

The Input | Reinforcement | Irregular Pattern command allows you to specify any number of
bars (up to 10,000) to be placed anywhere within the column section. Each bar may have any
cross-sectional area. This command is available with the Investigation option only.
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4.18

Select Input | Reinforcement | Irregular Pattern. If
the section is irregular, The spSection window, where
the section reinforcement may be graphically input, is
displayed. Otherwise, a dialog box appears.

Enter the bar area, along with its x- and y-coordinates.

Choose the INSERT button. The data are added to the
list box.

Repeat the steps above for each entry.

To edit an entry, select it from the list box, modify its
values in the text boxes, and choose the MODIFY
button. To change the area for several bars at once,
select those bars from the list box, enter the new area
in the AREA text box, and choose MODIFY.

Irregular Reinforcement Pattern

Area ®-Coord. -Coord.
|o.79 |5.625 |-5.625
in"2 in in

Izert | b odify | Delete ‘
| Mo, Area = N
1 073 5625 5625
2 079 5625 5625
3079 h.625 -5.625
_.1

DK‘

Cancel

To delete a bar entry, select it from the list box and choose the DELETE button.

Choose the OK button.

Reinforcement/Confinement

Select Input | Reinforcement | Confinement. A
dialog box appears.

Select the type of bar confinement: TIED (default),
SPIRAL, or Other. The capacity reduction factors
change depending on the selection.

To modify the capacity reduction factors, choose
OTHER for confinement type.

For the ACI code:

Phi(a) is the reduction factor for allowable compression,

Phi(b) is the strength reduction factor for tension
controlled failure,

Phi(c) is the reduction factor for compression controlled

failure.

For the CSA code:

Phi(a) is the reduction factor for allowable compression,

Confinement

Ted__ 2

Capacity Reduction Factors, Phi

Confinement:

Axial compreszion [a): 0.2
Tengion-controlled failure (b]: 04
Comprezsion-controlled failure [c]  |0.65

Tie Sizes

#3  «| tieswith |H#10 | bars or smaller.
#t4 | ties with larger bars.

o]

Cancel ‘
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Phi(s) is the material resistance factor for steel,
Phi(c) is the material resistance factor for concrete.

» Specify the tie size associated with the particular longitudinal bar sizes. The code
requirements are used as defaults.

* Choose the OK button.

Note that if confinement is selected as TIED or SPIRAL then the program will automatically adjust
the factors when the user changes the design code. However, if OTHER confinement is selected,
the factors will not be adjusted.

For CSA A23.3-14, the reduction factor for allowable compression is variable (shown as VAR)
and for irregular sections the wall thickness or minimum column dimension must also be
specified.

419 Reinforcement / Design Criteria

* Select Input | Reinforcement | Design Criteria. A
dialog box appears. This command is available with

Design Criteria

the Design Option Only Colurn Type Reinforcement Ratio
" Structural b ,1_ =
» Specify whether the column is to be considered € Architectural Masimum: [B] 2
STRUCTURAL (default), ARCHITECTURAL, or OTHER. * Userdefined
Notice that the minimum and maximum Bar Selection
reinforcement ratios change depending on the S LTI EES
selection. " Minimum area of steel

Minimum clear spacing between bars; |1.5 in

e Choose whether bar selection is to be based on o
Allowable Capacity [F atio]: 1

MINIMUM NUMBER OF BARS (default) or on MINIMUM
AREA OF STEEL.

Ratio <1 iz zafe

Ok, | Cancel |

* To modify the limiting reinforcement ratios, choose

OTHER. Enter the minimum and maximum
reinforcement ratios in the corresponding text boxes.

» Enter the minimum clear bar spacing and the allowable capacity (ratio).

*  Choose the OK button.
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4.20

Slenderness / Factors

4.21

Select Input | Slenderness | Factors. A dialog box appears.
Note: this command is available for slender columns only.

The default values, per the design code, for the stiffness
reduction factor (used to compute the moment magnification
factors) and the cracked section coefficients for beams and
columns are displayed. To modify these values, select the

USER-DEFINED option and enter your values.

Choose the OK button.

Slenderness Factors

{+ Code defaultz T User-defined

Stiffness reduction factar,  |0.75

Cracked-section coefficients

Beams [clb): 035
Colurmns [cle): 0.7
] | Cancel |

Slenderness / Design Column

Select Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-axis
data groups may be disabled depending on the active run axis. Note: this command is

available for slender columns only.

Enter the clear column height in the corresponding text box.

Specify whether the column is braced against sidesway or not by selecting or clearing the

NONSWAY FRAME option.

For a sway column, enter the ratio of the sum
of the critical load of all story columns to the
critical load of the column under
consideration, (SUM PC)/Pc. Also, enter the
ratio of the sum of the factored axial load of
all story columns to the factored axial load of
the column under consideration, (SuM PU)/

PU. Check 2P ORDER EFFECTS ALONG

LENGTH option to consider 2" order effects
along length. Note: this option is available for
ACI 318-14, ACI 318-11, and ACI 318-08
codes only. For more information see
"Moment Magnification along Length of
Compression Member" on page 32.

In the EFFECTIVE LENGTH FACTORS group, specify whether the k factor(s) are to be user-

Design Column

Kbz s
Clear height: 25 R Clear height: 225
% Monsway frame (& Monsway frame
" Sway frame " Sway frame
Sway criteria Sway criteria
{sumPcyiPel [I [SumPchPel [I
{Sum PupiPur [I [SumPupPa; [I
v ¥
Effective length factors Effective length factars
" Compute k' factors ™ Compute 'k' factors
& |nput 'k Factors: * |nput 'k' tactors:
knsk I kWsk 0 Kk [1 kEsk [0
Copy ta r'-Auis Copy to Az
ak | Cancel |

input or computed by the program, by selecting the corresponding option.
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» If you chose INPUT K FACTORS, enter the effective length factors for nonsway and sway
conditions, k(ns) and k(s), respectively.

* Repeat the steps above for each active axis.

e Choose the OK button.

4.22 Slenderness / Columns Above and Below

* Select Input | Slenderness | Columns Above/Below. A dialog box appears. Note: this
command is available for slender columns only for which the COMPUTE K FACTORS
option is selected in the DESIGN COLUMN dialog box.

Columns Above and Below

Column Above Caolurnn Below

I Mo column specified I Mo column specified
Height [c/c) ,T t Height [c/c): IT t
Width [along}p [12 s Width [slong}p [12 s
Depth [along ¥): ’T i Depth [along ) IT i
Concrete,  fo: ,4— ki Concrete,  Fo |4— ki
Ec: |3605 g Ec: |3605 |4

Copy to Column Below | Copy to Column Abowve |

QK | Carncel ‘

* In the COLUMN ABOVE group, specify whether or not a column above the design column
exists, by selecting or clearing the NO COLUMN SPECIFIED OPTION.

» Ifacolumn above exists; enter the center-to-center height, the width (along the x-axis), the
depth (along the y-axis), the concrete compressive strength, and the concrete modulus of
elasticity of the column above in the corresponding text boxes. For circular sections, enter
zero for the DEPTH and input the section diameter in the WIDTH box. If zero is entered for
both Width and Depth, the dimensions of the design column will be automatically used.

* Repeat the same for the column below or, if the column above and the column below are
the same, choose the Cory TO COLUMN BELOW button.

*  Choose the OK button.
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4.23 Slenderness / X-Beams

* Seclect Input | Slenderness | X-Beams. A
dialog box appears. Beams defined using

X-Beams (perpendicular to X)

this command span perpendicular to the x- Beam Location:

axis. Note: this command is avall.able for £ Above Left ¢ above Fight
slender columns only for which the
COMPUTE K FACTORS option is selected in
the DESIGN COLUMN dialog box and the

RUN AXIS is BIAXIAL or uniaxial ABOUT X-
AXIS. Span [cfc): 18 ft f'e: |4 kgl
* From the BEAM LOCATION group, choose Wwiidth: 20 in Ec: [3B05 ks

the appropriate option. The data group Depth: 24 in etz [23040 s
below updates depending on the selection.

» For the selected beam, specify whether or 0K | Cancel |
not a beam exists, by selecting or clearing

the NO BEAM SPECIFIED OPTION.

" Below Left " Below Right

Beam Above Left
[ Mo beam zpecified Copy From Beam Right |

« If a beam exists; enter the center-to-center span length, width, depth, concrete
compressive strength, concrete modulus of elasticity, and moment of inertia (if different
than computed) of the beam.

* Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and BELOW RIGHT.

* Choose the OK button.
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4.24 Slenderness /Y-Beams

* Select Input | Slenderness | Y-Beams. A dialog
box appears. Beams defined using this command

¥-Beams (perpendicular to )

span perpendicular to the y-axis. Note: this Beam Location:
command is available for slender columns only ' Above Left £ Above Right
for which the COMPUTE K FACTORS option is & Bl & EemRgn

selected in the DESIGN COLUMN dialog box and Eezinlraus Lol

. . . ik C Fi B Right
the RUN AXIS is BIAXIAL or uniaxial ABOUT Y- I Nobean specied _Copy From Beam g |
AXIS. Span [cfc] 12 ft f'er 4 kezi

“width: 12 in Ec: |4030.57 ksi

no Imertia 133750 14

* From the BEAM LOCATION group, choose the
appropriate option. The data group below SL 1
updates depending on the selection.

* For the selected beam, specify whether or not a
beam exists, by selecting or clearing the NO
BEAM SPECIFIED OPTION.

« If a beam exists; enter the center-to-center span length, width, depth, concrete
compressive strength, concrete modulus of elasticity, and moment of inertia (if different
than computed) of the beam.

* Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and BELOW RIGHT.

* Choose the OK button.

4.25 Loads / Factored

When designing or investigating a non-slender column, factored loads consisting of applied axial
loads and moments about the active axis may be input. This command is not available for slender
columns.
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» Select Input | Loads | Factored. A dialog box appears.

Factored Loads b4

» Enter the factored axial load in the LOAD text box.

Load K-Maoment r-Maoment
* Based on the active axis, enter the factored moment | [1750 60 o
about the x-axis, X-MOMENT, the factored moment | (kA L
about the y-axis, Y-MOMENT, or both. insert | Modiy | Deete |

| Mo, P [P by

e Choose the INSERT button. The data are added to the
list box.

» Repeat the steps above for each factored load entry.

* To edit an entry, select it from the list box, modify its
values in the text boxes, and choose the MODIFY
button.

Ok Cancel

* To delete an entry, select it from the list box and choose
the DELETE button.

e Choose the OK button.

4.26 Loads / Service

When designing or investigating a non-slender or slender column, service level loads consisting of
dead, live, lateral (wind and earthquake), and snow axial loads and moments at both column ends
about the active axis may be input. These loads are then factored and combined based on the load
combinations.

* Select Input | Loads | Service. A dialog box appears.

» For each of the load cases: Dead, Live, Wind, Earthquake (EQ), and Snow, enter the axial
load and the applicable moment (about x or y) at the column top and bottom.

* Enter the percentage of the sustained part of the load in each load case (by default only
Dead Load is assumed to be 100% sustained). These percentages will be used to arrive at
sustained axial load ratio B4, to calculate moment magnification factor along length of

the column’*.
*  Choose the INSERT button. The data are added to the list box.

* Repeat the steps above for each entry.

74.For moment magnification at ends of a column in a sway frame, the value of s is assumed to be zero

and is not affected by sustained load factors (For more information see "Moment Magnification at Ends of
Compression Member" on page 29.)
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» To edit an entry, select it from the list box, modify its values in the text boxes, and choose
the MODIFY button.

* To delete an entry, choose it from the list box and choose the DELETE button.

e Choose the OK button.

Service Loads

—&wial Load [kip])——#-Moments (k-] —————— YMoments [k-ftfl———— — Sustained Load %]+
@ Top @ Bot @ Top @ Bot
Dead: | 380 |3z |54 jo jo |
Live: | [140 |20 |- Jo Jo |
Wind: | [0 |50 |50 jo jo |
Ea: | o jo o o o |
Snow: | |0 jo o jo jo |

Inzert I Modify I Delete |

INo. [P. bt bdxb, bk, Myb] for each caze

oK Cancel

4.27 Loads / Control Points

A non-slender column may be investigated without inputting any loads. The capacity of the
section is computed along with other section capacity parameters. This command is not available
for slender columns or under the Design option.

» Select Input | Loads | Control Points.

In the output file, key points (e.g. balanced point and pure bending) on the interaction
diagram are listed. For each point, the axial load and bending moment capacities, along
with the corresponding neutral axis depth, distance from extreme compression fiber to
centroid of extreme layer of longitudinal tension steel, net tensile strain in extreme layer of
longitudinal tension steel at nominal strength, and strength reduction factor (ACI only) are
listed. For a biaxial run, these points are listed for bending about positive and negative X
and Y axes.

| 78 |



Sﬂ]mn OPERATING spColumn

For ACI code, the program flags the unusual increase in axial load capacity in transition
zone between the balanced point and the tension control point.

75

For uniaxial runs, the bar splice requirements for columns '~ are indicated on the

interaction diagram.

4.28 Loads / Axial Loads

When investigating a non-slender column (uniaxial runs only), grouped factored applied axial
loads may be input. The corresponding moment capacity for each load is computed and output.
This command is not available under the DESIGN option, for biaxial runs, or if the column is
slender.

* Select Input | Loads | Axial Loads. A dialog box

Aial Loads
appears.
. i o Initial load Final load Increment

» To input a range of axial loads, enter the initial, final 120 i B

and increment values in the corresponding text boxes. {kin) (kip) (kip)

To input a discrete (single) axial load, enter its value in nset | Modiy | Delste |

the INITIAL text box, and enter zero in the FINAL and [No. Inidl  Final nc

INCREMENT text boxes. 1 6475 0 0

2 250 300 10

*  Choose the INSERT button. The data are added to the list
box.

* Repeat the steps above for each axial load entry you
may have.

ak Cancel

» To edit an entry, select it from the list box, modify its
values in the text boxes, and choose the MODIFY
button.

* To delete an entry, choose it from the list box and choose the DELETE button.

*  Choose the OK button

75. ACI 318-14, Fig. R10.7.5.2; ACI 318-11, Fig. R12.17; ACI 318-08, Fig. R12.17; ACI 318-05, Fig.
R12.17; ACI 318-02, Fig. R12.17; CSA A23.3-14, 12.17.3; CSA A23.3-04, 12.17.3; CSA A23.3-94,
12.17.3
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4.29 Loads/Load Combinations

spColumn allows you to specify up to 50 load combinations. The service load input under the load
cases (dead, live, wind, earthquake, and snow) are combined based on these combinations. A
minimum of one combination must be input.

» Select Input | Loads | Load Combinations.
A dialog box appears. For a new file, the REAELULLILE

default combinations per the selected code are | pead Live Wind EQ Snow
shown in the list box. e+ o + o + o + o
e« To add a new combination, enter the load nset | Moty | Delte | Deuis |
factors or multipliers for each load case, ||ComboDead Live  ‘wind EQ  Snow
DEAD, LIVE, WIND, Earthquake (EQ), and T i i
us 1z 1 0 0 15
SNOW. 4 1z 0 08 0 18
us 1z 1 16 0 05
* Choose the INSERT button. The data are added TR e -
: us 1z 1 A6 0 05
to the list box. TR e 0
uln 1z 1 0 1 02
* Repeat the steps above for each load unons o : ! 2
combination. Up to fifty combinations may be ws 03 0 0 1 0
defined.

* To edit an entry, select it from the list box,
modify its values in the text boxes, and
choose the MODIFY button.

* To delete an entry, choose it from the list box
and choose the DELETE button.

e Choose OK when done.
Ok Cancel

4.30 Flipping / Rotating the
Section

This command is available for Irregular sections and for sections with Sides Different or Irregular
reinforcement.
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* Select Input | Flip/Rotate Section. A dialog box appears.

I

. Flip/Rotate Section
» Select one of the options: FLIP SECTION ABOUT X-AXIS,

FLIP SECTION ABOUT Y-AXIS, or ROTATE SECTION. The | Flipsection abouti-axs

last option is available for irregular sections only. Flip section about ¥-axis

(" Rotate section

» If ROTATE SECTION is selected, enter the angle of rotation [T degress messured clockwise

(clockwise is positive).

e Choose the OK button. Ok, | Cancel

4.31 Executing a Run

4311 From the program

» Select Solve | Classic Results File. This is an option
that may be turned ON or OFF by choosing it again. Brecute P

With this option ON, an output file will be created Include Nominal Diagram

while the program is solving. The output file is a text 2;3: ::;Tts fie

file that contains an echo of the input along with

slenderness calculation output, load combinations, and

the critical points on the interaction diagram.

* Select Solve | Include Nominal Diagram. This is an option that may be turned ON or
OFF by choosing it again. With this option ON, calculations of nominal (unfactored)
capacity interaction diagram will also be included in the calculations so that the nominal
diagram can be viewed and exported in addition to the design (factored) capacity diagram.

» Select Solve | Design Trace (design option only). This is an option that may by turned ON
or OFF be choosing it again. With this option ON, if designing a column section, the
program will pause at each cross section and reinforcement layout it tries, and display the
cross section with its bars in the Information bar.

» Select Solve | Execute. If more data are needed to solve the problem, an error box appears
and you will be prompted for the required data. If all the needed data are input, the solver
portion of spColumn will start executing. The Solving box appears with a progress
indicator. Click Cancel to terminate the solution process. After a successful run, the
interaction diagram or the contour plot is displayed in the Graphics area of the window.
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Deriving Interaction Diagram

27 [360]

100%

4.31.2 From the command prompt

spColumn run can also be executed in batch mode from the command line prompt. Input data file,
output data file, and run options can be passed to the program via parameters. For instance typing
spColumn /i:Examples\ExampleOl.col will run spColumn and solve the column
defined in input file ExampleO1.col.

EX C\Windows\system32icmd.exe lﬂlﬁléj

C:“\Program Files (xB6>~StructurePoint>spColumn si:Examples“ExampleBl.col

Multiple cross-sections can be designed and analyzed by executing spColumn with multiple input
files using batch (BAT) files (see Examples.bat in the spColumn program folder). Combined with
Column Text Input files (CTI), this feature can be used for automation spColumn runs for projects
involving large numbers of cross-sections.

Help on how to use command line parameters can be obtained by typing spColumn /? at the
command prompt.
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spColumn Command Line Help d

spiColumn [fiinput_file] [foioutput_file] [farch|/stru] [fwind|/eq] [/iad] [/csv]/tet] [/nom] [/dxf]
[/emf[:eachp|:eachm|:each|:pall:mall:all]] [/cti] [/rdoc|/rpdf]/rhd|resv]/rds] [Fhelp]/?]

Parameters:

"
i

Input data file name

Jou Output data file name

farch  If reinforcement ratio is below 1%, consider column as architectural

fstru If reinforcement ratio is below 1%, consider column as structural

Jwind  If input file version prior to 3.50 is detected, consider lateral loads as wind loads

Jeq If input file version prior to 3.50 is detected, consider lateral loads as earthquake
loads

Jfiad Expert interaction diagram to [AD file that can be superimposed in spColumn

fesv Export interaction diagram to Comma-Separated Values file that can be
imported into spreadsheet program

Jht Export interaction diagram to Tab-Delimited Text file that can be imported into
spreadsheet program

/nom Include nominal interaction diagram in export

[ elxf Export column section to DXF file that can be imported inte CAD program

Jfemf  Export graphical reports to EMF files that can be imported inte graphics
and word processing software
Fer uniaxial runs, single P-M diagram is exported. Fer biaxial, one P-M
and one Mx-My diagrams are exported.
:eachm  P-M diagrams separately for each factored load point
:eachp  Mx-My diagrams separately for each factored load point
:each  P-Mand Mx-My diagrams separately for each factored load point
:mall  P-M diagrams for all serted and grouped angles of factored resultant mement
:pall Wix-My diagrams for all sorted and grouped levels of factored axial load
:all P-M and Mx-My diagrams for all serted and grouped resultant

morments and axial loads

/rdec  Export report in Word format

frpdf  Export report in PDF format

it Export report in TEXT format

fresv Export report in C5Y format

frds Export report in Excel format

[cti Export input data to spColumn Text Input file

/help Show this help

7 Show this help

Examples:

spCelumn fiinput.col

spiColumn fiinput.col focoutput.out Siad Sdxf fosv

spCelumn /i Chprejiinput.cel fo:D\proj\output.out /emf
spCalumn fiinput.col fooutput.out fiad femfall fwind farch

4.32 Viewing Results

Once a successful run has been performed, you may view the results file.

» Select View | Results. spColumn executes the spResults module. Alternatively you can
also access spResults by pressing the F6 key.
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» Use the explorer, options in the toolbar or the “PAGEUP” and “PAGEDOWN” buttons to
navigate through the data tables.

* You can click the CLOSE button in the top right corner to exit spResults window.

4.33 Changing Startup Defaults

You can change some default settings that spColumn uses when it is started or when the File | New
command is executed.

» Select Options | Startup Defaults. A dialog box appears.

Startup Defaults
* Enter the full path of the directory to which spColumn

defaults when opening a data file. Data directory:

* Select the system of units, design code, reinforcement, | system of urits: [Englsh |

and section capacity calculation method to be used as | pesign code: [acr 31814 ]
defaults whenever a new file is started. Reinforcemert. [ ASTH ABTS E

« Enter the number of lines per page to be used in | Sectioncapaciy |Momentcapaciy v |

formatting the classic results file. No. of lines per printed page: — [50
* Choose the SAVE button to save these options in the save | Cancel |
registry.
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4.34 Changing Reinforcement Bar Set

* Select Options | Reinforcement. A dialog box

appears Reinforcement
. Bar Set
4.341 Select a different set et ciofined save.. |
. Read..
* From the BAR SET drop-down list, select the set to LI
be used. Size: Dviam.: Area: wieight:
g |z |4 [13.6
* Choose the OK button. in in"2 pli
_ _ Add Modiy | Delste |
4.34.2 Create or modify a user-defined = Db A wh
set #3 0375 011 0,375
#4 05 0z 0,668
) #5 0625 031 1.043
* From the BAR SET drop-down list, select USER- HE 075 044 1502
#7 0875 06 2.044
DEFINED. The ADD, DELETE and MODIFY buttons Ha 1 079 2E7
#1128 1 34
are enabled. #0127 127 4303
#1141 156 5313
» To edit an entry, select it from the list box, modify 1693 -25 :
its values, and choose the MODIFY button.
* To delete an entry, select it from the list box and
choose the DELETE button.
. ) Ok, Cancel
» To add an entry, enter the bar size, diameter, area e

and unit weight in the corresponding text box, and
choose the ADD button. The data are added to the list box.

* A user-defined set may be saved to disk for use in other files. To do so, choose the SAVE
button after inputting the bars. The bar set is saved to the file specified by the user. To
retrieve a saved set, choose the READ button.

*  Choose the OK button.

4.35 Changing Section Capacity Calculation Method

You can change the method that spColumn uses to calculate section capacity.
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Section Capacity

Compute section capacdity based on:

" Moment capadity
{* Critical capacity

oK | Cancel

Select Options | Section Capacity. A dialog box appears.
Choose between Moment capacity or Critical capacity for calculating section capacity.

Choose the OK button.

4.36 Superimposing Diagrams

After executing a run and selecting the File | Save command, the program saves the diagram data
in a separate file that has the same file name as the input file, with an IAD extension. If

calculations of nominal interaction diagram are included, the program stores also the nominal
diagram data in an additional IAD file named as the input file name suffixed with “-nominal.iad”.

The IAD interaction diagram file may be later read by the program and two diagrams (of different
files) may be superimposed for the purpose of comparison. Note that the RUN AXIS (uniaxial or
biaxial) of the two files must be the same.

Select View | Superimpose option. The open dialog box appears.

All files with the IAD extension contained in the current drive and directory are displayed
in the FILE NAME list box. To open a file that exists in another drive or directory, select a
different drive or directory drive from the LOOK IN drop-down list.

From the FILE NAME list box, select the file to be opened, or simply type its name in the
text box.

Choose the OK button. If the data is successfully read, the diagram from the IAD file
(shown dotted) is superimposed over the currently displayed diagram.

To clear the superimposed diagram, uncheck the View | Superimpose option.
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4.37 Viewing 2D Diagrams

By default, the program displays diagrams based on the design (factored) section capacity.
Display of diagrams based on the nominal (unfactored) strength is controlled by the View | Show
Nominal Diagram option which is available when calculations of nominal diagram are activated
using the Solve | Include Nominal Diagram option.

For a uniaxial run, the program computes and displays the P-M interaction diagram. For a biaxial
run, the program computes the three-dimensional failure surface (P, My, M,). The failure surface
can be viewed in one of two ways:

a) P-M interaction diagram (vertical slice at an angle measured from M,)

b) M;-My contour curve (horizontal slice at a constant axial load).

Whenever the mouse cursor moves over the Graph area, the axial load, moment, and eccentricity
are displayed in the Status bar.

4.37.1 Viewing P-M Interaction Diagram

» Select View | P-M Diagram - Full. A dialog box

View Interaction

appears.
@ fingle (My, My) " Moments:
* You may also select View | P-M Diagram — M rle e 1) oen
ope . . . 1] degrees 353 bl
positive or View | P-M Diagram — M negative to | o — A T
view the interaction diagram only for positive or 2o,
. - M_'r'
negative moments. g4 0
8 o kMm
» Specify whether you want to enter an angle or the
values of the moments that produce a view angle Z‘
by selecting either the ANGLE or MOMENTS option, o 0
. Iv List Point Numbers
respectively.
. ok | Cancel
» If the ANGLE option was selected, select an angle [ex] ﬂ

from the list, use the scroll bar to pick an angle, or
simply enter the value in the text box.

* If the MOMENTS option was selected, enter the values of M, and My which define the view

angle. The value of that view angle is computed and shown in the ANGLE text box.

» To display all load points and their numbers check the LIST POINT NUMBERS option. To
display unique angle values only, leave the option unchecked.

e  Choose the OK button.
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*  You may browse through the angles by using View | Next angle and View | Previous

angle respectively.
4.37.2 Viewing M,-M, Contours

* Select View | Mx-My Diagram. A dialog box appears.

» Select an axial load from the list, use the scroll bar to pick a load,
or simply enter the value in the text box.

» To display all load points and their numbers check the LIST
POINT NUMBERS option. To display unique axial load values
only, leave the option unchecked.

*  Choose the OK button.

*  You may browse through the loads by using View | Next Load
and View | Previous Load respectively.

View Contour

-

#1
#2
#3
#4

Dezign Axial load:

kM

1200
2200
1500
2200

Iv List Point Mumbers

o]

-480

Cancel |
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5.1 Example 1 - Capacity of a Square Column

51.1 Problem Formulation

For a column section’® which is 16” x 16” and reinforced with 4-#8 bars, calculate the load
moment capacities for the following load conditions:

Case 1: Bar stress near tension face of member equal to zero, (f; = 0).
Case 2: Bar stress near tension face of member equal to 0.5f, (f; = 0.5f))

Case 3: At limit for compression controlled sections. (e, = 0.002)

General Information

Case 4: At limit for tension controlled sections. (g = 0.005) o
|spCqumn Manual Exampls 1
Given a concrete of 4 ksi and reinforcing steel of 60 ksi. Colurmr Engineer
|PCANotes 6.4 H
Design Code
. AL 31614 |
5.1.2 Preparing Input
Unitz Fiun Option
* English % lreeestigation
" Metric " Design

» From the File menu, choose New. Any input data is cleared

and the default values are restored. Flun s

(* Abaut XAz (" Biawial

. " About A
From the Input menu, choose General Information. T

Conzider slendermess?  Yes ™ No

ok | Cancel |

- Input the PROJECT header.
- Select ENGLISH units and ACI 318-14 code.

- Select About X-axis for run axis, Investigation for run option and No for Consider
slenderness?

- Choose OK.

76. Based on Example 6.4, pp 6-33 from Notes on ACI 318-11 Building Requirements for Structural Con-
crete with Design Applications, Edited by Mahmoud E. Kamara and Lawrence C. Novak, Twelfth Edi-
tion, 2013, Portland Cement Association.
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5.1.3 Assigning Properties

*  From the Input menu, choose Material

Properties. Material Properties
. —Conerete—————————————————— ~ Reinforcing Steel
- Accept the default properties as they stengnte [ kol || suongh i [T o
match those in the problem statement ¥ Standard W Standard
- Choose OK. Blasticty. Ec: [3605  ksi | | Elestioly.E<[29000 ke
Mastess.fe: [34 ksi
Beta[1]: 0.85 Compression-controlled strain limit,
Ulimate strain: [0003 Epsst  [000208857
[ ok | cancel |

*  From the Input menu, choose Section |

Rectangular. Rectangular Section
- For the section WIDTH (ALONG X), input 16 width [slong <) B in
- For the section DEPTH (ALONG Y), input 16. Depth (along 7] IT o
- Choose OK.

Ok, Cancel |

*  From the Input menu, choose Reinforcement | All
Sides Equal Al Sides Equal

- Input 4-#8 bars under NO. OF BARS. No. of bars: [ Bar Lavout

; % Rectangular
Bar size: H v

- Input 1.5 in for the CLEAR COVER and select P
Cl - |15 i
TRANSVERSE BARS under COVER TO. parcover: [15 in

Covver to
- Choose OK. ’;: Transverse bars ¢ Longitudinal bars
* From the Input menu, choose Loads | Control x| Cancel
Points.

5.14 Solving

* From the Solve menu, choose Execute.

- The P-My contour is displayed in the Graphics area.
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5.1.5 Viewing and Printing Results

* From the View menu, choose Results.

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

* From the File menu, choose Print Report | Default Report.

- Select the printer to send the default report to.
- Choose PRINT.

*  From the File menu, choose Print Screen.

- Select the printer to send the graphical results to.
- Choose PRINT
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Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 7/12/2018
C:\Program Files (x86)\StructurePoint\spColumn V6.00\spColumn\Examples\Examples-Ma...\ExampleO1.col 2:15 PM
o ®
1100 P [kip]
I
// \\
_AD00
Pl o ™ "
- ~
A< 900+ e
° °
fs=0 # fs=0
N Z= 800+
16 x 16 in \
=i
7
B
fs=0.5y 800-] fs=0.5fy
General Information 500
Project spColumn M... Example1
Column PCANotes 6.4 400
Engineer SP
Code ACI 318-14 300
Bar Set ASTM A615
Units English 200+
Run Option Investigation \\
Run Axis X - axis e
Slenderness Not Considered ‘ \ Mk
Column Type Structural | {
250 250
Capacity Method =~ Moment capacity A
7
T N 100 -~ £
Materials (Prain) _ _ _ :L\\, 7/;/, _ _ _ (Pmin)
i 4 ksi 200-L.
E 3605 ksi FAiaLD0deg]
c
fy 60 ksi
ES 29000 ksi
Section
Type Rectangular
Width 16 in
Depth 16 in
Aq 256 in2
I3 5461.33 in*
ly 5461.33 in*

Reinforcement

Pattern All sides equal
Bar layout Rectangular
Cover to Transverse bars
Clear cover 1.5 in
Bars 4 #8
Confinement type Tied
Total steel area, A 3.16 in2
Rho 1.23 %
Min. clear spacing 10.25 in
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1. General Information

File Name C:\Program Files
(x86)\Structure...\Example01.col

Project spColumn Manual Example 1

Column PCANotes 6.4

Engineer SP

Code ACI 318-14

Bar Set ASTM AB15

Units English

Run Option Investigation

Run Axis X - axis

Slenderness Not Considered

Column Type Structural

2. Material Properties

2.1. Concrete

Type Standard

i 4 ksi

E8 3605 ksi

fo 3.4 ksi

Gy 0.003 in/in

B4 0.85

2.2. Steel

Type Standard

f, 60 ksi

ES 29000 ksi

En 0.00206897 infin

3. Section

3.1. Shape and Properties

Type Rectangular

Width 16 in

Depth 16 in

Aq 256 in?

Ix 5461.33 in*

ly 5461.33 in*

[ 4.6188 in

Iy 4.6188 in

Xo 0in

e 0in
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3.2. Section Figure
y
1«
Rectangular 16 x 16 in 1.23% reinf.
Figure 1: Column section
4. Reinforcement
4.1. Bar Set: ASTM A615
Bar Diameter Area Bar Diameter Area Bar Diameter Area
in in? in in? in in?
#3 0.38 0.11 #4 0.50 0.20 #5 0.63 0.31
#6 0.75 0.44 #7 0.88 0.60 #8 1.00 0.79
#9 1.13 1.00 #10 1.27 1.27 #11 1.41 1.56
#14 1.69 2.25 #18 2.26 4.00

4.2. Confinement and Factors

Confinement type Tied
For #10 bars or less #3 ties
For larger bars #4 ties

Capacity Reduction Factors

Axial compression, (a) 0.8
Tension controlled failure, (b) 0.9
Compression controlled failure, (c) 0.65

4.3. Arrangement

Pattern All sides equal
Bar layout Rectangular
Cover to Transverse bars
Clear cover 1.5 in
Bars 4 #8
Total steel area, A 3.16 in?
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rho 1.23 %
Minimum clear spacing 10.25 in

5. Control Points

About Point P X-Moment Y-Moment NA Depth d; Depth £ (]
kip k-ft k-ft in in
X @ Max compression 682.0 0.00 0.00 43.90 13.63 -0.00207  0.65000
X @ Allowable comp. 545.6 72.20 0.00 15.81 13.63 -0.00041 0.65000
X @f;=0.0 467.6 102.64 0.00 13.63 13.63 0.00000  0.65000
X @f,=0.5f, 331.8 135.43 0.00 10.13 13.63 0.00103  0.65000
X @ Balanced point 238.9 148.49 0.00 8.06 13.63 0.00207  0.65000
X @ Tension control 188.7 172.04 0.00 511 13.63 0.00500  0.90000
X @ Pure bending 0.0 91.03 0.00 2.24 13.63 0.01528  0.90000
X @ Max tension -170.6 0.00 0.00 0.00 13.63 9.99999  0.90000
-X @ Max compression 682.0 0.00 0.00 43.90 13.63 -0.00207  0.65000
-X @ Allowable comp. 545.6 -72.20 0.00 15.81 13.63 -0.00041 0.65000
X @f;=0.0 467.6 -102.64 0.00 13.63 13.63 0.00000  0.65000
X @f;=05f, 331.8 -135.43 0.00 10.13 13.63 0.00103  0.65000
-X @ Balanced point 238.9 -148.49 0.00 8.06 13.63 0.00207  0.65000
-X @ Tension control 188.7 -172.04 0.00 511 13.63 0.00500  0.90000
-X @ Pure bending 0.0 -91.03 0.00 224 13.63 0.01528  0.90000
-X @ Max tension -170.6 0.00 0.00 0.00 13.63 9.99999  0.90000
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5.2 Example 2 - Investigation of a Slender Column -
Nonsway Frame

5.2.1 Problem Formulation

Determine the adequacy of a 14 x 20” column’’ with 6-#11 bars in a nonsway frame with a clear
height of 22°6”. Use k=1.0.

The concrete used is 4.5 ksi and the reinforcing steel is 50 ksi.

The factored load values for the column under consideration are as follows:
P (kip) 115 kips
Top M,y (kip-ft) 279 k-ft
Bottom M, (kip-ft) -279 ft-kips

5.2.2 Preparing Input

General Information

—Labelz
Project:

From the File menu, choose New. Any input data is cleared and [snColumn Manual Example 2
Colurmnm: Engineer:
the default values are restored. Fang 15125 G
* From the Input menu, choose General Information. - Design Cade
jact 31a14 ~|
- Input the PROJECT header.
. — Uni Run Opti
- Select ENGLISH units and ACI 318-14 code. i {;nl -
glis rwestigation
 Metic " Design

- Select Biaxial for run axis, Investigation for run option
and Yes for Consider Slenderness?

— Rur Az

7 About K-dwis * Biawial

 About ¥-duis
- Choose OK.
Consider slenderness? & Yes ( No
ak. I Cancel

77. Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and
Jose A. Pincheira, Seventh Edition, 2007, John Wiley and Sons, Inc.
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5.2.3

*  From the Input menu, choose Material
Properties.

* From the Input menu, choose Section | Rectangular.

Assigning Properties

Input 4.5 for the CONCRETE STRENGTH.
Change the REINFORCING  STEEL
STRENGTH to 50. Other properties are

Material Properties

— Concrete

Strength, f'c: |45— ksi
IV Standard

Elasticity, Ec: IW e
Max stress, fo: W ksi
Betall) [oezs
Ultimate strair: W

— Reinforcing Steel

Strength, fy: ISD ki

v Standard

Elasticity, Es: |2SDDD ks

Compression-contralled strain limit,

Epz_yt: ID.DD‘I T2414

computed and will be accepted.

%

Cancel I

Choose Ok.

Input 20 and 14 for the section width (along X) and depth

(along Y).
Choose OK.

*  From the Input menu, choose Reinforcement
| Sides Different.

Input 2-#11 bars for TOP and BOTTOM
and 1-#11 for LEFT and RIGHT. Input
1.5 in for the cover and select
LONGITUDINAL BARS.

Choose OK.

*  From the Input menu, choose Slenderness |
Design Column.

Input 22 . 5 for the column CLEAR HEIGHT.

Rectangular Section

width [along =]; Iﬂ in
Depth [along ) I'I 4 in

QK I Cancel |

Sides Different

Top Buattam Left Right

Mo, of bars: |2 |2

I I

Bar size: I#H ;I Iﬂ

1 x| f#n = a1 ~]

Clear cover: |‘| A |1.

5 |15 |15 in

Cover to
’7(' Transverse

barz ' Longitudinal bars

aK I Cancel |

Check NONSWAY FRAME and select INPUT ‘k’ FACTORS. Input 1 for k.

Press COPY TO Y-AXIS.
Choose OK.
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Design Column

et

Clear height: 25
& Monsway frame
© Sway frame

— Sway criteria

[Sum Pul/(Pul: |1

[Surn Pel/[Pe): |1

¥ 2'nd arder effects along length

YA
Clear height:

© Sway frame
— Sway criteria

[Surn Pe)/[Pe):

[Sum Puld(Pul:

225

& Monsway frame

|1—
I.I_

ft

¥ 2'nd order effects along length

— Effective length factors
© Compute 'k’ factors
& |nput 'k’ factars:

k[ns]: |1 kls]: ID

— Effective length
© Compute 'k’
' Input 'k’ facl

factars
factors

tors:

k[ns]: |1 kls]: ID

Copy to'v-Auis |

Copy to <-Axis |

* From the Input menu, choose Loads | Service.

- Under LIVE, input 71 .875 for the AXIAL LOAD, O for the X-MOMENTS @ToP, 0 for
the X-MOMENTS @BOT, 174 . 375 for the Y-MOMENTS @ToOP and -174 . 375 for the
Y-MOMENTS @BOTTOM, respectively.

- In column SUSTAINED LOAD keep default setting for dead load equal 100%.

- Choose INSERT to add the entry to the list box.

- Choose OK.

Service Loads

—wial Load (kip] —— ¥-Moments [k-f) —"f-Moments [k-ft]  Sustained Load [%]+
@ Tap @ Bat @ Top @ Bat
Dead | [0 o o [o [o [100
Live: | [71.875 Jo Jo 17427 [174378 Jo
Wwind: | [0 |0 Jo o o Jo
EQ [ [ o Jo o Jo
Snow: | [0 |0 Jo o o Jo
Inzert I todify | Delete |

|N0. [P but, Mrb, Mut, Myb] for each case

ok Cancel
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*  From the Input menu, choose Loads | Load
Combinations.

- If the list displays thirteen combinations, choose
only the second load combination U2 and delete
all the others by selecting them and using
DELETE. Choose OK.

5.24 Solving

* From the Solve menu, choose Execute.

- The solver of the program is started and, upon
completion, displays the interaction diagram of
the section with the load point plotted within the
diagram.

5.2.5 Viewing and Printing Results

* From the View menu, choose Results.

Load Combinations

Dead Live “ind EQ Show

1.2 + 1.6 + + + |05
Inzert | M adify | Delete | Defaults|

| Comba Dead Live Wind EQ Show

(n] 4 Cancel

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the

spResults module and get back to spColumn.

* From the File menu, choose Print Report | Default Report.

- Select the printer to send the default report to.
- Choose PRINT.

* From the File menu, choose Print Screen.

- Select the printer to send the graphical results to.

- Choose PRINT.
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o o
_L 1600 — P [kip]
(] x [ ) ES
JA%0+ N,
,/ \\
) ) .
N
20 x 14 in r 20T %
// J ‘ \\
\\
\\
\\
\\
\\
\\
General Information &
Project spColumn M... Example2 N
Column Wang 15.18.5 j
1
Engineer SP 3
Code ACI 318-14 7
Bar Set ASTM A615 7
. = -
Units English £ . . Mty
Run Option Investigation l t t |
-600 400 500 600
Run Axis Biaxial
Slenderness Considered
Column Type Structural
Capacity Method =~ Moment capacity _/_/ | -
Materials
i 4.5 ksi -600—
E 3823.68 ksi FMiSLes.0ldeg)
5 H
f, 50 ksi
ES 29000 ksi
Section
Type Rectangular
Width 20 in )
Depth 14 in No. Load Combo F-’., Mux M,y ¢l?.. PM,, M, Capacity
280 in? kip k-ft K-ft kip K-ft k-ft Ratio
Ag . 1 1 u1 Top 115.0 11.5 293.0 115.00 13.83 353.32 0.83
I 4573:33 i 2 1 Ul Bot 1150 115 2930 11500  13.83  353.32 0.83
ly 9333.33 in*

Reinforcement
Pattern

Sides different

Bar layout Rectangular
Cover to Longitudal bars
Clear cover -
Bars -

Confinement type Tied

Total steel area, A 9.36 in?
Rho 3.34 %
Min. clear spacing 3.39 in

Max. Capacity Ratio: 0.83
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()] o

_L 600 — My [k-ft]
o x o
500
o o
400 —
20 x 14 in 2 Ry
/ \\
/" /30042 ~
/, \
// \\
7 200+ 5
/ ‘\
e 100+ 5
General Information
Project spColumn M... Example2 | : , ; ' ' Ll
Column Wang 15.18.5 -600 -500 -400 -300 300 400 500 600
Engineer SP
Code ACI 318-14
Bar Set ASTM A615
Units English
Run Option Investigation
Run Axis Biaxial
Slenderness Considered
Column Type Structural
Capacity Method =~ Moment capacity 500
Materials
i 4.5 ksi -600 —
E 3823.68 ksi MM at P=115.0 [kip]
5 H
f, 50 ksi
ES 29000 ksi
Section
Type Rectangular
Width 20 in .
Depth 14 in No. Load Combo F-’., Mux M,y ¢l?.. SM,« M, Capacity
S — kip k-ft k-ft kip k-ft k-ft Ratio

Ag . 1 1 u1 Top 115.0 11.5 293.0 115.00 13.83 353.32 0.83
I 4573:33 i 2 1 Ul Bot 1150 115 2930 11500  13.83  353.32 0.83
ly 9333.33 in*

Reinforcement
Pattern

Sides different

Bar layout Rectangular
Cover to Longitudal bars
Clear cover -
Bars -

Confinement type Tied

Total steel area, A 9.36 in?
Rho 3.34 %
Min. clear spacing 3.39 in

Max. Capacity Ratio: 0.83
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1. General Information

File Name C:\Program Files
(x86)\Structure...\Example02.col

Project spColumn Manual Example 2

Column Wang 15.18.5

Engineer SP

Code ACI 318-14

Bar Set ASTM A615

Units English

Run Option Investigation

Run Axis Biaxial

Slenderness Considered

Column Type Structural

2. Material Properties
2.1. Concrete

Type Standard

e 4.5 ksi
Ec 3823.68 ksi
fe 3.825 ksi
Ey 0.003 in/in
B1 0.825
2.2. Steel

Type Standard

f, 50 ksi
Es 29000 ksi
€n 0.00172414 infin
3. Section

3.1. Shape and Properties

Type Rectangular

Width 20 in
Depth 14 in
Aq 280 in?
[ 4573.33 in*
fl, 9333.33 in*
I 4.04145 in
Iy 5.7735 in
Xo 0in
Yo 0in
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3.2. Section Figure
y
o +x o
Rectangular 20 x 14 in 3.34% reinf.
Figure 1: Column section
4. Reinforcement
4.1. Bar Set: ASTM A615
Bar Diameter Area Bar Diameter Area Bar Diameter Area
in in? in in? in in?
#3 0.38 0.11 #4 0.50 0.20 #5 0.63 0.31
#6 0.75 0.44 #7 0.88 0.60 #3 1.00 0.79
#9 1.13 1.00 #10 1.27 1.27 #11 1.41 1.56
#14 1.69 2.25 #18 2.26 4.00
4.2. Confinement and Factors
Confinement type Tied
For #11 bars or less #3 ties
For larger bars #4 ties
Capacity Reduction Factors
Axial compression, (a) 0.8
Tension controlled failure, (b) 0.9
Compression controlled failure, (c) 0.65
4.3. Arrangement
Pattern Sides different
Bar layout -
Cover to Longitudal bars
Clear cover -
Bars -
Total steel area, A, 9.36 in?
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rho 3.34 %

Minimum clear spacing 3.39 in
4.4. Bars Provided
Bars Cover
in
Top 2 #11 1.5
Bottom 2 #11 1.5
Left 1 #11 1.5
Right 1 #11 1.5
5. Loading
5.1. Load Combinations
Combination Dead Live Wind EQ Snow
U1 1.200 1.600 0.000 0.000 0.500
5.2. Service Loads
No Load case Axial load Mx @ Top Mx @ Bottom My @ Top My @ Bottom
kip k-ft k-ft k-ft k-ft
1 Dead 0.00 0.00 0.00 0.00 0.00
1 Live 71.88 0.00 0.00 174.38 -174.38
1 Wind 0.00 0.00 0.00 0.00 0.00
1 EQ 0.00 0.00 0.00 0.00 0.00
1 Snow 0.00 0.00 0.00 0.00 0.00
5.3. Sustained Load Factors
Load case Factor
%
Dead 100
Live 0
Wind 0
EQ 0
Snow 0
6. Slenderness
6.1. Sway Criteria
X-Axis Non-sway column
Y-Axis Non-sway column
6.2. Columns
Column Axis Height Width Depth I fe E.
ft in in in* ksi ksi
Design X 225 20 14 4573.33 4.5 3823.68
Design Y 225 20 14 9333.33 4.5 3823.68
Above X (no column specified...)
Above Y (no column specified...)
Below X (no column specified...)
Below Y (no column specified...)
6.3. X - Beams
Beam Length Width Depth I f. E.
ft in in in* ksi ksi
Above Left (no beam specified...)
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Beam

Length
ft

Width
in

Depth I
in in*

fe E.
ksi ksi

Above Right
Below Left
Below Right

(no beam specified...)
(no beam specified...)
(no beam specified...)

6.4. Y - Beams

Beam

Length
ft

Width

Depth 1

fe Ec
ksi ksi

Above Left
Above Right
Below Left
Below Right

(no beam specified...
(no beam specified...
(no beam specified...
(no beam specified...

7. Moment Magnification

7.1. General Parameters

Factors
Stiffness reduction factor, ®x

0.2 Elg + Edleo (X-axis)
0.2 Ely + Edleo (Y-axis)

Minimum eccentricity, Ex min

Minimum eccentricity, Ey min

Cracked section coefficients, cl(beams)
Cracked section coefficients, cl(columns)

Code defaults
0.75

0.35

0.7

7.66e+006 kip-in?

2.36e+007 kip-in?
1.02 in
1.20 in

7.2. Effective Length Factors

Axis

Weop

Whottom

k (Nonsway)

k (Sway)

kly/r

X
Y

0.000
0.000

0.000
0.000

1.000
1.000

(N/A)
(N/A)

66.81
46.77

7.3. Magnification Factors: X - axis

Load
Combo

2Py
kip

At Ends
P. 2P
kip kip

Bas 8

Along Length

P, K'lu/r P.
kip kip

Ba

Cn 5

1 Ut (N/A)

(N/A) (NIA)

(NIA) (NIA)

115.00 (N/A) 1036.79

0.000

1.000 1.174

7.4. Magnification Factors: Y - axis

Load
Combo

2Py
kip

At Ends
P. 2P
kip kip

Bas 8

Along Length

P, K'lu/r P.
kip kip

Ba

1 U1

(N/A)

(N/A) (NIA)

(NIA) (NIA)

115.00 (N/A) 3199.27

0.000

1.000 1.050

8. Factored Moments

NOTE: Each loading combination includes the following cases:

Top - At column top
Bot - At column bottom

8.1. X - axis

Load
Combo

1%t Order
Mns

k-ft k-ft k-ft

M. M,

2" Order
Miin M;
k-ft k-ft

M.
k-ft

Ratio
2nd/1 st

1 u1 Top
1 U1 Bot

0.00
0.00

(NIA)
(NIA)

0.00
0.00

9.78 0.00
9.78] M= 0.00

11.47
11.47

1.174
1.174
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8.2. Y - axis
Load 15t Order 2 Order Ratio
Combo M, M, M, Mumin M; M. 2nd/qst
k-ft k-ft k-ft k-ft k-ft k-ft

1 u1 Top 279.00 (N/A) 279.00 11.50| M= 279.00 293.04 1.050

1 U1 Bot 279.00 (N/A) 279.00 11.50] My= 279.00 293.04 1.050
9. Factored Loads and Moments with Corresponding Capacities
NOTE: Each loading combination includes the following cases:
Top - At column top
Bot - At column bottom

No. Load
Combo Pu Mux M,y OM,« ®M,, OM,/M, NADepth d;Depth & (]
kip k-ft k-ft k-ft k-ft in in
1 1 Ul Top 115.00 11.47 293.04 13.83 353.32 1.206 5.19 18.77 0.00810 0.900
2 1 U1 Bot 115.00 11.47 293.04 13.83 353.32 1.206 5.19 18.77 0.00810 0.900
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5.3 Example 3 - Design of a Slender Column - Sway
Frame

5.3.1 Problem Formulation

Design a square column’® with a clear height of 16 ft. The column is sway and subjected to dead,
live and wind loads as shown below.

Dead Live Wind
P (kip) 380 140 0
Top M, (kip-ft) 32 20 50
Bottom M, (kip-ft) 54 36 50

The column is to be checked for the following load combinations:

Ul=12D+1.6L
U2=12D+05L+1.6 W

The calculations in the reference are done based on the load combination U2.

In practice, the ratio 2P/ P, would have to be calculated before

General Information

the problem can be attempted, using a trial value of ZP/P_. Here,

. — Labels
the value of ZP /P used is 28.67 based on the reference value of Project:
P_. There are 14 interior columns, 18 exterior columns and 4 |spCokamn Mar.al Example 2

Columr: Engineer:
corner columns. Therefore, the value of 2P, /P, =14 + 18 * 2/ [Wang 15185 P
3+4 *1/3 =27.33 irrespective of the load combination being
used. — Design Code
|act 31814 |
— Urits Run Option
5 3 2 Pre arin In ut @ English @ |nvestigation
. p g p " Metric " Design

— Run &uis

 About - & Biavial

* From the File menu, choose New. Any input data is -
About bz

cleared and the default values are restored.

Conzider slendermess? & Yes © Mo

Ok I Cancel

* From the Input menu, choose General Information

- Input the PROJECT header.

78. Based on Example 12.4, pp 409, from Structural Concrete: Theory and Design by M. Nadim Hassoun
and Akthem Al-Manaseer, Fourth Edition, 2008, John Wiley and Sons, Inc.
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- Select English units and ACI 318-14 code.

- Select About X-Axis for run axis, Design for run option and Yes for Consider
slenderness?

- Choose OK.

5.3.3 Assigning Properties

*  From the Input menu, pick Material Properties.

- Input 5 for the concrete strength. Other properties are computed and will be accepted.
- Choose OK.

Material Properties

— Concrete — Reinforzing Steel

Strength, fc: IE— ki Strength, fy: IED— kzi

¥ Standard v Standard

Elasticity. Ec: [403051  ksi | | Elasticty, E[23000 ks

Max stress, fo: |425— ksi

Beta[1): IDB— Comprezsion-controlled strain limit,

ltimate strain: W Epzs_ut: IM
’Tl Cancel |

* From the Input menu, pick Section | Rectangular.

Rectangular Section

- Input 18 and 18 for the WIDTH (ALONG X) and DEPTH St Erd  Inoemont
(ALONG Y) under both START and END options. Wi (lona; [18 [i8 [0 in
Choose OK Depth [along ): IT IT ID_ in

oK I Cancel |

* From the Input menu, choose Reinforcement | All
Sides Equal

All Sides Equal

. .  Cover to
Finirurm M arirum

- Input 4-#10 bars for Minimum, and 40-#10 |, _. = o r—

& Transverse bars

™ Longitudinal bars

bars for Maximum and 1.5 in for the cover, Barsie:  [W10 =] [#10 =] —bor Loyot

and select TRANSVERSE BARS and . Ir . % Rectangular
RECTANGULAR Bar Layout. " Birour
- Choose OK. 0K I Cancel
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* From the Input menu, choose Slenderness | Design Column.

Check SWAY FRAME

Under SWAY CRITERIA, input 28.67 and 27.33 for the ZPc/Pc and ZPu/Pu,
respectively.

Select COMPUTE ‘K’ FACTORS.
Choose OK.

Design Celumn

— s

Clear height; I'I B ft

™ Nonsway frame

% Sway frame

— Sway criteria

[Sum Pc)/(Pc]: IEE.E?

[Surn Pul/(Pul 2733

v 2'nd arder effects along length

Input 16 for the column CLEAR HEIGHT.

Leave 2N° ORDER EFFECT ALONG LENGTH option checked (default)

—T-his

Clear height; I'I B ft

€ Monsway frame

& Sway frame

— Sway criteria

(Sum Pel(Pe). [28.68:

[Surn Pu)d(Pu): |21.14:

¥ 2'nd order effects along length

— Effective length factors
£ Compute k' factors

7 Input k' factors:
Kinsk [OLB020 kfs): [1.38%:

— Effective length factors
€ Compute k' factors
% |nput k' factors:

k[hz]: IEI.E klzl |1.37

Copy to'-Axiz |

Copy to #-bsis |

.

Cancel
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* From the Input menu, choose
Slenderness | Columns Above/Below.

Clear the NO COLUMN SPECIFIED
option.

Input 11 for the column height
(center-to-center) under HEIGHT (C/C)
and leave the other data as is.

Choose Copy to Column Below.
Choose OK.

*  From the Input menu, choose
Slenderness | X-Beams.

Choose ABOVE LEFT.

Clear the NO BEAM SPECIFIED option.

Columns Above and Below

Calumn Above

[ Mo column specified
Heightc/el |11 ¢
width [alona 3 [18 iy
Depth [along v: ,T i
Concrete,  fic ,5_ ki
Ec: |4030.F g

Copy to Colurmn Below |

Colurnn B elaw

I Mo column specified
Heightc/ck  [11 ¢
Width [slong ) [18
Drepth [along v7); IT in
Concrete,  fo |5_ ki
Ec: [4030% 1o

Copy to Column Above |

o]

Cancel |

X-Beams (perpendicular to X)

Beam Location:
{* Above Left
" Below Left

Input 20 for the span (center-to-center) under || Beam#abovelett

SPAN(C/C).

Input 0.00 and 0.00 for the WIDTH and

DEPTH, respectively.

Input 21436.6 for the moment of inertia

under INERTIA.

Leave the other data as it is.

[~ Mo beam specified ~ Copy Fram Beam Right ‘

Span[c/c) |20 ft f'er |5 ki

wficth 0 in Ec: (403057 ksi
Depth; 0 in  Inertia; [21436.6 g

" &bove Right
" Below Right

Choose ABOVE RIGHT and click on CorY FROM BEAM LEFT.

Choose BELOW LEFT and click on CorY FROM BEAM ABOVE.

Choose BELOW RIGHT and click on COPY FROM BEAM ABOVE.

Choose OK.

*  From the Input menu, choose Loads | Service.

Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS @ ToP and

X-MOMENTS (@ BOT respectively.

Under LIVE, input 140, 20 and -3 6 for the AXIAL LOAD, X-MOMENTS (@ ToP and X-

MOMENTS (@ BOT, respectively.

Under WIND, input 0, 50 and -50 for the AXIAL LOAD, X-MOMENTS @ ToP and X-

MOMENTS (@ BOT, respectively.
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Service Loads

Live:
Wéind:
EQ:

Dead:

Show:

—aial Load [kip]—- #-Moments [k-ft) —7-homents [k-ft] — Sustained Load [3]
@ Top (@ Bat @ Top @ Bat
|380 |32 |54 Jo Jo [100
{140 |20 |-36 Jo Jo Jo
jo |50 |50 Jo Jo Jo
jo jo o Jo Jo |o
o o o o o o
Ihzart I M adify | Delete |

IND. [P k=t M xb, yt, bpb] for each case

oK

| Cancel |

- Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all
other load cases.

- Choose INSERT to add the entry to the list box.
- Choose OK.
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*  From the Input menu, choose Loads | Load
Combinations.

Load Combinations

Dead Live "wfind EQ Show
[tz +Jos  + 16+ |0 + |05

- Select all load combinations by clicking on
Ul and dragging to Ul3. Then choose |[ st |  Modiy |  Delete |  Defats |

DELETE. [ComboDead  Live  wind  EQ Snow

11 1.2 1.6 0 i] 0.5

- Enter 1.2 for Dead, 1.6 for Live, and 0.5
for Snow then choose INSERT.

- Enter1.2 forDead, 0.5 forLive, 1.6 for
Wind, and 0 . 5for Snow then choose INSERT.

- Choose OK.

5.3.4 Solving

* From the Solve menu, choose Execute.

- The solver of the program is started and, upon
completion, displays the interaction diagram
of the section with the load points plotted
within the diagram.

1] Cancel

5.3.5 Viewing and Printing Results

* From the View menu, choose Results.

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

* From the File menu, choose Print Report | Default Report.

- Select the printer to send the default report to.
- Choose PRINT.

* From the File menu, choose Print Screen.

- Select the printer to send the graphical results to.

- Choose PRINT.
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STRUCTUREPOINT - spColumn v6.50 Page | 1
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 7/12/2018
C:\Program Files (x86)\StructurePoint\spColumn V6.00\spColumn\Examples\Examples-Ma...\Example03.col 2:22 PM

. . 2400 - P [kip]
I
2290--\ y
[ ) [ ) g %%
- 2000 +
e o o o ot
- H N
: fs=0 T 1600+ fs=0
18 x 18 in o (PRI el sy 2 el
o 1400 -1
,// \‘\
L -~ 1200
fs=0.5fy / f6=0
it ~ 1000
.
General Information S ao6)
Project spColumn M... Example3 fs=0.5ty_
Column Hassoun 12.4 7 L 600
Engineer SP \ ™
\ 400 -
Code ACI 318-14 \\
Bar Set ASTM A615 Y 2 007
Units English | N ; ™
Run Option Design -600 500
Run Axis X - axis
Slenderness Considered
Column Type Structural
Capacity Method =~ Moment capacity
=<7 _ _(emin)
Materials o
fo 5 ksi 1000
E 4030.51 ksi EMiSLO ]
5 k
f, 60 ksi
ES 29000 ksi
Section
Type Rectangular
Width 18 in
Depth 18 in No. Load Combo By Mux P, M, Capacity
5 kip k-ft kip k-ft Ratio
Ay 324 in?
. 4 1 u2 Bot 526.0 206.5 526.00 344.47 0.60
Ix 8748 in 3 1 U2 Top 526.0 168.7 526.00 344.47 0.49
ly 8748 in* 2 1 u1 Bot 680.0 124.0 680.00 311.55 0.40
1 1 u1 Top 680.0 71.3 680.00 311.55 0.23
Reinforcement
Pattern All sides equal Max. Capacity Ratio: 0.60
Bar layout Rectangular
Cover to Transverse bars
Clear cover 1.5 in
Bars 12 #10
Confinement type Tied
Total steel area, A 15.24 in2
Rho 4.70 %
Min. clear spacing 3.06 in
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STRUCTUREPOINT - spColumn v6.00 Page | 3
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example03.col 11:42 AM

1. General Information

File Name C:\Program Files
(x86)\Structure...\Example03.col

Project spColumn Manual Example 3

Column Hassoun 12.4

Engineer SP

Code ACI 318-14

Bar Set ASTM A615

Units English

Run Option Design

Run Axis X - axis

Slenderness Considered

Column Type Structural

2. Material Properties
2.1. Concrete

Type Standard

fo 5 ksi
= 4030.51 ksi
fe 4.25 ksi
Ey 0.003 in/in
B1 0.8
2.2. Steel

Type Standard

f, 60 ksi
Es 29000 ksi
€n 0.00206897 infin
3. Section

3.1. Shape and Properties

Type Rectangular

Width 18 in
Depth 18 in
Aq 324 in?
[ 8748 in*
fl, 8748 in*
I 5.19615 in
Iy 5.19615 in
Xo 0in
Yo 0in
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STRUCTUREPOINT - spColumn v6.00

Page | 4
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example03.col 11:42 AM
3.2. Section Figure
y
+x
Rectangular 18 x 18 in 4.70% reinf.
Figure 1: Column section
4. Reinforcement
4.1. Bar Set: ASTM A615
Bar Diameter Area Bar Diameter Area Bar Diameter Area
in in? in in? in in?
#3 0.38 0.11 #4 0.50 0.20 #5 0.63 0.31
#6 0.75 0.44 #7 0.88 0.60 #3 1.00 0.79
#9 1.13 1.00 #10 1.27 1.27 #11 1.41 1.56
#14 1.69 2.25 #18 2.26 4.00

4.2. Design Criteria

Bar selection Min. number of bars
Asmin = 0.01 X Ag 3.24 in?
Asmax = 0.08 x Ag 25.92 in?
Design/Required ratio 1.00

4.3. Confinement and Factors

Confinement type Tied
For #10 bars or less #3 ties
For larger bars #4 ties

Capacity Reduction Factors

Axial compression, (a) 0.8
Tension controlled failure, (b) 0.9
Compression controlled failure, (c) 0.65

4.4. Arrangement

Pattern All sides equal
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Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example03.col 11:42 AM
Bar layout Rectangular
Cover to Transverse bars
Clear cover 1.5 in
Bars 12#10
Total steel area, As 15.24 in?
rho 4.70 %

Minimum clear spacing 3.06 in
5. Loading
5.1. Load Combinations
Combination Dead Live Wind EQ Snow
u1 1.200 1.600 0.000 0.000 0.500
u2 1.200 0.500 1.600 0.000 0.500
5.2. Service Loads
No Load case Axial load Mx @ Top Mx @ Bottom My @ Top My @ Bottom
kip k-ft k-ft k-ft k-ft
1 Dead 380.00 32.00 -54.00 0.00 0.00
1 Live 140.00 20.00 -36.00 0.00 0.00
1 Wind 0.00 50.00 -50.00 0.00 0.00
1 EQ 0.00 0.00 0.00 0.00 0.00
1 Snow 0.00 0.00 0.00 0.00 0.00
5.3. Sustained Load Factors
Load case Factor
D/O
Dead 100
Live 0
Wind 0
EQ 0
Snow 0
6. Slenderness
6.1. Sway Criteria
X-Axis Sway column
2 order effects along length  Considered
>P. 28.67 x P,
>Py 27.33x Py
6.2. Columns
Column Axis Height Width Depth | f'e E.
ft in in in* ksi ksi
Design X 16 18 18 8748 5 4030.51
Above X 11 18 18 8748 5 4030.51
Below X 11 18 18 8748 5 4030.51
6.3. X - Beams
Beam Length Width Depth | f'e E.
ft in in in* ksi ksi
Above Left 20 0 0 21436.6 5 4030.51
Above Right 20 0.0001 0.0001 21436.6 5 4030.51
Below Left 20 0.0001 0.0001 21436.6 5 4030.51
Below Right 20 0.0001 0.0001 21436.6 5 4030.51
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STRUCTUREPOINT - spColumn v6.00 Page | 6
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example03.col 11:42 AM

7. Moment Magnification
7.1. General Parameters

Factors Code defaults
Stiffness reduction factor, ®x 0.75
Cracked section coefficients, cl(beams) 0.35
Cracked section coefficients, cl(columns) 0.7

0.2 Eclg + Eslse (X-axis) 2.02e+007 kip-in?
Minimum eccentricity, Ex min 1.14 in

7.2. Effective Length Factors
Axis Yiop Wyottom k (Nonsway) k (Sway) kl,/r
X 1.252 1.252 0.802 1.390 51.36

7.3. Magnification Factors: X - axis

Load At Ends Along Length
Combo >Pu P 2P Bas [N P, K'l/r Pc Ba Cm [
kip kip kip kip kip
1 U1 18584.40 2792.45 80059.54 0.000 1.448 680.00  (N/A) 5018.30  0.671 0.830 1.013
1 U2 14375.58 2792.45 80059.54 0.000 1.315 526.00  (N/A) 4490.56  0.867  0.927 1.098

8. Factored Moments

NOTE: Each loading combination includes the following cases:
Top - At column top

Bot - At column bottom

8.1. X - axis
Load 1t Order 2"d Order Ratio
Combo M, M, M, Muin M; M. 2nd/qst

k-ft k-ft k-ft k-ft k-ft k-ft

1 U1 Top 70.40 0.00 70.40 64.60| M= 70.40 71.32 1.013
1 U1 Bot 122.40 0.00 122.40 64.60| M= 122.40 124.00 1.013
1 u2 Top 48.40 80.00 128.40 49.97| M= 153.58 168.69 1.314
1 U2 Bot 82.80 80.00 162.80 49.97| M= 187.98 206.47 1.268

9. Factored Loads and Moments with Corresponding Capacities
Design/Required ratio ®M,/M, >= 1.00

NOTE: Each loading combination includes the following cases:

Top - At column top

Bot - At column bottom

No. Load
Combo P. Mx DM, oM, /M, NA Depth d; Depth & (0]
kip k-ft k-ft in in
1 1 Ul Top 680.00 71.32 311.55 4.368 12.43 15.49 0.00074 0.650
2 1 U Bot 680.00 124.00 311.55 2.512 12.43 15.49 0.00074 0.650
3 1 U2 Top 526.00 168.69 344.47 2.042 10.76 15.49 0.00132 0.650
4 1 U2 Bot 526.00 206.47 344.47 1.668 10.76 15.49 0.00132 0.650
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5.4 Example 4 - Investigation of Concrete Shear
Wall Capacity

5.4.1 Problem Formulation

Investigate the axial load and moment capacity of a shear wall”® for a given location of the neutral
axis. Use 4-ksi concrete and 60-ksi reinforcing steel.

— 1500 | 144 in ' 15in |~
C?:ter Neutral
ine axis
|
— X 4— —P x | —
[ B N J | [ Y N J
o ° ° ° o N
15in o o - | o o
! ) d d d | d d s e e e
T 0 ~ o) | ® N 2 |
) R < N | Y < L)
X, in o X o
«© «© [Te} 0 © ©
~ o N ~ g o~ o ] ~ ~ o S
A, in? N2 © S © © p &8 & &
ts N o = =} IS =} o N oo
[s2]
——18
S
o

Strain Diagram
~ N fsel < wn © ~ © ()
- F F = = = = = =

Force Diagram
a=204in

—C10
—C11
—»C12

P |
0.85fc'h

spColumn provides a comprehensive model editor for irregular shapes. For this example,
however, a specific tool provided with spColumn will be used for frequently needed shapes.

* From the Start Menu, go to All Programs | StructurePoint | spColumn and run Design
Assistant®0,

» Design Assistant uses macros to export data to text files. If a macro warning is displayed

when opening Design Assistant, make sure macros are enabled in order for the exporting
function to work properly.

79. Based on Example 4-4, pp 333, from Seismic and Wind Forces Structural Design Examples by Alan
Williams, Third Edition, 2007, International Code Council.

80. Design Assistant is a Microsoft Excel spreadsheet that can be used to facilitate creation of spColumn text
import files for a variety of sections including dumbbell shaped and C-shaped shear walls.
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* Choose Example 4 Tab in the spreadsheet.

* Input the data shown below:

- Under OVERALL SECTION WIDTH IN X, input 15.

- Under OVERALL SECTION HEIGHT IN'Y, input 144.
- Under WEB WIDTH, input 12.

- Under WEB HEIGHT, input 114.

- Under NUMBER OF BOUNDARY BARS IN X, input 3.
- Under NUMBER OF BOUNDARY BARS IN'Y, input 3.
- Under NUMBER OF WEB BARS PER LAYER, input 8.
- Under WEB BAR SPACING, input 18.

- Under COVER, input 2. 5.

- Under REINFORCEMENT AREA PER BOUNDARY BAR, input 0.79.

- Under REINFORCEMENT AREA PER WEB BAR, input 0. 31.

H ©- Templates [Read-Only] - Excel Roldan, Ariann;
File Home  Insert  Pagelayout  Formulas  Data Review  View Q@ Tell me what you want to do 9 Share
Qs - 5 v
A B c D E F G H | J K L M N 0 -
1 Input Output
2 | Note: 1. Mo units are used. It is the user's responsibility to maintain the consistency of units.
3 2. Do not delete or move output data cells. Otherwise the exported data might be incorrect.
5
6 Overall Section Width in X: 15 Export Geometry Geometry Reinforcement
7 Owverall Section Height in Y:| 144 X hd Boundary X hd Web X hd
8 Web Width 12 -7.500 | 72.000 1 5.000 69.500 1 3.500 63.000
9 Web Height 114 Export Reinforcemeant 7500 72.000 2 5.000 59.500 2 3.500 45.000
10 Mumber of Boundary Bars in X| 3 7500 [ 57000 3 0.000 69.500 3 3.500 27.000
1 Number of Boundary Bars in Y| 3 [ 6.000 57.000 4 0.000 59.500 4 3.500 9.000
12 Number of Web Bars per Layer| 8 6.000 | -57.000 5 -5.000 | 69.500 5 3.500 -9.000
13 Web Bar Spacing 18 7500 -57.000 6 -5.000 59.500 6 3.500 -27.000
14 Cover] 25 7500 | -72.000 T 5.000 64.500 T 3.500 | -45.000
15 | Reinforcement Area per Boundary Bar:]  0.79 -7.500 | -72.000 8 -5.000 | 64.500 8 3.500 | -63.000
16 Reinforcement Area per Web Bar]  0.31 7500 [ -57.000 9 5.000 -69.500 9 -3.500 63.000
17 [ -6.000 | -57.000 10 5.000 | -59.500 10 -3.500 | 45.000
18 6.000 | 57.000 11 0.000 | -69.500 11 3500 | 27.000
19 -7.500 | 57.000 12 0.000 | -59.500 12 -3.500 9.000
20 -7.500 | 72.000 13 -5.000 | -69.500 13 -3.500 | -9.000
21 _fl 14 -5.000 | -59.500 14 -3.500 | -27.000
22 i 15 5.000 | -64.500 15 -3.500 | -45.000
23 16 -5.000 | -64.500 16 -3.500 | -63.000
24 3 17 17
25 16 16
26 ) 19 19
27 20 20
28 21 21
29 0 T2 s % 1 18 % s T2 @ 22 22
30 4 23 23
H 24 24
32 -l 25 25
33 26 26
34 ) 27 27
35 k- . 28 28
36 k4. 29 29
v 30 30
38 ™ 31 31
39 32 32
40 33 33 -
3 Read Me | Exampled | Examples Exampled Example10 Example .. (£ [] 3
Ready i3] 0 - 1 +  100%
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* Press Export Geometry Button and Save Geometry File box appears. Save the file as
Example4-Geo.txt

[ [§| Save Geometry File .
try

GU

Organize v Mew folder BF - @

Microsoft Excel No items match your search,

¢ Favorites
M Desktop
g Downloads
(E_--j'_', Recent Places

= Libraries
@ Documents
J Music -
File name: Exampled-Geo -
Save as type: | Text Files VI
Authors: StructurePoint Tags: Add atag
(% HideFolders Tools I Save I ’ Cancel ]

* Press Export Reinforcement button and Save Reinforcement File dialog box appears.
Save the file as Example4-Reinf.txt

Save Geometry File E

. <= Aroldan » Desktop » Examples - Search Examples 2
Organize v New folder g= @
=
“*  MName Date modified Type
Libraries .

- | Exampled-Geo 2/10/2017 2:04 PM  Text Doc

@ Documents

Ji Music

[&=] Pictures

B videos

18 Computer
& o5
L shares (\ispl) (%)
Ll |

| mn " b

File name: | [ZENT0E U= -
Save as type: [Ten‘t Files - ]
Authors: StructurePoint Tags: Add a tag
(= Hide Folders Tools ~ I Save I ’ Cancel l

» Save and close the Design Assistant spreadsheet.
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From the Start Menu, go to All Programs | StructurePoint | spColumn and run

spColumn

From the File menu, choose New. Any input data is cleared and the default values are

restored.

From the File menu, choose Import | Import Data. Import Data (from text file) dialog
box appears. Make sure that Geometry radio button is checked, choose OK

* Geometry

" Reinforcement
" Semice loads
" Factored lnads

oK | Cancel |

Open Import File box appears. Select Example4-Geo. txt file and choose Open. The
shear wall geometry appears on the spColumn screen.

@ Open Import file

S

—,
OU9| . v Examples

- |¢¢ | | Search Examples jo |

i

| Recent Places

e

Organize » Mew folder

4.0 Favorites N
B Desktop

& Downloads

m

4 Libraries
> 3 Documents | 4
H J‘. Music
> | Pictures
2 B Videos

&2 My Videos
Puhlir Videns

-

File name: Exampled-Geo - [TEXT Files (*.bxt) ']

| Bxampled-Geo
|| Exampled-Reinf

[open 1) [ ones |

From the File menu, choose Import | Import Data. Import Data (from text file) box
appears. Press Reinforcement radio button, then Choose OK

" Geometry

{* Reinforcement
™ Service loads
" Factored loads

aK | Cancel
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* Open Import File box appears. Select Example4-Reinf. txt file and choose Open.
The shear wall reinforcement appears on the spColumn screen as well.

@ Open Impaort file

25

0 Favorites
Bl Desktop
& Downloads

UE
=1l Recent Places

4 Libraries
@ Documents
Aﬁ Music
[&5] Pictures

E Videos

"M Comnuter

®O| N » E]LEI"-I"Ip|5 - |¢,|| Search Examples
el .

o]

Organize + New folder HF v

i || Exampled-Geo
| || Exampled-Reinf |

m

0 e

File name: Exampled-Reinf - [Teut Files (*.tet)

)

Cowen [ |

Cancel

)

*  From the Input menu, choose General Information Tab. Input Project Information and
leave all other options in their default settings of ACI 318-14 design code. Choose OK

General Information

— Labels
Project:
IspEu:qumn Manual Example 4
Columr: Engineer:
[&lan Ex 4.4 5P
— Dezign Code
|01 31814 ~|
—Units——————— — Run Option
& Englizh % |nvestigation
 Metic " Design
— Run Axiz
& Ahout Az " Biaial
7 About bz

Consider slendemess?  Yes Mo

] I Cancel
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5.4.2 Assigning Properties

* From the Input menu, choose the Material Properties tab. VERIFY CONCRETE STRENGTH,
fc’, and REINFORCING STEEL STRENGTH, fy, values are entered as 4 ksi, and 60 ksi
respectively. Leave all other options in their default settings. Choose OK

Material Properties

— Concrete — Reinforzing Steel

Strength, fc: |4— ki Strength, fy: IED— kzi

¥ Standard v Standard

Elasticity. Ec: [3505 kei | | Elasticty, E[23000 ks

Max stress, fo: |34— ksi

Beta[1): 0.85 Comprezsion-controlled strain limit,

ltimate strain: W Epzs_ut: IM
’Tl Cancel |

*  From the Input menu, choose Reinforcement | Confinement Tab.

From the CONFINEMENT drop-down menu choose OTHER.

Input AXIAL COMPRESSION (a) as 0. 85.

Input COMPRESSION CONTROLLED FAILURE (c) as 0. 7.

Leave all other options in their default settings. Choose OK

Confinement

Confinernent: I vl

— Capacity Reduction Factors, Phi

Auial compressian [a): ID.ES
T enzsion-cantralled Failure [B): IIJ.EI

Compreszsion-controlled failure [c]: IIJ.T-"

—Tie Sizes

IﬁS vI ties with Iﬂ'IEI vl bars or smaller.
|#4 vI ties with larger bars.

1] I Cancel |
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5.4.3

544

From the Input menu, choose Loads | Axial Loads Tab

- Input 649.5 for the INITIAL LOAD. The initial
axial load was selected through trial and error
procedure in order to match neutral axis depth of 24
in. given in the example.

- Choose INSERT. Then, choose OK

Solving

From the Solve menu, choose Execute.

Auxial Loads

Initial load

E43.5]
[kip]

Inzert |

Final load Increment

[ .

[kip] [kip]
Modify | Delete |

| Mo, Iritial

0K

Final Inc

Cancel

- Click No when the warning message is displayed saying “Reinforcement ratio is less
than 1%. Consider column as architectural (i.e. fc is reduced by reinforcement

ratio?)”.

- The solver of the program is started and, upon completion, displays the interaction

diagram of the section.

Viewing and Printing Results

From the View menu, choose Results.

- Use the explorer in the spResults module or the Previous Table and Next Table

buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the

spResults module and get back to spColumn.

From the File menu, choose Print Report | Default Report.

- Select the printer to send the default report to.
- Choose PRINT.
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STRUCTUREPOINT - spColumn v6.50
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB
C:\Program Files (x86)\StructurePoint\spColumn V6.00\spColumn\Examples\Examples-Ma...\Example04.col

15 x 144 in

General Information

Project
Column
Engineer
Code

Bar Set

Units

Run Option
Run Axis
Slenderness
Column Type
Capacity Method

Materials
fo
Ec

fy

E,

Section
Type

Ag

I

IY
Reinforcement
Pattern

Bar layout
Cover to
Clear cover
Bars

Confinement type
Total steel area, A

Rho
Min. clear spacing

spColumn M... Example4
Alan Ex 4.4

SP

ACI 318-14
ASTM A615
English
Investigation

X - axis

Not Considered
Structural
Moment capacity

3605 ksi

60 ksi
29000 ksi

Irregular
1818 in2
3.36209e+006
24853.5 in*

in¢

Irregular

Other

17.60 in?
0.97 %
1.31 in

Page | 1
7/12/2018
2:23 PM
8000 - P [kip]
7000+~
({07, 1 R, SRS RS
fs=0.5fy 7 s=0.5fy
N ; ‘
N
T
g N
£ e
/ f5=0.5fy.
1
i
\
\
\
y !
\\
N
r N
MIk-ft]
! i
-1.5E+04 1.5E+04
-2000 =
PM at 0.0 [deg]
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Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example04.col 12:01 PM

1. General Information

File Name C:\Program Files
(x86)\Structure...\Example04.col

Project spColumn Manual Example 4

Column Alan Ex 4.4

Engineer SP

Code ACI 318-14

Bar Set ASTM A615

Units English

Run Option Investigation

Run Axis X - axis

Slenderness Not Considered

Column Type Structural

2.1. Concrete

2. Material Properties

Type Standard

e 4 ksi
Ec 3605 ksi
fe 3.4 ksi
Ey 0.003 in/in
B4 0.85
2.2. Steel

Type Standard

f, 60 ksi
=, 29000 ksi
€n 0.00206897 infin
3. Section

3.1. Shape and Properties

Type Irregular
Aq 1818 in?
[ 3.36209e+006 in*
ll, 24853.5 in*
I 43.0039 in
Iy 3.6974 in
Xo 0in
Yo 0in
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C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example04.col 12:01 PM
3.2. Section Figure
X
Irregular 15 x 144 in 0.97% reinf.
Figure 1: Column section
3.3. Exterior Points
Points X Y Points X Y Points X Y
in in in in in in
1 -7.5 72.0 2 75 72.0 3 7.5 57.0
4 6.0 57.0 5 6.0 -57.0 6 75 -57.0
7 7.5 -72.0 8 =75 -72.0 9 -7.5 -57.0
10 -6.0 -57.0 11 -6.0 57.0 12 -7.5 57.0
4. Reinforcement
4.1. Bar Set: ASTM A615
Bar Diameter Area Bar Diameter Area Bar Diameter Area
in in? in in? in in?
#3 0.38 0.11 #4 0.50 0.20 #5 0.63 0.31
#6 0.75 0.44 #7 0.88 0.60 #8 1.00 0.79
#9 1.13 1.00 #10 1.27 1.27 #11 1.41 1.56
#14 1.69 2.25 #18 2.26 4.00
4.2. Confinement and Factors
Confinement type Other
For #10 bars or less #3 ties
For larger bars #4 ties
Capacity Reduction Factors
Axial compression, (a) 0.85
Tension controlled failure, (b) 0.9
Compression controlled failure, (c) 0.7
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Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example04.col 12:01 PM

4.3. Arrangement

Pattern Irregular
Bar layout -
Cover to -—
Clear cover -—
Bars -—
Total steel area, As 17.60 in?
rho 0.97 %
Minimum clear spacing 1.31 in

(Note: rho < 1.0%)

4.4. Bars Provided

Area X Y Area X Y Area X Y

in? in in in? in in in? in in
0.79 5.0 69.5 0.79 5.0 59.5 0.79 0.0 69.5
0.79 0.0 59.5 0.79 -5.0 69.5 0.79 -5.0 59.5
0.79 5.0 64.5 0.79 -5.0 64.5 0.79 5.0 -69.5
0.79 5.0 -59.5 0.79 0.0 -69.5 0.79 0.0 -59.5
0.79 -5.0 -69.5 0.79 -5.0 -59.5 0.79 5.0 -64.5
0.79 -5.0 -64.5 0.31 3.5 63.0 0.31 35 45.0
0.31 3.5 27.0 0.31 3.5 9.0 0.31 3.5 -9.0
0.31 35 -27.0 0.31 3.5 -45.0 0.31 35 -63.0
0.31 -3.5 63.0 0.31 -3.5 45.0 0.31 -35 27.0
0.31 -3.5 9.0 0.31 -3.5 -9.0 0.31 -3.5 -27.0
0.31 -3.5 -45.0 0.31 -3.5 -63.0

5. Axial Loads and Moments with Corresponding Capacities

No OP, OM,,, NA Depth d; Depth & (]
kip k-ft in in

1 649.5 8395.14 23.998 141.500 0.01469 0.900

2 649.5 -8395.14 23.998 141.500 0.01469 0.900
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5.5 Example 5 - Capacity of an Irregular Section

5.5.1 Problem Formulation

Compute horizontal moment capacity M, of the unsymmetrical beam cross section®! shown
below. Use 3-ksi concrete and 60-ksi reinforcing steel.

24"
+
4"
f
215" o4

(2-#8 | |

(1)-#9 | &

2.142" —~ F — 2

- 12" —

Note: when instructed to move to a location (15, 25), move the cursor until the cells in the Status
bar show “x=15" and “y=25".

From the File menu, choose New. Any input data is cleared and the default values are restored.

81. Based on Example 4.7, pp 161 from Reinforced Concrete: Mechanics and Design by James G. Wight and
James K. MacGregor, Fifth Edition, 2009, Pearson Prentice Hall, Pearson Education Inc.
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5.5.2 Preparing Input

*  From the Input menu, choose General Information.

General Information

- Select English units and ACI 318-14 code. " Lab
. . Project:
- Select BIAXIAL for RUN AXIS, Investigation for run [spColimn Hanl Evaripl 5
option and NO for CONSIDER SLENDERNESS. Colurr: Engineer
IMacGlegol4.? ISF'
- Choose OK.
— Design Code
s 31814 |
5.5.3 Assigning Properties - Units Flun Opion
' English * |nwestigation
 Metric ' Design
* From the Input menu, choose Material Properties. [ Flun Ao
) " About X-dis % Biaial
- Under CONCRETE, input 3 for the STRENGTH. Other C About -his
properties are computed and will be accepted. e e @ e ) e
- Choose OK. ok | Canel

Material Properties

— Concrete — Reinforzing Steel

Strength, fic: |3— ksi Strength, fyu: IED— ki

¥ Standard ¥ Standard

Blasticity. Ec: [312202  ksi | | Elasticly, E=[29000 ki

M aw stress, fo |255— ksi

Beta(l1]: IDBE— Compression-controlled strain limit,

Ultimate strain; W Eps ut IW
’T‘ Cancel |

*  From the Input menu, choose Section | Irregular. When spSection module is loaded its
window occupies the desktop. Open the DRAWING AREA box by selecting the arrow under

H .

the Grid On/Off button L=

- Under Limits, input 0 and 24 for the MINIMUM X and MAXIMUM X, respectively.
- Under limits, input =20 and 4 for the MINIMUM Y and MAXIMUM Y, respectively.
- Under GRID, input 4 and 4 for X and Y grid STEP, respectively.

- Choose OK.

* Click Polygon icon under Draw Menu. The default shape type is Solid.

| 132 |



Sﬂjmn EXAMPLES

- In the drawing area, move the cursor to the location (0, 0) and click the left mouse

button. A node is inserted.
- Move to (12, 0) and click the left mouse button.
- Move to (12, -20) and click the left mouse button.
- Move to (24, -20) and click the left mouse button.
- Move to (24, 4) and click the left mouse button.
- Move to (0, 4) and click the left mouse button.
- Move to (0, 0) and click the left mouse button.

» Select Single icon under Reinforcement Menu.

- Under Options Menu on the left, select #9 from the drop-down list for BAR SIZE.
Under Commands Menu, enter 14.142 for X-COORD and -17.5 for Y-COORD.
Choose OK.

- Under Options Menu on the left, select #8 from the drop-down list for BAR SIZE.
Under Commands Menu, enter 18 . 0 for X-COORD and -17 .5 for Y-COORD. Choose
OK.

- Under Options Menu on the left, select #8 from the drop-down list for BAR SIZE.
Under Commands Menu, enter 22 . 0 for X-COORD and -17 .5 for Y-COORD. Choose
OK.

2 [x i 1] Rectangle (= Gircle ~ |+ Single &% Rectanguiar B o Add | Measure &3 loxe], Export
& o= - - . = o
e Select | [ Poiygon Combine | ,** Unear % Circular  Cover [f Select | [¥] Validate Settings Import
General Modify Draw Reinforcement Reshape Misc DXF f~
Options o
Selecti )
- p
Bars onk w
aaaaa y i
Properti ba
v
No properties sslected 2
B
Q
a
2
[

-4

Bars: ASTM A615 0 solids, 0 openings, 0 bars selected X=34831 Y = -10781 Units: ~ fin]
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» From the General Menu, choose Save and Exit. You are returned to spColumn and the

section is shown in the Information bar.

*  From the Input menu, choose Input |
Loads | Factored

- Enter LOAD as O (zero), X-MOMENT as -225 k-ft
and Y-MOMENT as 0. Choose INSERT.
- Choose OK.

5.5.4 Solving

* From the Solve menu, choose Execute.

- A message is displayed saying “Reinforcement
ratio is less than 1% Consider column as
architectural (i.e. fc is reduced by reinforcement
ratio?)”. Click No for this option.

Factored Loads

Load HA-Moment -Moment
] |-225 o
[kip] [k-ft] [k-ft]
[ et | Modiy | Delete |
|Nu:|. P b by

oK

Cahicel

- The solver of the program is started and, upon completion, displays the interaction

diagram of the section.

5.5.5 Viewing and Printing Results

* From the View menu, choose Results.

- Use the explorer in the spResults module or the Previous Table and Next Table

buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the

spResults module and get back to spColumn.

* From the File menu, choose Print Report | Default Report.

- Select the printer to send the default report to.
- Choose PRINT.

* From the File menu, choose Print Screen.

- Select the printer to send the graphical results to.
- Choose PRINT

- Change the interaction diagram to show the P-M diagram at 180° using the & icon.
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STRUCTUREPOINT - spColumn v6.50 Page | 1
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 7/12/2018
C:\Program Files (x86)\StructurePoint\spColumn V6.00\spColumn\Examples\Examples-Ma...\Example05.col 2:26 PM

&
400 — My [k-ft]
350+
300
e o o e
24 x 24 in 200

150+

100+

General Information

Project spColumn M... Example5 ! i ; ; ; ; ' I I Leid !‘(‘"1
Column MacGregor4_7 -400 -350  -300 50 100 150 200 250 300 350 400
Engineer SP

Code ACI 318-14

Bar Set ASTM A615

Units English 1601

Run Option Investigation el

Run Axis Biaxial

Slenderness Not Considered 250

Column Type Structural

-300
Capacity Method =~ Moment capacity

-350

Materials
fo 3 ksi 4001
E 3122.02 ksi MRS el
5 (
fy 60 ksi
ES 29000 ksi
Section
Type Irregular
A 336 in? !
| 18002.3 int No. B Mux M,y P, SM, oM, Capacity
I‘ 0056 5'6 e kip K-ft K-ft kip k-ft K-t Ratio
£ - 1 0.0 -225.0 0.0 0.00 -224.43 0.00 1.00
Reinforcement
Pattern Irregular Max. Capacity Ratio: 1.00
Bar layout -
Cover to -
Clear cover -—-
Bars -
Confinement type Tied
Total steel area, A 2.58 in2
Rho 0.77 %
Min. clear spacing 2.79 in

| 135 |



_
I

STRUCTUREPOINT - spColumn v6.50 Page | 1
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 7/12/2018
C:\Program Files (x86)\StructurePoint\spColumn V6.00\spColumn\Examples\Examples-Ma...\Example05.col 2:26 PM
1100 P [kip]
1000+
- ! o oS 90\0 <+
7 “
e o o & e
4 800+
24 x 24 in F %
/ T
/]
!
!
i
General Information iy
Project spColumn M... ExampleS \
\
Column MacGregor4.7 .
Engineer SP
Code ACI 318-14
Bar Set ASTM A615
Units English
Run Option Investigation
Run Axis Biaxial
Slenderness Not Considered . . . M
Column Type Structural ! ! ! i 1
-400 350  -300 350 400
Capacity Method =~ Moment capacity
-100 + T
Materials s S ek =
i 3 ksi -200—
B 3122.02 ksi PM at 180.0 [deg]
5 (
f, 60 ksi
ES 29000 ksi
Section
Type Irregular
A 336 in? )
I 180023 in* No. P Mux M,y P, oM, M, Capacity
I 9956156 T kip k-ft k-ft kip k-ft k-ft Ratio
4 - 1 0.0 -225.0 0.0 0.00 -224.43 0.00 1.00
Reinforcement
Pattern Irregular Max. Capacity Ratio: 1.00
Bar layout -
Cover to -
Clear cover -—-
Bars -
Confinement type Tied
Total steel area, A 2.58 in2
Rho 0.77 %
Min. clear spacing 2.79 in
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1. General Information

File Name C:\Program Files
(x86)\Structure...\Example05.col

Project spColumn Manual Example 5

Column MacGregor4.7

Engineer SP

Code ACI 318-14

Bar Set ASTM A615

Units English

Run Option Investigation

Run Axis Biaxial

Slenderness Not Considered

Column Type Structural

2. Material Properties
2.1. Concrete

Type Standard

fo 3 ksi
Ec 3122.02 ksi
fe 2.55 ksi
Ey 0.003 in/in
B4 0.85
2.2. Steel

Type Standard

f, 60 ksi
=, 29000 ksi
€n 0.00206897 infin
3. Section

3.1. Shape and Properties

Type Irregular
Aq 336 in?
[ 18002.3 in*
ll, 9956.56 in*
I 7.31972 in
Iy 5.44359 in
Xo 16.2857 in
Yo -6.57143 in
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3.2. Section Figure

Irregular 24 x 24 in 0.77% reinf.
Figure 1: Column section
3.3. Exterior Points
Points X Y Points X Y Points X Y
in in in in in in
1 0.0 0.0 2 12.0 0.0 3 12.0 -20.0
4 24.0 -20.0 5 24.0 4.0 6 0.0 4.0
4. Reinforcement
4.1. Bar Set: ASTM A615
Bar Diameter Area Bar Diameter Area Bar Diameter Area
in in? in in? in in?
#3 0.38 0.11 #4 0.50 0.20 #5 0.63 0.31
#6 0.75 0.44 #7 0.88 0.60 #8 1.00 0.79
#9 1.13 1.00 #10 1.27 1.27 #11 1.41 1.56
#14 1.69 2.25 #18 2.26 4.00
4.2. Confinement and Factors
Confinement type Tied
For #10 bars or less #3 ties
For larger bars #4 ties
Capacity Reduction Factors
Axial compression, (a) 0.8
Tension controlled failure, (b) 0.9
Compression controlled failure, (c) 0.65
4.3. Arrangement
Pattern Irregular
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Bar layout -

Cover to -

Clear cover -

Bars -

Total steel area, A, 2.58 in?

rho 0.77 %

Minimum clear spacing 279 in

(Note: rho < 1.0%)

4.4. Bars Provided

Area X Y Area X Y Area X Y
in? in in in? in in in2 in in
1.00 14.1 -17.5 0.79 18.0 -17.5 0.79 22.0 -17.5

5. Factored Loads and Moments with Corresponding Capacities

No Py M.« M,y OM,, ®M,, OM,/M, NA Depth d, Depth & [}
kip k-ft k-ft k-ft k-ft in in
1 0.00 -225.00 0.00 -224.43 0.00 0.997 7.21 2353 0.00685 0.900 #

# Section capacity exceeded. Revise design!
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5.6 Example 6 - Investigation of a Rectangle Short
Column

5.6.1 Problem Formulation

Determine the adequacy of a 200 mm x 350 mm column®? with 6-15M bars. Note that since the
least column dimension is less than 300mm, the maximum section axial design capacity is capped
in CSA A23.3-14 as required by clause 10.10.4.

The concrete used is 30 MPa and the reinforcing steel is 400 MPa.

The factored load values for the column under consideration are as follows:

P (kN) 500 kN
M, (kN-m) 37.5 kN-m

From the File menu, choose New. Any input data is cleared and the

General Information

default values are restored. L abol
Project:
|spCOIumn Marual Exarple &
Colurmn; Engineer:
|Rect-200350 5P
5.6.2 Preparing Input
— Design Code
|Csa 423314 |
* From the Input menu, choose General Information. o ——
— Unik un Option
" English & Irvestigation
- Input the PROJECT header. * Metric ’7 " Design
- Select MEetric units and CSA A23.3-14 code. - Flun s
. . . . 0 About w-dis  Biawial
- Select About X-Axis for run axis, Investigation for run  About Vs
Option and No for ConSider SlendemeSS? Conzider slenderness? ( “Yes @ No
- ChOOSC OK af I Cancel

5.6.3 Assigning Properties

*  From the Input menu, choose Material Properties.

82. Based on STRUCTUREPOINT Hand Verification Example based on CSA A23.3-14 Concrete Design
Handbook
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- Input 30 for the CONCRETE STRENGTH, and 400 for the REINFORCING STEEL
STRENGTH. Other properties are computed and will be accepted.

- Choose OK.

* From the Input menu, choose Section | Rectangular.

- Input 350 and 200 for the section width (along X) and depth (along Y).
- Choose OK.

Rectangular Section x

Width [along = |[EEL  mm
Depth [along ™) (200 mm

* From the Options menu, choose Reinforcement.
- For Bar Set, choose CSA G30.18 from the drop down list.
- Choose OK.
* From the Input menu, choose Reinforcement | Sides Different

- Input 3-#15 bars for ToP and BOTTOM and 0-#15 for LEFT and RIGHT. Input 50 in
for the cover and select LONGITUDINAL BARS.

- Choose OK.

Sides Different

Top Bottorn  Left Right
Mo, of bars: |3 |3 |U |D
Barsize:  [m5 ~] M5 ~|[w5s ] [#15 ~]
Clear cover: |50 |50 |50 |50 mm

Cawver to

" Transverse barz & Longitudinal bars

oK | Cancel |

*  From the Input menu, choose Loads | Factored.
- Input 500 for the AXIAL LOAD, 37.5 for the X-MOMENTS.

- Choose INSERT to add the entry to the list box.
- Choose OK.
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Factored Loads

Load A oment -t oment
|500 [37.5 [0
(kW] [kMra] kM m]
[ nsen | Modiy | Delere |
| Mo, P M by

ok Cancel

5.6.4 Solving

* From the Solve menu, choose Execute.

- The solver of the program is started and, upon completion, displays the interaction
diagram of the section with the load point plotted within the diagram.

5.6.5 Viewing and Printing Results

* From the View menu, choose Results.

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

* From the File menu, choose Print Report | Default Report.

- Select the printer to send the default report to.
- Choose PRINT.

* From the File menu, choose Print Screen.

- Select the printer to send the graphical results to.
- Choose PRINT.
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STRUCTUREPOINT - spColumn v6.50
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB

C:\Program Files (x86)\StructurePoint\spColumn V6.00\spColumn\Examples\Examples-Ma...\Example06.col

=

350 x 200 mm

General Information

Project
Column
Engineer
Code

Bar Set

Units

Run Option
Run Axis
Slenderness
Column Type
Capacity Method

Materials

Section
Type

Width
Depth

Ag

I

IY
Reinforcement
Pattern

Bar layout
Cover to
Clear cover
Bars

Confinement type
Total steel area, A

Rho
Min. clear spacing

spColumn M... Example6

Rect-200x350
SP

CSA A23.3-14
CSA G30.18
Metric
Investigation

X - axis

Not Considered
Structural
Moment capacity

30
26621.1

400
200000

Rectangular
350

200

70000
2.33333e+008
7.14583e+008

Sides different
Rectangular
Longitudal bars

Tied
1200

1.71
68

MPa
MPa

MPa
MPa

mm
mm
mm?
mm#
mm#

mm?
%
mm

Page | 1
7/12/2018
2:27 PM
2200 P [kN]
o]
2000+ S
- - = e
o 1800 + S
Ve N
4 K
F d e N
e 1600 -+ S
fs=0 F. 1 (G e o (Pmax) T fs=0
S 14001 51~
N - e ke L 4
¢ > ~ 2l
“— -7 1200+ = £ N
/ ™ 7 Foe / \
! N 7 b L i =
L fs=0. L 1000 2 =0 || ==
MIKNm]
|
60
-600 —
PM at 0.0 [deg]
No. Py Mg, P, M Capacity
kN kNm kN kNm Ratio
1 500.0 37.5 500.00 39.25 0.96

Max. Capacity Ratio: 0.96
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1. General Information

File Name

Project
Column
Engineer
Code

Bar Set
Units

Run Option
Run Axis
Slenderness
Column Type

C:\Program Files
(x86)\Structure...\Example06.col

spColumn Manual Example 6
Rect-200x350

SP

CSA A23.3-14

CSA G30.18

Metric

Investigation

X - axis

Not Considered

Structural

2.1. Concrete

2. Material Properties

Type Standard

i 30 MPa
= 26621.1 MPa
fe 24.15 MPa
Ey 0.0035 mm/mm
B4 0.895

2.2. Steel

Type Standard

f, 400 MPa
=, 200000 MPa
€4 0.002 mm/mm
3. Section

3.1. Shape and Properties

Type Rectangular
Width 350 mm
Depth 200 mm
Aq 70000 mm?
[ 2.33333e+008 mm*
fl, 7.14583e+008 mm?*
Iy 57.735 mm
ry 101.036 mm
Xo 0 mm
Yo 0 mm
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3.2. Section Figure

Rectangular 350 x 200 mm 1.71% reinf.

Figure 1: Column section

4. Reinforcement
4.1. Bar Set: CSA G30.18

Bar Diameter Area Bar Diameter Area Bar Diameter Area

mm mm? mm mm? mm mm?
#10 11.30 100.00 #15 16.00 200.00 #20 19.50 300.00
#25 25.20 500.00 #30 29.90 700.00 #35 35.70 1000.00
#45 43.70 1500.00 #55 56.40 2500.00

4.2. Confinement and Factors

Confinement type Tied
For #55 bars or less #10 ties
For larger bars #10 ties

Material Resistance Factors

Axial compression, (a) 0.6
Steel () 0.85
Concrete (®.) 0.65
Minimum dimension, h 200 mm

4.3. Arrangement

Pattern Sides different

Bar layout -
Cover to Longitudal bars
Clear cover -

Bars -
Total steel area, A, 1200 mm?
rho 1.71 %
Minimum clear spacing 68 mm
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4.4. Bars Provided
Bars Cover
mm
Top 3 #15 50
Bottom 3 #15 50
Left 0 #15 50
Right 0 #15 50
5. Factored Loads and Moments with Corresponding Capacities
No P; M d; Depth &
kN kNm mm
1 500.00 37.50 142 0.00140
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6.1 Introduction

spSection is an add-on module to the spColumn program. It enables the user to investigate
irregularly shaped reinforced concrete sections subject to a combination of loadings. spSection
considers a polygonal section reinforced with bars located at any location. The section may

contain one opening.

spSection is accessed from within spColumn. Once spColumn is started, you can activate
spSection by selecting the Section | Irregular command from the Input menu. This starts
spSection, locks the spColumn window and maximizes the spSection window. The section
geometry may then be defined by drawing it on the screen or by inputting the coordinates of the
polygon nodes. Once the section definition is complete, return to spColumn by selecting Save and
Exit from the Main menu or the Toolbar. The following is a list of the spSection window

components.

<P

Main  View

h} Xh 4 N 1] Rectangle (= cirde =+ sing Redangu\ar Fy Add [T Measure -ﬁ# oxE| Export

Save Discard = = . B

Save D5 oo Redo select | [ Polygon Combine ,*" Linesr Cover| | 7} Select [ Validate Settings g

Genersl Modify Draw Reinforcement Reshape Misc DXF
Options ¥
Reinforcement TOOLBAR
LEFT PANEL
® Barsize #
Bar area
Cover (Longitudina! bars)
Cover [in] 2,000 VIEW CONTROL

SOLID SHAPE

® Clear To bar center

OPENING SHAPE

Bar spacing
MNumber of bars -

® Bar spacing ] 6500

Commands

Center point

X fin] 0.000

Y [in] 10.000

TGS S s E R,

oK

COVER GUIDE

REINFORCEMENT

3D CUBE

COMPLETE SECTION

—Mx

Bars: ASTMAG615  Circular bar patter - Specify center point X = 0000 Y = 0,000 Units: ~ fin]
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6.2 Main Menu
Import

Imports the DXF File.
Export

Exports to the DXF File.
Errors

Lists the errors in the spSection model.

Validate

Checks if the section is valid for analysis by spColumn.

Save and Exit

Saves changes and exits.

Exit without Saving

Discards changes and exits.

6.3

View Menu

Toolbar

Provides five options to determine the location and size of the toolbar.

Settings

Provides the user with options to modify general and color settings.

In General Settings, user controls are provided for display, at exit choices, and precision

options.

Display:

Coordinate system sign: Provides a cross-hair indicating the X and Y axes.
Object Centroid: Provides a cross-hair at the object centroid.
Grid labels: Show or hide grid labels

Flying text: Displays the parameters related to the operation in flying text box while
performing that operation.
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At Exit:

* Combine all shapes: When checked, it combines all shapes at exit.
* Align model centroid to coordinate system origin: When checked, it aligns model cen-

troid to the coordinate system centroid at exit.

Precision:

* General: Shows on 0 to 3 trailing decimal places when entering dimensions at the left
panel textboxes.

» Flying text: Shows on 0 to 3 trailing decimal places when displaying flying text.

In Colors Settings:

» Shapes: Color options for solid, selected solids, openings, and selected openings.
* Reinforcement: Color options for bar, selected bar, and overlapped bar.

* Misc: Color options for main grid lines, other grid lines, and screen background.

P Settings

5P Settings

General IR

Display Shapes
+ Coordinate system sign Solid -
| Object centroid Selected solid -
Grid labels Opening N
+| Flying text Selected opening -
At exit Reinforcement
v Combine all shapes Foint Are2
¥ Align model centroid to coordinate system origin
precsion (U5 Cstomar Overoppever N I
General 3 v
Misc
Flying text | 2 v
Main grid lines w2
Other grid lines v
Screen background N
Reset oK Cancel

Resst OK Cancel
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View Controls

Shows or hides the view controls. Arrows in the upper right corner provide controls for the

location or the tool and extent of functions. The icons show in blue when active. View controls
provide the following operator functions:

Show and hide 3D rotation cube.

Rotate section in 3D (shift + middle mouse button)
Zoom to workspace

Zoom to model

Zoom to window

Zoom in (mouse wheel)

Zoom out (mouse wheel)

Pan (middle mouse button)

Grid On/Off: Shows or hides the grids. The arrow at
the bottom of the icon opens Drawing Area dialog box
which enables the user to edit the limits of drawing
area and grid steps in X, and Y directions.

Snap On/Off: Activates or deactivates the snap fea-
ture, the arrow at the bottom of the icon opens Snap
dialog box. Snap options are: Grid, shapes, cover, rein-
forcements, intersections, and coordinate system ori-
gin.

v Select/deselect all

~ Grid
+ Shapes
v Cover

+| Reinforcements

v Intersections

« Coordinate system origin

OK Cancel

$P Drawing area

Limits
X [in] Y [in]
Minimum -50.000 -50.000

Maximum 50.000 50,000

Grid
X [in] ¥ [in]

Step 5.000 5.000

OK Cancel

Ortho mode On/Off: Restrict cursor movement to horizontal and vertical direction

when creating or modifying sections.

Status Bar

Shows or hides the status bar. Status bar is located at the bottom of the screen and displays the
bars set, active command and its instruction, the coordinates of the cursor, and the units.

| 151 |



sTcolumn

spSection MODULE

6.4 Toolbar - General

Save and Exit

Saves changes and exits.
Exit without Saving

Discards changes and exits.
Undo

Undo last operation (Ctrl + Z).
Redo

Redo last operation (Ctrl +Y).

6.5 Toolbar - Modify

Mirror

Mirrors selected items about line or point.

Delete
Deletes selected items.
Copy
Copies selected items to new location.

Rotate

Rotates selected items from a base point by a specified angle.

Move
Moves selected items to new location.
Select

Selects items to perform operations.
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6.6 Toolbar - Draw

Rectangle

Creates rectangular shapes of solid or opening by clicking the start and end points. Alternately,
the shape can be created by typing precise start point coordinates and dimensions at the left
panel when Draw | Rectangle icon is active.

Polygon

Creates polygon shapes by specifying its vertices in the drawing area until the closed polygon
shape is obtained or by typing precise point coordinates and then pressing close button at the
left panel when Draw | Polygon icon is active.

Circle
Creates circular shapes in one of the three methods namely;

» Circle | Draw circle by radius: Create circular shape by specifying center point and
radius.

» Circle 2 points | Draw circle by diameter: Create circular shape by specifying its diam-
eter.

» Circle 3 points | Draw circle by tangent points: Create circular shape by specifying
three tangent points.

Combine

Combines all shapes or just selected shapes.

6.7 Toolbar - Reinforcement

Single — Add single reinforcement bar

Creates a single reinforcement bar at a point. When the reinforcement single icon is active, sin-
gle bar can be created by clicking at any point on the screen. Alternatively, single reinforce-
ment bar can also be created by entering precise coordinates at the left panel.

Linear — Add bars in linear pattern

Creates a linear bar pattern based on the specified bar number or bar spacing. When the rein-
forcement linear icon is active, linear bar pattern can be created by specifying start and next
points on the screen. Alternatively, linear bar pattern can also be created by entering precise
coordinates of the start point and next points at the left panel.
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Rectangular — Add bars in rectangular pattern

Creates a rectangular bar pattern based on the specified number of bars in the X and Y direc-
tions respectively. When the reinforcement rectangular icon is active, rectangular bar pattern
can be created by specifying start and end points of the diagonal on the screen. Alternatively,

rectangular bar pattern can also be created by entering precise coordinates of the start point

and the translation vector of the diagonal for the rectangle, at the left panel.

Circular — Add bars in circular pattern

Creates a circular bar pattern based on the specified bar number or bar spacing. When the rein-

forcement circular icon is active, circular bar pattern can be created by specifying the center

point of the circle and the end point of its radius on the screen. Alternatively, circular bar pat-

tern can also be created by entering precise coordinates of the center point, the radius and its

angle with x-axis, at the left panel.

Cover

Shows and hides the bar cover guide. The cover type i.e. clear or to bar center and the required

value can be specified while using each of the above mentioned commands for reinforcement.

6.8 Toolbar - Reshape

Add - Add nodes
Creates additional nodes on shape edges.
Select — Select nodes

Selects nodes to move or delete.

6.9 Toolbar - Misc

Measure
Measures distance between two points.

Validate

Checks if the section is valid for analysis by spColumn.
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Settings

Modifies settings for view, display, combine, precision, and colors. Refer to View Menu for
more information on settings.

6.10 Toolbar - DXF

Export DXF
Exports the model to DXF file.
Import DXF

Imports a model from DXF file.
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§P spReporter - Slendr-ACI-14 For Prototypes.col [_[O[x]
Vot u g T 4% R EE L8 EE
¥ * v [ Cover & Contents =
= = TOOLBAR =1
Export Print EXPORT/ PRINT PANEL i
EXPLORER PANEL
Type al
+| Material Properties
® Word Excel 5 ¥ Section
PDF Csv i
REPORT PREVIEW + Reinforcement
Text e — >« Loading
- col Umn ?  v/Slenderness

Printer ~ |« Results

NPIAADEDO (HP Laserlet 400 M ~ e S > [l Momerit Magnification

?  « Factored Moments
Properties | Loads and Capacities

Settings

Paper Letter LI AL L

Orientation | Portrait * . *

. . .

Margins Narrow: 0.5° . o

Printrange  All pages et

Pages

PREVIEW AREA
27 4

7.1 Introduction

spReporter is a module of the spColumn program. It enables the user to view, customize, print and
export reports in different formats.

spReporter is accessed from within spColumn. Once a successful run has been performed, you can
open spReporter by selecting the Reporter command from the View menu. Alternatively,
spReporter can also be accessed by pressing the F7 key or by clicking on the spReporter button in
the program toolbar. Immediately after opening spReporter, you can export and/or print the default
report by pressing Export/Print button. Various options to customize the report before printing
and/or exporting it are also provided. Once the work in spReporter is complete click the close
button in the top right corner to exit the spReporter window.
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7.2 Toolbar

Previous page
Displays the previous page of the report.

Next page
Displays the next page of the report.

Page number box

Displays the page with the page number entered in the box.

Zoom in

Zooms in on the report (Ctrl + Mouse wheel up).

Z.oom out

Zooms out on the report (Ctrl + Mouse wheel down).

Z.oom box

Zooms on the report preview to the extent typed in the box or selected from the dropdown
list.

Fit to window width and enable scrolling

Fits the width of report to the preview space width and enables scrolling.

Fit one full page to window

Fits one full page in the preview space.

Pan

When toggled on and if the report is bigger than preview window, enables panning the
report.

Text selection

When toggled on enables selecting text in the report.

Settings

Modifies settings for report and explorer panel.
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— Report Settings

$P Settings

Report
Font size Medium

Regenerate automatically

«| Split long tables

Explorer

Location Right

«| Hide inactive items

OK Cancel

Regenerate automatically: Enables automatic regeneration of report when content
selection is modified by the user.

Split long tables: Displays table headings in all pages when tables are split along sev-

eral pages.

— Explorer Settings

Location: Displays explorer panel on the left or right side of screen depending on

selection.

Hide inactive items:: Hides unused tables from the explorer view.

Explorer

Shows or hides the explorer panel.

7.3 Export / Print Panel

Export

Exports the report in the selected format.

Print

Prints the report in the selected format when the option is available.
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Type

Provides 5 format options to print and/or export the reports

Printer

Word: Produces a Microsoft Word file with .docx extension.
PDF: Produces an Adobe Acrobat file with .pdf extension.
Text: Produces a Text file with .txt extension.

Excel: Produces a Microsoft Excel file with .xlsx extension.

CSV: Produces a Comma Separated file with .csv extension.

Provides the option to select available printers and change printer properties.

Settings

Provides the options to modify print settings.

7.4

Paper: Provides the options to select from available paper sizes.

Orientation: Provides the options to select between landscape or portrait paper orien-
tation.

Margins: Provides the options to use narrow, normal, wide or custom margins to the
report.

&P Custom Margins

Margins (Inches)

Tep 075 -  Bottem 07s o
Left 0.75 - Right 075 =
OK Cancel

Print range: Provides the options to select the pages to print and/or export.

Explorer panel

The explorer panel consists of all the available report items classified into sections and arranged
hierarchically. Each item listed in the explorer panel is preceded by a checkbox. The user can
check/uncheck the checkbox to include or exclude from the report, the items or sections.
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Expand all

Expands item list.

Collapse all

Collapses item list.
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TOOLBAR
&P spResults - Slendr-ACI-14 For Prototypes.col [ O] x]
= L 1 B BHI|EZ &
=l v nput General Information
—1 2 \ \ _ACI-14 F
* Material Properties ‘ File Name I CAUsers\spou..\Slendr-ACl-14 For Prototypes.col
Secti Project Slender-ACI14
ection
Reinforcement Column Col-2
Loading Engineer Eng-2
Code ACI318-14
Slenderness
Bar Set ASTM AB1S
~  Results
h
~  Moment Magnification Units Englis
Run Option Investigation
Run Axis Biaxial
Slendemness Considerad
5 X - axis
I n Factors: ¥ - axis Column Type Structural
~ Factored Moments
X - axis TABLE
¥ - axis
EXPLORER PANEL
Loads and Capacities B
PREVIEW AREA
A

8.1 Introduction

spResults is a module of the spColumn program. It enables the user to view program input and
output in tables and export them in different formats.

spResults is accessed from within spColumn. Once a model has been successfully executed, you
can open spResults by selecting the Results command from the View menu. Alternatively,
spResults can also be accessed by pressing the F6 key or by clicking on the spResults button in the
program toolbar. Once the work in spResults is complete click the close button in the top right
corner to exit spResults window.

8.2 Toolbar

Previous table

Displays the previous table.

Next table
Displays the next table.
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Table number box
Displays the table with the table number entered in the box.

Auto fit column width to view area

When toggled on always fits the width of table to the preview space width.

Maintain maximum column width

Switches all table columns to their default maximum width.

Export current table

Exports the table being viewed in the selected format.

Settings

Modifies settings for tables and explorer panel.

Tables

+| Highlight critical load peints
Highlighting color

Explorer

Location Left
~| Hide inactive items

oK Cancel

— Tables settings

Highlight critical items: Enables highlighting of critical items in the “Loads and
Capacities” table.

Highlighting color: Provides color options for highlighting critical items.
— Explorer settings

Location: Displays explorer panel on the left or right side of screen depending on
selection

Hide inactive items: Hides unused tables from the explorer view.

Explorer

Shows or hides the explorer panel.
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8.3 Explorer panel

The explorer panel consists of all the available items of the result classified into sections
and arranged hierarchically. Any item in the explorer panel can be clicked on to display
the corresponding table in the preview space.

Expand all

Expands item list.

Collapse all

Collapses item list.
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9.1 Introduction

sp2D3DView is a module of the spColumn program. It enables the user to view and analyze 2D
interaction diagrams and contours along with 3D failure surfaces in a multi viewport environment.

sp2D3DView is accessed from within spColumn. Once a successful run has been performed, you
can open sp2D3DView by selecting the 2D/3D Viewer command from the View menu.
Alternatively, sp2D3DView can also be accessed by clicking the 2D/3D Viewer button in the
program toolbar.

Toolbar

B m ¥ b AT - 1) & &
Resaits  Reporter  Addto Export M W IPM IpMM Wiewpoits  Diply Settings
o - - - - < optns
Is. [Ey— = —
B Angle Mz, Myl | 770 T3 deg 24
2600 [«ij
Asial laad kip kiF] .
o
u 2 Moo My Capacty -
o
p ! en 5
950 1340 o s 1. o
2 950 3400 oo e N R m
w0 a2 o 106
~ BROBERTIES T
- (Pmaz) i : (Bmax)
r 45 ksl v ul
fy | /
%%%% rex 450 inn2 P Ly
Total A Frigeen A
i 132 % [
M. capacity 100 f II
~ SECTION I
|/
| I
|
\ I
".\ ro Mk
| — 7 t d
= % &
7 1000 N 1000
B (Pmin} Pminy
_ so0L
=t SRSEN Y PIAat 7.0 [deg]
= Imegular 202810
T & -
Biasial ACIZIBAA | P - 43T kp 5= M006AS kk Eee = 205 \ \ Ueits: (k] o]

Left Panel / ~. Status bar k\{iew;!orts

9.2 Toolbar

Results

Executes the spResults module to view the input and output data.
Reporter

Executes the spReporter module to generate and print reports.
Add to Report

Adds the active 2D diagram to the report.
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Export

Graphical Report to EMF File: Exports the active 2D diagram as a graphical report to and
EMF file.

Copy Diagram to Clipboard: Copies the active 2D diagram to the clipboard to be basted
elsewhere.

Factored Diagram to CSV File: Exports the Active factored 2D diagram or the active
factored 3D surface to a CSV file.

Nominal Diagram to CSV File: Exports the active nominal 2D diagram or the active nominal
3D surface to a CSV file when the nominal diagram display is toggled on.

PM

. S . My, M,)
PM: Displays an interaction diagram sliced at a constant ( 277V ) angle drawn for both
positive and negative moments.

. o . M, M,)
+PM: Displays an interaction diagram sliced at a constant ( *277Y) angle drawn for the
negative moments only.

. S . M, M,)
-PM: Displays an interaction digram sliced at a constant ( ¥277Y) angle drawn for the
negative moments only.

MM

Displays a contour of the failure surface sliced at a constant axial load.

3D-PM

Displays a 3D visualization of the failure surface with a vertical plane (biaxial runs only).
Show Plane: Toggles the display of vertical plane on and off.
Cut: Cuts the failure surface at the location of the vertical plane or restores it.
Swap: Swaps the visible part of the 3D-PM surface when it is cut.

3D-MM

Displays a 3D visualization of the failure surface with a horizontal plane (biaxial runs only).
Show Plane: Toggles the display of horizontal plane on and off.

Cut: Cuts the failure surface at the location of the horizontal plane or restores it.
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Swap: Swaps the visible part of the 3D-MM surface when it is cut.

The commands PM, MM, 3D-PM and 3D-MM and their sub commands are also available in the

right click menu of the viewports.

PM » Dy PM

MM [y «pM
3D-PM Y
3D-MM

MR = R

View controls

[:I] Show Plane

@ Cut

L View controls

For viewport displaying 2D diagrams For viewport displaying 3D surfaces

Viewports (biaxial runs only)

2D/3D — PM: Displays two vertical viewports; PM and 3D-PM.

2D/3D — MM: Displays two vertical viewports; MM and 3D-MM.

2D/3D — PM/MM: Displays four equal viewports; MM and 3D-MM at the top and PM and

3D-PM at the bottom.

New Window: Creates a new floating viewport with the contents of the existing active

viewport.

Display Options

Provides the user with an option to toggle the display of different items in both 2D diagrams and

3D surfaces.
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sp Display options

Diagrams / Surfaces

+| Mominal

~ Factored

2D Elements

« Load points
v Load points labels

+  Axial load labels

3D Elements

+ Load points

| Splice lines
| Factored diagram top

| Capacity points

+  Main axes

Diagra

Reset Cancel

ms / Surfaces

Nominal - Shows or hides nominal (unfactored) interaction diagram, contour or 3D
surface. Available only when Include Nominal Diagram option is selected in the
Solve menu.

Factored - Shows or hides factored capacity interaction diagram, contour or 3D sur-
face.

2D Elements

Load Points - Shows or hides load points in 2D contours and interaction diagrams.

Load Point Labels - Shows or hides load point labels in 2D contours and interaction
diagrams.

Axial Load Labels - Shows or hides axial load labels 2D interaction diagrams.

Splice Lines - Shows or hides splice lines in 2D interaction diagrams (uniaxial runs
only).

Factored Diagram Top - Shows or hides the top part of factored diagram in 2D interac-
tion diagrams.

3D Elements

Load Points - Shows or hides load points in 2D contours and interaction diagrams.

Main Axes - Shows or hides My, My and P, axes in the 3D diagram.
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9.3 Settings

§p Settings
[ Axes  Colors
3D Diagrams Display
Load table & Report Text size Medium =
Load Point size Medium ~
Diagram aspect ratio Auto v
Line types
Type Thickness
Mominal diagram Dashed - Thin -
Factored diagram Solid - Thin -
Factored diagram (Top) | Dashed - Thin -
Gnd lines Solid - Thin -
Axes Selid v Medium v
Ticks Medium v
Reset OK

Provides the user with options to modify various settings for 2D diagrams, 3D diagrams and Load
Table & Report.

9.3.1 2D Diagram

Provides users with the options to modify general, axes and color settings for 2D diagrams.
General
Display

Text size - Small, medium and large size options for text in 2D diagrams.

Load Point size - Small, medium and large size options for load points in 2D diagrams.
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Diagram aspect ratio - 1:1 or Auto diagram aspect ratios for 2D diagrams
Line types

This section allows the user to choose the line types and line thicknesses for nominal
diagram, factored diagram, factored diagram (top), grid lines, axes and ticks.

Axes

Axis value - Provides the option to show labels for all ticks on axes or only for ticks
representing maximum values in axes.

Uniform “axis values” for M-M diagrams - When checked, all MM diagrams have the same
maximum value in each axis making comparison between different contours easier.

Uniform “axis values” for P-M diagrams - When checked, all PM diagrams have the same
maximum value in each axis making comparison between different interaction diagrams
easier.

Colors
Diagrams
Color options for factored diagram, nominal diagram and splice lines
Load points

Color options for load points inside the diagram, load points outside the diagram,
selected load points and load points with cursor hovering over them.

Misc

Color options for grid lines, axes and screen backgrounds.

9.3.2 3D Diagram

Provides users with the options to modify general and color settings for 3D diagrams.
General
Display
Coordinate system - Show/Hide coordinate system for 3D surfaces.
Planes

Mx-My plane - Show/Hide Mx-My plane for 3D surfaces.
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P-My plane - Show/Hide P-My plane for 3D surfaces.
P-Mx plane - Show/Hide P-Mx plane for 3D surfaces.

Camera
Provides the options to switch between perspective and isometric camera types.
Colors
Factored surface
Color, opacity and line size options for factored surface
Nominal surface
Color, opacity and line size options for nominal surface
Load points

Color and size options for load points inside the diagram, load points outside the dia-
gram, selected load points and load points with cursor hovering over them.

Main axes planes

Color and opacity options for M,-M,, P-M, and P-M, planes
Axes

Color and opacity options for X, Y and Z axes
Cutter plane

Color and opacity options for cutter plane

9.3.3 Load table & Report

General
Load table

Highlight critical load points - When checked, critical load points in the load point list
of Navigation section of left panel are highlighted.

Highlighting color - Color options for highlighting of critical load points in the load
point list of Navigation section of left panel.

Automatically include in report
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PM Diagrams - Provides options to automatically include all PM diagrams in the
report or include PM diagrams based on load point capacity ratios, and angles at which
the PM diagrams are generated.

MM Diagrams - Provides options to automatically include all MM diagrams in the
report or include MM diagrams based on load point capacity ratios, and axial loads at
which the MM diagram are generated.

View Controls

Arrow in the upper right corner provides control for the location of the tool.

Commands listed in view controls vary depending on if the viewport is displaying 2D
diagrams or 3D surfaces. The icons show in blue when active.

In viewports showing 2D Diagrams

H G o o 5 & .

View controls for a 2D diagram viewport provide the following operator functions:

* Zoom to workspace

* Zoom to window

* Zoom in (mouse wheel)

* Zoom out (mouse wheel)

* Pan (Middle mouse button)

»  Grid On/Off: Shows or hides the grids.
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In viewports containing 3D Surfaces

View controls for a 3D diagram viewport provide the following operator functions:

Show/Hide 3D rotation cube

Rotate section in 3D (shift + middle mouse button)

Free guide plane control: Enable free movement of horizontal and vertical planes.

Zoom to window
Zoom in (mouse wheel)
Zoom out (mouse wheel)

Pan (Middle mouse button)
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9.3.4 Left Panel

D + NAVIGATION # SECTION

m o
¢

Angle (Mx, My) 770 B PR deg GENERAL INFORMATION
Code ACI318-14
Axial load -200.0 N | kip Bar set ASTM AB15
Run Optiocn Investigation
No. Pu Mux Muy Capacity Column Type Structural
e eft koft Ratio Capacity Method Critical capacity
i =0 T2 ol 0 v CONCRETE PROPERTIES
2 915.0 340.0 0.0 094 Type Standard
3 915.0 4020 0.0 103 o 45 i
4 915.0 575.0 0.0 127 Ec 382368 ksi
5 575.0 475.0 0.0 085 fe 3875 ksi
6 1500 2200 00 098 o 0,003 infin
7 150.0 3300 0.0 110 B 0.825
8 -200.0 50.0 50.0 123
9 -200.0 -100.0 50.0 0.86 ~ STEEL PROPERTIES
10 -200.0 50.0 2100 143 Type Standard
fy 60 ksi
Es 29000 ksi
eyt 0.002069 infin

 SECTION PROPERTIES

Type Irregular
Ag 450 in*2
Ix 203819 in”4
Iy 13750 in*4

~ PROPERTIES .
4 6.73002 in

~ SECTION ry 552771 in

¥ Xo 0 in

n

Yo -13.6111
. .

v REINFORCEMENT

Pattern Irregular

? Bar layout ==
Cover to ==

E_!) Clear cover -

= — Bars —

= * o 0 0 0 0 =

=1 Irregular 20 x 25 in =1 Total steel area, As 594 in*2

Image A. Navigate Tab Properties Tab

Navigate Tab

Navigation: Consists of tools that enable navigating the 2D diagrams and 3D surfaces;
angle control box Axial load control box and the load points list.

Properties: List out the crucial section and design properties.

Section: Displays the section being analyzed.
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 Filter Options: Filters the load points in the load points list and the diagrams based on load
point location, capacity ratio and presence in diagram.

General

Only show load point(s):
At column

With capacity ratic »

Load table

Only list load points present in active diagram

o | [ ]

Properties Tab

Lists out the General, Concrete, Steel, Section, Reinforcement and Slenderness properties of
the section being analyzed along with a diagram of the section being analyzed.

9.3.5 Viewing and Navigating 2D and 3D Diagrams

The 2D diagram and 3D surfaces can be navigated using the Navigation section of the left panel.

D v NAVIGATION

Angle (Mx, My) 450 v <> deg
Auial load 5750 T kip
No. Pu Mux Muy Capacity
kip k-ft k-ft Ratio

1 915.0 1340 0.0 035

2 915.0 3400 0.0 0.29

3 915.0 4020 0.0 1.06

4 915.0 573.0 0.0 1.51

5 575.0 475.0 0.0 092

6 150.0 2200 0.0 093

7 150.0 3300 0.0 139

8 -200.0 50.0 50.0 >1.00

9 -200.0 -100.0 50.0 <1.00

10 -200.0 50.0 210.0 >1.00
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Viewing and navigating P-M interaction diagrams (biaxial runs only)

A . . M M)

P-M interaction diagrams can be navigated using the Angle( X>7Y/ option. This controls
the direction of the vertical plane in the 3D surface, which indicates the location of the P-M
interaction diagram.

» To view the desire P-M diagram enter the angle value or select and angle from the drop-
down list.

*  You can browse through the angles by using <[ buttons adjacent to the box contain-
ing the angle values.

Viewing and navigating M, My contours (biaxial runs only)

X277 contours can be navigated using the Axial load option. This controls the elevation of

the horizontal plane in the 3D surface, which indicates the location of the = *’ "V contour.

* To view the desired © %’V contour enter the axial load value or select and axial load
from the drop-down list.

*  You can browse through the axial loads by using ' buttons adjacent to the box con-
taining the axial load values.

Viewing load points
To investigate a particular load point

* Click on the desired load point in the load point list immediately below the Angle and

Axial load options. This creates P-M interaction diagram and M, My contours at the
required location and also highlights the selected load point for easy observation.

» Alternatively, you can also directly click on a load point in the diagram and view its asso-
ciated angle, axial load and load point details in the navigation section.
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A.1 Import File Formats

Geometry, reinforcement or load data may be imported from a text file. The import file must be
saved in pure ASCII (text) format. Data fields on each line should be separated by spaces or TABs.
Comments or blank lines should not be placed within the import file.

A11 Service Loads Data:

No Of Load Points

P1 D Mlx DT Mlx DB Mly DB Mly DB

Pl L Mlx LT Mlx LB Mly LT Mly LB

Pl W Mlx WT Mlx WB Mly WT Mly WB

P1 EQ Mlx EQT Mlx EQB Mly EQT Mly EQB
Pl S Mlx ST Mlx SB Mly ST Mly SB

Pn D Mnx DT Mnx DB Mny DB Mny DB
Pn L Mnx LT Mnx LB Mny LT Mny LB
Pn W Mnx WT Mnx WB Mny WT Mny WB
Pn EQ Mnx EQT Mnx EQB Mny EQT Mny EQB
Pn S Mnx ST Mnx SB Mny ST Mny SB

Each service load point has five lines of data (one line for each load case, i.e. Dead, Live, Wind,
Earthquake, and Snow). Each data line has five values. For a service load point i, Pi D,
Mix_DT, Mix_DB, Miy_ DT,andMiy_ DB are the axial load, M, at top, M, at bottom, My at top

and My at bottom, respectively. The notation D, L, W, EQ, and S designate the Dead, Live,

Wind, Earthquake, and Snow load cases, respectively.

A.1.2 Factored Loads Data:

No Of Load Points
Pl Mlx Mly
P2 M2x M2y

Pn Mnx Mny
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For a factored load point i, P1 is the factored axial load, M1 x is the factored moment about x and

Mivy is the factored moment about y.

A1.3 Reinforcement Data:

No Of Bars
Al X1 Y1

An Xn ¥Yn

Forabar i, A1 isthe bar area, X1 is its x-coordinate, and Y1 is its y-coordinate.

A14 Geometry Data:

No Of Section Nodes
Xsl Ysl
Xs2 Ys?2

Xsn Ysn
No Of Opening Nodes
Xol Yol
Xo2 Yo2

Xon Yon
For a section node si, Xs1 is the x-coordinate of the node and Ys1 is its y-coordinate.
For an opening node oi, Xo1i is the x-coordinate of the node and Yo1 is its y-coordinate.

If the section does not contain an opening, you must have a zero for the value of
No Of Opening Nodes.

| 181 |



Sﬁﬁ/llen APPENDIX

A.2 spColumn Text Input (CTI) file format

spColumn is able to read and save its input data into two file formats, COL file or CTI file. CTI
files are plain text files that can be edited by any text editing software.

Caution must be used when editing a CTI file because some values may be interrelated. If one of
these values is changed, then other interrelated values should be changed accordingly. While this
is done automatically when a model is edited in the spColumn user graphic user interface (GUI),
one must update all the related values in a CTI file manually in order to obtain correct results. For
example, if units are changed from English to Metric in GUI, all the related input values are
updated automatically. If this is done by editing a CTI file, however, not only the unit flag but also
all the related input values must be updated manually.

The best way to create a CTI file is by using the spColumn GUI and selecting CTI file type in the
Save As menu command. Then, any necessary modifications to the CTI file can be applied with
any text editor. However, it is recommended that users always verify modified CTI files by
loading them in the spColumn GUI to ensure that the modifications are correct before running
manually revised CTI files in batch mode.

The CTI file is organized by sections. Each section contains a title in square brackets, followed by
values required by the section. The CTI file contains the following sections.

[spColumn Version]

[Project]

[Column ID]

[Engineer]

[Investigation Run Flag]

[Design Run Flag]

[Slenderness Flag]

[User Options]

[Irregular Options]

[Ties]

[Investigation Reinforcement]
[Design Reinforcement]
[Investigation Section Dimensions]
[Design Section Dimensions]
[Material Properties]

[Reduction Factors]

[Design Criteria]

[

External Points]
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[Internal Points]
[Reinforcement Bars]
[Factored Loads]
[Slenderness: Column]
[Slenderness: Column Above And Below]
[Slenderness: Beams]
[ET]
[S1dOptFact]
[Phi Delta]
[Cracked I]
[Service Loads]

[Load Combinations]
[BarGroupType]

[User Defined Bars]
[Sustained Load Factors]

Each section of a CTI file and allowable values of each parameter are described in details below.
Corresponding GUI commands are presented in parenthesis.

#spColumn Text Input (CTI) File

The number sign, #, at the beginning of a line of text indicates that the line of text is a comment.
The # sign must be located at the beginning of a line. Comments may be added anywhere
necessary in a CTI file to make the file more readable. If a comment appears in multiple lines,
each line must be started with a # sign

[spColumn Version]

Reserved. Do not edit.
[Project]
There is one line of text in this section.

Project name (menu Input | General Information...)

[Column ID]
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There is one line of text in this section.

Column ID (menu Input | General Information...)

[Engineer]
There is one line of text in this section.

Engineer name (Menu Input | General Information...)

[Investigation Run Flag]

Reserved. Do not edit.

[Design Run Flag]

Reserved. Do not edit.

[Slenderness Flag]

Reserved. Do not edit.

[User Options]

There are 27 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right.

1. O-Investigation Mode; 1-Design Mode; (Run Option on menu Input | General
Information...)

2. 0-English Unit; 1-Metric Units; (Units on menu Input | General Information...)
0-ACI 318-02; 1- CSA A23.3-94; 2-ACI 318-05; 3-CSA A23.3-04; 4-ACI 318-08; 5-ACI
318-11; 6-ACI 318-14; 7-CSA A23.3-14 (Design Code on menu Input | General
Information...)

4. 0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | General
Information...)

5. Reserved. Do not edit.

6. 0-Slenderness is not considered; 1-Slenderness in considered; (Consider slenderness? on
menu Input | General Information...)
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10.

I1.

12.

13.

14.

15.

16.

17.
18.
19.
20.
21.
22.
23.
24.

25.

26.
27.

0-Design for minimum number of bars; 1-Design for minimum area of reinforcement;
(Bar selection on menu Input | Reinforcement | Design Criteria...)

Reserved. Do not edit.

0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular Column Section,;
(menu Input | Section)

0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar Layout on
menu Input | Reinforcement | All Sides Equal)

0-Structural Column Section; 1-Architectural Column Section; 2-User Defined Column
Section; (Column Type on menu Input | Reinforcement | Design Criteria...)

0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; (Confinement drop-
down list on menu Input | Reinforcement | Confinement...)

Load type for investigation mode: (menu Input | Loads) 0-Factored; 1-Service; 2-Control
Points; 3-Axial Loads

Load type for design mode: (menu Input | Loads)

0-Factored; 1-Service; 2-Control Points; 3-Axial Loads

Reinforcement layout for investigation mode: (menu Input | Reinforcement)
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
Reinforcement layout for design mode: (menu Input | Reinforcement)
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
Reserved. Do not edit.

Number of factored loads (menu Input | Loads | Factored...)

Number of service loads (menu Input | Loads | Service...)

Number of points on exterior column section

Number of points on interior section opening

Reserved. Do not edit.

Reserved. Do not edit.

Cover type for investigation mode: (menu Input | Reinforcement)

0-To transverse bar; 1-To longitudinal bar

Cover type for design mode: (menu Input | Reinforcement)

0-To transverse bar; 1-To longitudinal bar

Number of load combinations; (menu Input | Load | Load Combinations...)

0-Moment capacity method; 1-Nearest point method; (menu Options | Section capacity...)
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[Irregular Options]

There are 13 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right. (menu Input | Section | Irregular | Section Editor
menu Main | Drawing Area)

1. Reserved. Do not edit.
2. Reserved. Do not edit.
3. Reserved. Do not edit.
4. Reserved. Do not edit.
5. Area of reinforcing bar that is to be added through irregular section editor
6. Maximum X value of drawing area of irregular section editor
7. Maximum Y value of drawing area of irregular section editor
8. Minimum X value of drawing area of irregular section editor
9. Minimum Y value of drawing area of irregular section editor
10. Grid step in X of irregular section editor
11. Grid step in Y of irregular section editor
12. Grid snap step in X of irregular section editor
13. Grid snap step in Y of irregular section editor

[Ties]

There are 3 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right. (Menu Input | Reinforcement | Confinement...)

1. Index (0 based) of tie bars for longitudinal bars smaller that the one specified in the 3rd
item in this section in the drop-down list

2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified in the 3™ jtem
in this section in the drop-down list

3. Index (0 based) of longitudinal bar in the drop-down list

[Investigation Reinforcement]

This section applies to investigation mode only. There are 12 values separated by commas in one
line in this section. These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different...) is selected:
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Number of top bars

Number of bottom bars

Number of left bars

Number of right bars

Index (0 based) of top bars (Top Bar Size drop-download list)

Index (0 based) of bottom bars (Bottom Bar Size drop-download list)
Index (0 based) of left bars (Left Bar Size drop-download list)

Index (0 based) of right bars (Right Bar Size drop-download list)

A IR AN o B O

Clear cover to top bars

10. Clear cover to bottom bars

11. Clear cover to left bars

12. Clear cover to right bars
If All Sides Equal (Menu Input | Reinforcement | All Sides Equal...) or Equal Spacing (Menu
Input | Reinforcement | Equal Spacing...) is selected:
Number of bars (No. of Bars text box)
Reserved. Do not edit.
Reserved. Do not edit.
Reserved. Do not edit.
Index (0 based) of bar (Bar Size drop-down list)
Reserved. Do not edit.
Reserved. Do not edit.

Reserved. Do not edit.

A PR AN A I

Clear cover to bar (Clear Cover text box)
10. Reserved. Do not edit.
11. Reserved. Do not edit.
12. Reserved. Do not edit.

If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern...) is selected:

Reserved. Do not edit.
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[Design Reinforcement]

This section applies to design mode only. There are 12 values separated by commas in one line in
this section. These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different...) is selected:

Minimum number of top and bottom bars

Maximum number of top and bottom bars

Minimum number of left and right bars

Maximum number of left and right bars

Index (0 based) of minimum size for top and bottom bars
Index (0 based) of maximum size for top and bottom bars
Index (0 based) of minimum size for left and right bars

Index (0 based) of maximum size for left and right bars

A S I U o e

Clear cover to top and bottom bars

10. Reserved. Do not edit.

11. Clear cover to left and right bars

12. Reserved. Do not edit.
If All Sides Equal (Menu Input | Reinforcement | All Sides Equal...) or Equal Spacing (Menu
Input | Reinforcement | Equal Spacing...) is selected:
Minimum number of bars
Maximum number of bars
Reserved. Do not edit.
Reserved. Do not edit.
Index (0 based) of minimum size of bars
Index (0 based) of maximum size of bars
Reserved. Do not edit.

Reserved. Do not edit.

A e IR AN N o

Clear cover

10. Reserved. Do not edit.
11. Reserved. Do not edit.
12. Reserved. Do not edit.
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[Investigation Section Dimensions]

This section applies to investigation mode only. There are 2 values separated by commas in one
line in this section. These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular...) is selected:

1. Section width (along X)
2. Section depth (along Y)

If circular section (Menu Input | Section | Circular...) is selected:

1. Section diameter

2. Reserved. Do not edit.
If irregular section (Menu Input | Section | Irregular) is selected:

1. Reserved. Do not edit.
2. Reserved. Do not edit.

[Design Section Dimensions]

This section applies to design mode only. There are 6 values separated by commas in one line in
this section. These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular...) is selected:

Section width (along X) Start
Section depth (along Y) Start
Section width (along X) End
Section depth (along Y) End

Section width (along X) Increment

A

Section depth (along Y) Increment
If circular section (Menu Input | Section | Circular...) is selected:

Diameter start
Reserved. Do not change.
Diameter end
Reserved. Do not change.

Diameter increment

A e

Reserved. Do not change.
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[Material Properties]

There are 11 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right. (Menu Input | Material Properties...)
Concrete strength, f’c

Concrete modulus of elasticity, Ec

Concrete maximum stress, fc

Beta(1) for concrete stress block

Concrete ultimate strain

Steel yield strength, fy

Steel modulus of elasticity, Es

Precast material for concrete. Only applicable for CSA A23.3-14 and CSA A23.3-04.

© N kWD =

0-Non-precast; 1-Precast

9. Standard material for concrete
0-Non-standard; 1-Standard

10. Standard material for reinforcing steel
0-Non-standard; 1-Standard

11. Compression-controlled strain limit

[Reduction Factors]

There are 5 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right. (Menu Input | Reinforcement | Confinement...)
Phi(a) for axial compression

Phi(b) for tension-controlled failure

Phi(c) for compression-controlled failure

Reserved. Do not edit

A e

Minimum dimension of tied irregular sections for CSA-A23.3-14; 0-for all other cases

[Design Criteria]

There are 4 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right. (Menu Input | Reinforcement | Design Criteria...)

1. Minimum reinforcement ratio
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2. Maximum reinforcement ratio

3. Minimum clear spacing between bars

4. Allowable Capacity (Ratio)

[External Points]

This section applies to irregular section in investigation mode only. The first line contains the
number of points on exterior section perimeter. Each of the following lines contains 2 values: X
and Y coordinates (separated by comma) of a point.

Number of Points, n
Point 1 X, Point 1 Y
Point 2 X, Point 2 Y

Point n X, Point n Y

[Internal Points]

This section applies to irregular section in investigation mode only. The first line contains the
number of points on an interior opening perimeter. Each of the following lines contains 2 values:
X and Y coordinates (separated by comma) of a point. If no opening exists, then the first line must
be 0.

Number of Points, n
Point 1 X, Point 1 Y
Point 2 X, Point 2 Y

Point n X, Point n Y

[Reinforcement Bars]

This section applies to irregular section in investigation mode only. The first line contains the
number of reinforcing bars. Each of the following lines contains 3 values: area, X and Y
coordinates (separated by comma) of a bar.

Number of bars, n
Bar 1 area, Bar 1 X, Bar 1 Y
Bar 2 area, Bar 2 X, Bar 2 Y
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Bar n area, Bar n X, Bar n Y

[Factored Loads]

The first line contains the number of factored loads defined. Each of the following lines contains
3 values: axial load, X-moment, and Y-moment separated by commas. (Menu Input | Loads |
Factored Loads...)

Number of Factored Loads, n
Load 1, X-Moment 1, Y-Moment 1
Load 2, X-Moment 2, Y-Moment 2

Load n, X-Moment n, Y-Moment n

[Slenderness: Column]

This section contains 2 lines describing slenderness parameters for column being designed. The
first line is for X-axis parameters, and the second line is for Y-axis parameters.

There are 8 values! separated by commas in each line. These values are described below in the
order they appear from left to right. (Menu Input | Slenderness | Design Column...)

Column clear height

k(nonsway)

k(sway)

0-Sway frame; 1-Nonsway frame

0-Compute ‘k’ factors; 1-Input k factors

(ZP,)/P,

(ZPy)/Py

© N kLD =

0-Do not ignore moment magnification along column length in sway frames; 1-Ignore
moment magnification along column length in sway frames. Use for ACI 318-11 and ACI
318-08 only. For all other codes the value must be 0.

[Slenderness: Column Above And Below]

1. Value No 8 introduced in spColumn v4.60.
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This section contains 2 lines describing slenderness parameters for column above and column

below. The first line is for column above, and the second line is for column below. (Menu Input |
Slenderness | Columns Above/Below...)

There are 6 values separated by commas in line 1 for column above. These values are described
below in the order they appear from left to right.

Concrete compressive strength, f’c

1. 0-Column specified; 1-No column specified
2. Column Height

3. Column width (along X)

4. Column depth (along Y)

5.

6.

Concrete modulus of elasticity, Ec

There are 6 values separated by commas in line 2 for column below. These values are described
below in the order they appear from left to right.

Concrete compressive strength, f’c

1. 0-Column specified; 1-No column specified
2. Column Height

3. Column width (along X)

4. Column depth (along Y)

5.

6.

Concrete modulus of elasticity, Ec

[Slenderness: Beams]

This section contains 8 lines. Each line describes a beam.
Line 1: X-Beam (perpendicular to X), Above Left

Line 2: X-Beam (perpendicular to X), Above Right

Line 3: X-Beam (perpendicular to X), Below Left

Line 4: X-Beam (perpendicular to X), Below Right

Line 5: Y-Beam (perpendicular to Y), Above Left

Line 6: Y-Beam (perpendicular to Y), Above Right

Line 7: Y-Beam (perpendicular to Y), Below Left

Line 8: Y-Beam (perpendicular to Y), Below Right
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There are 7 values separated by commas for each beam in each line. (Menu Input | Slenderness |
X-Beams..., Input | Slenderness | Y-Beams...) These values are described below in the order they
appear from left to right.

0-beam specified; 1-no beam specified
Beam span length (c/c)

Beam width

Beam depth

Beam section moment of inertia

Concrete compressive strength, f’c

AL I o

Concrete modulus of elasticity, Ec

[EI]

Reserved. Do not edit.

[S1dOptFact]

There is 1 value in this section for slenderness factors. (Code Default and User Defined radio
buttons on menu Input | Slenderness | factors...)

0-Code default; 1-User defined

[Phi Delta]
There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | factors...)

Stiffness reduction factor

[Cracked I]

There are 2 values separated by commas in one line in this section. These values are described
below in the order they appear from left to right. (Menu Input | Slenderness | factors...)

1. Beam cracked section coefficient

2. Column cracked section coefficient

[Service Loads]
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This section describes defined service loads. (Menu Input | Loads | Service...) The first line

contains the number of service loads. Each of the following lines contains values for one service
load.

There are 25 values for each service load in one Line separated by commas. These values are
described below in the order they appear from left to right.

Dead Axial Load

Dead X-moment at top

Dead X-moment at bottom

Dead Y-moment at top

Dead Y-moment at bottom

Live Axial Load

Live X-moment at top

Live X-moment at bottom

A e IR AN R o B

Live Y-moment at top

—_
S

. Live Y-moment at bottom
. Wind Axial Load

—_
N =

. Wind X-moment at top

—
(98]

. Wind X-moment at bottom

[
A

. Wind Y-moment at top

[
()]

. Wind Y-moment at bottom
. EQ. Axial Load

—_
~N O

. EQ. X-moment at top

[S—
o0

. EQ. X-moment at bottom

—_
Ne)

. EQ. Y-moment at top

[\
S

. EQ. Y-moment at bottom

\]
—

. Snow Axial Load

N
N

. Snow X-moment at top

[\
W

. Snow X-moment at bottom

[\
N

. Snow Y-moment at top

[\
)]

. Snow Y-moment at bottom

[Load Combinations]
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This section describes defined load combinations. (Menu Input | Loads | Load Combinations...)

The first line contains the number of load combinations. Each of the following lines contains load
factors for one load combination.

Number of load combinations, n
Dead 1, Live 1, Wind 1, E.Q. 1, Snow 1
Dead 2, Live 2, Wind 2, E.Q. 2, Snow 2

Dead n, Live n, Wind n, E.Q. n, Snow n

[BarGroupType]

There is 1 value in this section. (Bar Set drop-down list on menu Options | Reinforcement...)
0-User defined

1-ASTM615

2-CSA G30.18

3-prEN 10080

4-ASTM615M

[User Defined Bars]

This section contains user-defined reinforcing bars. (Menu Options | Reinforcement...) The first
line contains the number of defined bars. Each of the following lines contains values for one bar
separated by commas.

Number of user-defined bars, n
Bar 1 size, Bar 1 diameter, Bar 1 area, Bar 1 weight
Bar 2 size, Bar 2 diameter, Bar 2 area, Bar 2 weight

Bar n size, Bar n diameter, Bar n area, Bar n weight

[Sustained Load Factors]

There are 5 values separated by commas in one line in this section. Each value respectively
represents percentage of Dead, Live, Wind, EQ, and Snow load case that is considered sustained
(Menu Input | Loads | Service...).
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A.3 Conversion Factors - English to Sl

To convert from To Multiply by

in. m (1000 mm) 0.025400

ft m 0.304800

Ib N (0.001 kN) 4.448222

kip (1000 1bs) kN 4.448222
plf (Ib/ft) N/m 14.593904
psi (Ib/in.?) kPa 6.894757
ksi (kips/in.?) MPa 6.894757
psf (Ib/ft?) N/m? (Pa) 47.88026
pef (Ib/ft%) kg/m? 16.018460
ft-kips KN -m 1.355818
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A4

Conversion Factors - Sl to English

To convert from To Multiply by
m (1000 mm) in 39.37008
m ft 3.28084
N (0.001 kN) Ib 0.224809
kN kip (1000 Ibs) 0.224809
kN/m plf (Ib/ft) 68.52601
MPa psi (Ib/in?) 145.0377
MPa ksi (kips/in?) 0.145038
KN/m? (kPa) psf (Ib/ft?) 20.88555
kg/m® pef (Ib/ft) 0.062428
kN -m ft-kips 0.737562
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A.5 Material Strength Value Limits

ACI Standard Material Non-Standard Material
Min. Max. Min. Max.
fic 2 ksi 12 ksi 2 ksi 20 ksi
fy 10 ksi 80 ksi 10 ksi 270 ksi
CSA Standard Material Non-Standard Material
Min. Max. Min. Max.
f'c 10 MPa 80 MPa 10 MPa 150 MPa
fy 100 MPa 500 MPa 100 MPa 1860 MPa
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A.6 Contact Information

Web Site: http://www.StructurePoint.org

info@StructurePoint.org
E-mail:

support@StructurePoint.org

StructurePoint, LLC.
5420 Ol1d Orchard Road
Skokie, IL 60077
USA

Phone: +1- 847-966- 4357

Fax: +1- 847- 966- 1542
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